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About This Document

This document contains the usage instructions for the IBM Cloud 9 for SCLM for
z/0S product.

Who Should Use This Document

Readers should be familiar with the Unix System Services (USS) environment,
Hierarchical File System (HFS) structure, and the Software Configuration and
Library Manager (SCLM) component of IBM’s Interactive System Productivity
Facility (ISPF)..

Where to Find More Information

Where necessary, this document references information in other books, using
shortened versions of the book title. For complete titles and order numbers of the
books for all products that are part of z/OS, see z/OS Information Roadmap
(GC28-1727). Direct your request for copies of any IBM publication to your IBM
representative or to the IBM branch office serving your locality.

There is also a toll-free customer support number (1-800-879-2755) available
Monday through Friday from 6:30 a.m. through 5:00 p.m. Mountain Time. You can
use this number to:

* Order or inquire about IBM publications
* Resolve any software manufacturing or delivery concerns

» Activate the program reorder form to provide faster and more convenient
ordering of software updates

Hardcopy Publications

Short Title Used in This Title of Publication Order Number
Document

SCLM Project Manager’s Interactive System Productivity SC34-4750 -xx
Guide Facility (ISPF) Software

Configuration and Library Manager
(SCLM) Project Manager’s and
Developer’s Guide

SCLM Reference Interactive System Productivity SC28-1320-xx
Facility (ISPF) Software
Configuration and Library Manager
(SCLM) Reference

USS User’s Guide z/0S Unix System Service User’s SA22-7801-xx
Guide

ISPF User’s Guide ISPF User’s Guide Volume | SC34-4791-xx
ISPF User’s Guide Volume |1 SC34-4792-xx

Cloud 9 Installation Guide IBM Cloud 9 for SCLM for z/0S SC31-8845-xx
Installation Guide

© Copyright IBM Corp. 2001, 2004 Vil




Softcopy Publications

The z/0S library is available on the z/OS Collection Kit, SK2T-6700. This softcopy
collection contains a set of z/OS and related unlicensed product books. The
CD-ROM collection includes the IBM Library Reader, a program that customers
can use to read the softcopy books.

Softcopy z/0S publications are also available for Web browsing. PDF versions of
the z/0OS publications for viewing or printing using Adobe Acrobat Reader are
available at this URL:

http://www.ibm.com/software/ad/scimsuite/cloud/Tibrary/

Viii  Cloud 9 for SCLM for z/OS User’s Guide



Summary of Changes

This chapter describes the changes made in the the documentation supporting
Cloud 9 Version 2.1. Technical changes to the document are marked in the text by
a vertical change bar in the left margin.

Important Information
The current edition of this document describes Cloud 9 V2.1 with the PTFs
for APAR OA03122 applied. These PTFs must be applied before using Cloud
9 V2.1 or the product will not behave as described in this document.

Fifth Edition (April 2004)

The following enhancements and changes have been made to the Cloud 9 Version
2.1 interface, since the last edition of this manual.

* The Cloud 9 Cloud 9 WebSphere Studio Application Developer Plug-In (WSAD
Plug-in) has been added to the product.

* You now have the ability to change the Authorization Code for a selected SCLM
member or members.

Fourth Edition (December 2002)

The following enhancements and changes have been made to Cloud 9 Version 2.1
since the last edition of this manual:

* A major component has been added. This is a plug-in for IBM’s Visual Age for
Java, enabling Java source, classes and resources to be exported and imported to
SCLM as a project using the Microsoft SCCI API (Application Programming
Interface). With this plug-in, you can check in and check out source files and
resources and set Authorization codes within SCLM.

» Directory names or a portion thereof can now be retained when adding or
migrating a file into SCLM. To support this, a Remove from path field has been
added to the ADD PC/WS FILES and MIGRATE panels (see|‘Remove from|
[path” on page ).

» A facility has been provided, that allows remote build and deploy of Java objects
to computers running an FTP server.

» Useability enhancements to the following panels:
— SCLM Query
— ADD WS/PC Files
- Edit
— Migrate
— Open Package
— Save Package

These changes include the removal of the Access Key field (Access Key now
defaults to the User Id) and the addition of drop-down lists for Authorization
Codes.

« HTML upgraded to the 4.01 standard.
e Various minor technical corrections.

© Copyright IBM Corp. 2001, 2004 ix



* Online help and links to technical documentation.

Remove from path

In Cloud 9, path names can now be retained as part of the file name for objects
added into SCLM through the Cloud 9 Browser interface. This support can be seen
on two Browser panels: ADD PC/WS FILES and MIGRATE.

The concept behind path name retention is simple: the long name associated with a
file includes part or all of the directory name. For example, a file called myDog. jpg
is located in a directory called C:\pictures\mypets. With this Cloud 9 feature, you
can store the file as \pictures\mypets\myDog.jpg or pictures\mypets\myDog.jpg or
mypets\myDog.jpg or even myDog. jpg.

This feature was developed because Cloud 9 deployment, through SCLM Build
and Promote translators, uses the directory name component of the stored path
name to properly copy a file to a target directory. In this way, a file defined as
mypets\myDog. jpg is copied to the same directory structure, mypets\myDog, on a
target server. You might have established a directory structure on the target server
as c:\sales\dev, c:\sales\ga and c:\sales\rel, to correspond to an SCLM life
cycle of PROJECT=SALES and groups of DEV, QA, and REL. When the Cloud 9
SCLM Build Deployment translator is called in the group DEV, the file
mypets\myDog. jpg is copied from SCLM to c:\sales\dev\mypets\myDOG. jpg on the
target server.

To implement this, fields called "Remove from pathname” have been added to the
ADD PC/WS FILES and MIGRATE panels. In these fields, you can specify a
portion of the path name to be removed. For example, if you have selected
c:\pictures\mypets\myDog.jpg to be added into SCLM, but wish to define the file
to SCLM as mypets\myDog. jpg, you would specify c:\pictures\ in the "Remove
from pathname” field. When the file is added to SCLM, the file name is stored as
mypets\myDog. jpg.

Note: If no value is specified in "Remove from pathname”, the file name is stored

without any directory information. Also, the drive letter is never retained as
part of the SCLM file name.

X  Cloud 9 for SCLM for z/0S User’s Guide
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Chapter 1. Getting Started

What is Cloud 9?

IBM Cloud 9 for SCLM for z/0S, hereinafter called Cloud 9, is a powerful
front-end application that provides IBM Software Configuration and Library
Manager (SCLM) users with a platform-transparent change management tool.
Cloud 9 can perform key SCLM actions, including impact analysis and editing, all
from a familiar and easy-to-use Web based interface.

Cloud 9 connects remote or intranet users to their host-based systems through the
industry-standard Web browsers: Microsoft Internet Explorer and Netscape
Navigator. Utilizing existing Web technology, a Hypertext Transfer Protocol (HTTP)
Server, and the source management capabilities of SCLM, Cloud 9 gives developers
distributed access to the programmer functions of SCLM without the need to log
on to ISPF. Programmers can now access both distributed and host-based
application inventory regardless of location or host-based licensing restrictions.
With Cloud 9, organizations can take advantage of the security and stability of
SCLM and the z/0S platform from their Web browser.

This chapter describes how to get started using Cloud 9, including how to:
» Configure your browser to use Cloud 9

+ Start Cloud 9

» Set up your profile

You need the following:
» Uniform Resource Locator (URL) for Cloud 9 (Web address)
e TSO user ID for host access
» Password for host
* Names of data sets you want to view on the host
 Either:
— Netscape 4.7 or higher
— Internet Explorer 5.0 or higher
* Your e-mail address and telephone number
 Digitized photograph of yourself in .jpg format (optional)

Starting Cloud 9

You can access Cloud 9 from either of the most popular Web browsers— NetScape
Navigator or Microsoft Internet Explorer. Before you begin Cloud 9, ensure that
your browser is configured properly.

Setting up your Web browser

Before using the Cloud 9 Web interface, check that your Web browser uses the
following settings.

Refresh every time
Ensure that your Web browser retrieves the latest version of a page every time you
visit, rather than using a cached version from a previous visit.

Netscape users
1. From the Edit menu, select Preferences.
2. Under the Advanced category, select Cache.

© Copyright IBM Corp. 2001, 2004 3



3. Under “Document is compared to document on network”, click “Every
time”.
Internet Explorer users
From the Tools menu, select Internet Options.
Click the General tab.
Under “Temporary internet files”, click the Settings button.
Under “Check for newer versions of stored pages”, select “Every visit
to the page”.

rpON =

Enable Java
The Cloud 9 Web interface is a Java applet. Ensure that your Web browser is
configured to run Java.

Netscape users
Navigator versions 4.5 and later are already Java-enabled, therefore
nothing more needs to be done.

Internet Explorer users
1. From the Tools menu, select Internet Options.
2. Click the Advanced tab.
3. Scroll down to Java VM or (depending on your version of IE) Microsoft
VM.
4. Select all the check boxes under this option.
5. Restart your computer.

Use a direct connection

You can use the Cloud 9 Web interface to communicate with a Cloud 9 host over a
corporate intranet or over the Internet, using a dial-up modem or a direct LAN
connection. In any case, you need a connection between your browser and the
Cloud 9 host that is unhampered by proxy servers or firewalls. If you are
connecting within a corporate intranet, then you can ensure this by turning off
proxies in your browser, as described in the procedures later in this section.

However, most corporations have a firewall between their intranet and the
Internet; and the only way that you can access the external Internet is through a
corporate proxy server. Therefore, if you turn off proxies in your browser, you can
use Cloud 9, but you might not be able to access the Internet. In this case, the
solution is to contact your network administrator, who can change the proxy server
to recognize the Cloud 9 server address and provide a direct connection. If this is
done, you can leave proxies turned on, and use both Cloud 9 and the Internet.

To turn off the use of proxies by your browser:

Netscape users
1. From the Edit menu, select Preferences.
2. Under the Advanced category, select Proxies.
3. Select “Direct connection to the Internet”.

Internet Explorer users
1. From the Tools menu, select Internet Options.
2. Click the Connections tab.
3. Click the LAN Settings button (if you are connected through a LAN) or
the Dial-up Settings button (if you are connected by a modem).
4. Select “Automatically detect settings”. Deselect “Use a proxy server”
and “Use automatic configuration script” .
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To access Cloud 9
From a properly configured browser:
1. Open your browser window.

2. Type the URL for Cloud 9 in the location/address field of the browser and
press ENTER. is displayed before the next browser window opens.

Enter Network Password EH

?> Pleaze type your user name and password.

Site: pthrmee s
Realn System_Logan
Uzer Mame |

Passyword |

[ Save this passwaord in your password list

[ Cancel

Figure 1. Enter Network Password Panel

3. Type in your User Name and Password.
4. Press OK.

Attention: If the password panel does not display, you might not have the
correct Web address (URL). Check with the system administrator to ensure you
have the correct address.

The Cloud 9 Main Menu Panel
The next panel you see is the Cloud 9 Main Menu, as shown in

Select a query function to display a list. Actions
can then be performed on the list.

Figure 2. Cloud 9 Main Menu

If this is the first time you have logged onto Cloud 9, the pop-up panel shown in
[Figure 3 on page 6| is displayed. Fill in valid job card information in the
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appropriate place on the profile panel. See [“Setting Your Profile” on page 7| for
more information.

Microsoft Internet Explorer |

& JOB CARD must be present in Profile

Figure 3. Job Card Pop-up Panel

The Main Menu is divided into the following sections:

Query Functions
These are the functions that you use to create lists of objects residing on
the host. Depending on which files you want to work with, you can choose
to:
* List SCLM Files
* List Members
* List Unix Files.

Actions
There are two choices listed under this section:
* Add PC/WS Files, where you can add Personal Computer or
Workstation files to your host repositories.
» Edit, from which you can edit files of your choosing.

Misc Functions
There are two miscellaneous functions:
* Open Package is the selection to start working with new or existing
packages.
» Profile is the selection to create or work with your personal profile for
Cloud 9.

About Cloud 9
A copyright statement for the Cloud 9 product that includes the product
number and release number of the version your installation has installed.

All of these functions are explained in various sections of this book.

Using Pull-Down Lists

Several of the panels within Cloud 9 have entry fields that have an associated list
of the values available for selection in the field. You can enter a value in these
types of fields or you can display the list and then select from it. All fields that
have a question mark (?) button next to them have this feature. For example,
[Figure 4 on page 7| shows part of the SCLM Query Panel with the Projects list
open.
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Project: lmﬂ

alternate: l—ﬂ
Group: |TEST ﬂ ’ j
e [ 7]l
Member : l— A
Language: liﬂ gE%
crengecsde: [ enengo . [

Authorization code: | R EST

Figure 4. Pull-down Menu

» To display a list, click the question button. Cloud 9 returns a list box that
contains the possible values that can be entered in that field.

» To select an item from a pull-down list, click anywhere on the list box to open it,
then click your selection. Cloud 9 returns your choice to the adjacent field.

Note: Only one pull-down list is displayed at any one time.

Setting Your Profile
It is important that you set your profile before you begin using the system. Setting
your profile:
» Creates a job card; without one you cannot run batch actions

* Improves communication with other users by providing your telephone number
and e-mail contacts

» Automatically starts browsers and editors.

To set your profile;

1. Select PROFILE from the Cloud 9 Main Menu. The Profile panel is displayed
(Figure 5 on page 8).
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User ID: SCLMUSE

Add your picture:
{Picture must be in . jog format)
Full Marme:

Email:

Phone:

I Browse. .. |

Wiew Source in Browser: " as % Mo

Edlit Source in Browser 1 Yes % Mo

Job ID: I

Increment Jobname: i ves Mo

Jobcard:
=
[~

Update profile |

Figure 5. Cloud 9 Profile Panel

2. The entry fields on the Profile panel are as follows:

The file name and path name of a digital
picture that you want to add to your profile.
See [*How to Add Your Picture (Optional)” on|
|Eage 9| for more information.

Your name.

Your e-mail address.

Your telephone number.

The default setting to be used when viewing
members or files:

Add your picture

Full Name

Email

Phone

View Source in Browser

Edit Source in Browser

8 Cloud 9 for SCLM for z/0S User’s Guide

Yes — If accessing a text source file, the file
automatically opens in a new browser
window. If accessing a non-text file, the
browser automatically prompts you to either
open the file or download it to your PC or
Workstation.

No — Show the View Options panel, in
which you can choose to open the file in a
browser window (text only), open the file
using its internal format (binary) or
download the file to your PC or Workstation.

The default setting to be used when editing
members or files:

Yes — If accessing a text source file that is
not contained in an SCLM Group, the file
automatically opens in an edit session in a
new browser window. If accessing a non-text
file that is not contained in an SCLM Group,
the browser automatically prompts you to
either open the file or download it to your



PC or Workstation. If accessing files
contained in an SCLM Group, the Edit
Options panel is always displayed, as there
are SCLM parameters such as Lock in Group
and Access Key that might need to be
specified.

* No — Show the Edit Options panel, in which
you can specify the SCLM parameters (if
necessary) and then choose to open the file in
a browser window (text only), open the file
using its internal format (binary) or
download the file to your PC or Workstation.

Job ID A letter to be appended to the Jobname.
Increment Jobname

* Yes —the letter that has been appended to
the Jobname is incremented with each job
submission.

* No — no incrementing of the Jobname.

Jobcard Job card used to submit batch jobs on your host
system. It must have valid accounting
information, class specifications, and so on.

3. Complete as many of the fields as you require.

4. Click the Update Profile button. A message confirms that your Profile has been
updated.

Profile Updated

Query Functions

LIST SCLM FILES
LIST MEMBERS
LIST UNIX FILES

Figure 6. Profile confirmation message

Note: User profiles are an important feature of Cloud 9. If you attempt to edit or
manipulate a file that is in use or has been locked and the person who is
using/locked the file has completed his or her User Profile, you can view
that user’s telephone number and e-mail address in the member Accounting
information. You can then call or e-mail the user to inquire about the
member’s availability, or to give an alert that you also need to make changes
to it.

How to Add Your Picture (Optional)

The first field in the Profile panel asks you for the location of a picture. If you
already have a digital version of a photograph, find that file on your hard drive by
clicking the Browse button. Select the picture file and click the Update profile
button.

If you do not have a digital photograph, see|Appendix B, “Creating and Adding|
[ipg Images to the User Profile,” on page 185| for suggestions for getting one.

Note: The picture must be in a file with a .jpg extension.
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Chapter 2. Working with Objects

By using Cloud 9, you can work with members or files that are stored within an
SCLM hierarchy, within PDS data sets or on a Unix server. This chapter describes
how to:

* Generate a list of SCLM members, PDS members or Unix files.
» Select members or files for viewing, editing and other manipulation purposes.

* View members and files within a browser window (where appropriate), open
them within in another application or download them to your PC or
Workstation.

» Edit Text and Binary members and files.

Listing Objects

Most of the Cloud 9 functionality begins by listing members or files, using the
Cloud 9 Main Menu. When you choose one of the three List functions, you create
a list of objects from which you can perform most of the Cloud 9 functions such as
editing, building, and promoting.

Listing SCLM Members

You can create a list of the SCLM members with which you want to work, by
using the SCLM Query panel. This panel displays the various SCLM inventory
locations and query filter settings. A query filter helps you to limit your request to
specific items with common characteristics.

1. From the Cloud 9 Main Menu (Figure 2 on page 5), select LIST SCLM FILES.
The SCLM Query panel (shown in|Figure 7D is displayed.

SCLM Query

Froject: l— ﬂ
Alternate: I— ﬂ
Group: Ii ﬂ
Type: l— ﬂ
Mermber: |
Language: l— ﬂ
Authorization Code: I— ﬂ
Change code: I—
Change user: I—

Arcess key: |

Hierarchy Wiew: © Inthisgrouponly @ Firstfound ¢ &ll occurrences
ACCOUnting Status: & Al © Editable  © Mon-Edit © Lockout € Initial

Reset |

Figure 7. SCLM Query Panel

The entry fields on the SCLM Query Panel are:
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Project

Alternate

Group

Type
Member
Language
Change code

Change user
Authorization code

Access key

Hierarchy View

Accounting Status

The name of the project that contains the
member you want to access. This is the only
required field on this panel.

If you are using an alternative project for this
particular process, enter its name here.

If blank, it defaults to the same name as the

project.

The name of the group that contains the

member you want to access.

The name of the type that goes with the project

and group containing the member that you

want to access.

The name of the member that you want to

access.

A valid SCLM language for this project.

A valid SCLM change code string.

The last user ID to have updated a member.

Your authorization code. This is a character

string that cannot contain commas, comprising

up to and including 8 characters.

An identifier used to restrict access to a

member. The default valued is the user ID of

the person who currently has the member
locked.

Selects the scope within the SCLM hierarchy in

which the members can be found.

* In this group only — list members found
only in the chosen group.

» First found — list only the first occurence of
a match, starting in the group specified and
continuing up the project hierarchy.

» All occurrences — list all members found in
this project.

Selects the Accounting Status within the SCLM

hierarchy in which the members can be found.

* All — all members found.

» Editable — only members that can be edited.

* Non-Edit — members that SCLM creates as a
result of build processing.

* Lockout — only locked members.

 Initial — Members for which a lock has been
requested. This status generally is displayed
while a member is being edited. When the
edit is complete, the status changes to
Editable.

2. Complete as many fields as you wish, ensuring that at least the Project field is
filled in. You can leave each of the rest of the inventory and query filters blank,
enter valid values in them, enter values with wild card characters in them, or
select valid values from the lists by clicking on the '?’ next to the field.

Note: The wild card search character (*) is available for use in all fields except
Project and Access key. The wild card character is used to replace
certain characters in an entry when you want to find all objects that
match a certain pattern. For example, if you wanted to find members
ROD, RAD and RED, you can use the wild card like this:
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RxD
3. Click the Submit button. This submits the query for processing.

If the query finds members using your specifications, the SCLM Member List panel

is displayed (Figure §).

Member (4) Project Group Type Language Status Access key

[ MJET SCLMTEST TEET  ARCHDEF ARCHDEF  EDITABLE
I MJBT SCLMTEST TEST  JCLUE TEXT EDITABLE
[T TESTEAC!  SCLMTEST TEST  SOURCE  TEXT EDITABLE
[T TESTPROM SCLMTEST TEST  SOURCE  TEXT EDITABLE

Figure 8. SCLM Member List

Note that the Main Menu changed after showing a list of members. The left side of
the panel always reflects the actions available based on what has been listed. In
this case, the menu contains all SCLM actions.

Figure 9. Menu options when SCLM Member list is displayed

If the query does not find any members, a message is displayed within the panel:

No Members Found

Query Functions

Figure 10. No members found message

You can select the LIST SCLM FILES menu option again, adjust your query
specifications and click Submit again.
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If you made an error in your query specifications, a message box is displayed to
show the cause of the problem (see |Figure 11). Click the OK button, adjust your

query specifications and click Submit again.

Microsoft Internet Explorer | Microsoft Internet Explorer |

& Please enter a project & wild carding not supported For praject Field

Project field was empty Project field contains a wild card character

Figure 11. SCLM query error messages

Notes:

1. If a wild card character is used in the Access key field, no error message is
generated. Instead, it is treated as a text character and used in the search, e.g
finding all members in which the Access key contains an asterisk. As a result,
the query is unlikely to find matching members.

2. Clicking the Reset button clears all of the current field values. You can then
begin constructing a new query.

3. The 'LIST SCLM FILES’ option only lists members that have accounting
information in the SCLM accounting file. As a result, using the 'LIST SCLM
FILES’ might not display all members in a PDS. To view all members in a PDS,
use the 'LIST MEMBERS’ option.

Listing Partitioned Data Set (PDS) Members

You can create a list of the PDS members with which you want to work, by using
the List Members panel. In this panel, you can enter up to 7 data set and member
name patterns.

1. From the Cloud 9 Main Menu, select LIST MEMBERS. The panel in[Figure 12
is displayed.

List Members

Dataset Name Member

| [

|
|
|
| |
|
|
|

Show & First found © All

Clear |

Figure 12. List Members Panel

The entry fields on the List Members Panel are as follows:
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Dataset Name Conventional Partitioned Data Set (PDS) or
Partitioned Data Set Extended (PDSE) data set.
The name must be entered without quotation
marks and can use wild card characters.

Each level within a data set name can contain
wild cards, however, the return results are
restricted to members in data sets with the
number of levels specified in your pattern. For
example:

SCLMUSR. *

returns members in all matching data sets with
two levels in their name but not those with one,
three, or more levels (SCLMUSR.SRC but not
SCLMUSR or SCLMUSR.SRC.TEST);

whereas:
SCLMUSR. * . *

returns members in all data sets with three
levels in their name but not those with one,
two, four, or more levels (SCLMUSR.SRC.TEST
but not SCLMUSR, SCLMUSR.SRC or
SCLMUSR.SRC.TEST.DATAL).

To list all matching data sets, regardless of the
number of levels in the data set name, use a
double asterisk, (**). For example:

SCLMUSR. **

would return the members in SCLMUSR,
SCLMUSR.SRC and SCLMUSR.SRC.TEST, and
So on.

Member A member name, a pattern including wild cards
or blank. Leaving the field blank results in a list
of all members within the specified data set(s).

Show Where the search finds multiple members with
the same name, this determines the number of
matches returned.

* First found — show the first occurrence
encountered.
* All — show all occurrences.

2. Complete as many fields as you wish, ensuring that at least one data set name
pattern is entered.

3. Click the Submit button. This submits the query for processing.

If the query finds members using your specifications, the Member List panel is
displayed (Figure 13 on page 16).
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MemberList |
Member (5) Dataset Name

r TESTSMTF SCLMTEST. TEST. JCLLIB FULL

[ TESTO1 SCLMTEST. TEST. JCLLIB.FULL

r TESTOZ SCLMTEST. TEST. JCLLIB FULL

r TESTOZ SCLMTEST. TEST.JCLLIB.FULL

r TESTO4 SCLMTEST. TEST. JCLLIB. FULL

Figure 13. PDS Member List

Note that the Main Menu changed after showing a list of members. The menu
always reflects the actions available, based on what has been listed. In this case,
the menu is all PDS actions. For information about the various functions available
to you, see [Chapter 5, “PDS Functions,” on page 87|

Misc Functions

PROFILE

ABOUT

Figure 14. Menu options when the Member List is displayed

If the query does not find any members, a message is displayed within the panel:

No Members Found

OQuery Functions

Figure 15. No members found message

You can select the LIST MEMBERS menu option again, adjust your query
specifications and click Submit again.

If you made an error in your query specifications, a message box displays the
cause of the problem (see [Figure 16 on page 17). Click the OK button, adjust your
query specifications and click Submit again.
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Microsoft Internet Explorer |

& Flease specify a dataset name

All data set name fields are empty

Figure 16. List Members query error message

Note: Clicking the Clear button clears all of the current field values. You can then
begin constructing a new query.

Listing Unix Files
You can create a list of the Unix files with which you want to work, by using the

Unix File List panel. In this panel, you can enter up to 7 Unix file paths and file
name patterns.

1. From the Cloud 9 Main Menu, select LIST UNIX FILES. The panel in[Figure 17]
is displayed.

Unix File List

Unix Path Name File

|
|
|
| |
|
|
|

€ Listhy path © List by file

Subrmit | Clearl

Figure 17. Unix File List Panel

The entry fields on the Unix File List Panel are as follows:
Unix Path Name Fully qualified path for an HFS directory,
starting with the root. For example:

/usr/1pp

File An HFS file name, a pattern with wild card, or
blank.

List by path Occurrences found are listed according to path

names. All occurrences under one path are
listed before occurrences under a separate path
are listed.

Making this selection might cause the resulting
list to include directories upon which you
cannot act.
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List by file The list is ordered according to file name
regardless of path.

2. Complete as many fields as you wish, ensuring that at least one Unix file path
is entered (you cannot use the wild card search character in a Unix path name).

3. Select either List by path or List by file.
4. Click the Submit button. This submits the query for processing.

If List by path is chosen and the query finds files or directories using your
specifications, the Unix Directory List panel is displayed (Figure 18).

Unix Directory List

File Type File Name (2) Directory Path
r file librm. a fustilib
<= dir b a fusr/lib

Figure 18. Unix Directory List

Note that the Main Menu changed after creating a list of Unix files. The menu
always reflects the actions available, based on what has been listed. In this case,
the menu is all Unix actions. For information about the various functions available
to you, see [Chapter 6, “Unix Functions,” on page 95

Figure 19. Menu options when the Unix Directory List is displayed

If the query does not find any results, a message is displayed within the panel:

No Files Found

Figure 20. No files found message
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You can select the LIST UNIX FILES menu option again, adjust your query
specifications and click Submit again.

If you made an error in your query specifications, a message box displays the
cause of the problem (see [Figure 21). Click the OK button, adjust your query

specifications and click Submit again.

Microsoft Internet Explorer |

& Please specify a path value

Unix Path Name field is empty

Figure 21. List Unix Files query error message

Note: Clicking the Clear button clears all of the current field values. You can then
begin constructing a new query.

Selecting and Viewing Objects

Once your list of objects (SCLM members, PDS members or Unix files) has been
created, you can select and view the objects, using the same techniques.

Selecting list items
With a Member List or Unix File List panel displayed:
* Manually select or clear the check box for each list item.

¢ Click the SELECT ALL menu command, found within the MISC FUNCTIONS
section of each modified menu.

¢ Click the DESELECT ALL menu command, found within the MISC
FUNCTIONS section of each modified menu.

Note: Although the SELECT ALL and DESELECT ALL commands remain visible
after you have left the list panels, they have no effect if the panel is not
currently displayed.

Once you have selected the list members, you can choose any of the available
menu commands. Cloud 9 retains your selections until you remove them, perform
another query or leave the Cloud 9 site.

Viewing Objects
Members and files can be viewed in a browser window, opened using the
application associated with their extension or downloaded to your PC or
Workstation and then opened for viewing. Files that have been opened in a
separate application or downloaded can also be edited, however, you cannot
transmit the edited file back into SCLM as part of this process (see
[an Edited Member Back to SCLM” on page 29). Instead, you must use the Add
PC/WS File menu command (see [*“Add PC/WS Files” on page 47).
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Your method of viewing objects varies, depending upon your Profile settings (see
[“Setting Your Profile” on page 7), your browser settings and the File Type of the
object you are viewing:

* Your Profile settings determine whether the member or file is opened
automatically in a browser window, using the default File Type setting, or if the
View Options panel displays, in which you can choose the View in Browser or
Download option and to set the File Type (Default, Text or Binary).

» If the View Options panel is displayed, Internet Explorer users can use the
Download option for all File Types. Netscape Navigator users can use the
Download option for Binary files but must use their Netscape Preferences to
determine how to handle Text files when the Download option is selected.

* The method used to display Binary files depends upon your browser settings,
the available browser plug-ins, the applications registered on your PC or
Workstation and whether the file type is registered in the SLR Add Types within
SCLM (see [“Editing Binary Files” on page 30| for details).

Note: "Text" files are those objects that use EBSCIC format (for example, members
that have been created in SCLM or in an Edit Session within Cloud 9) or
ASCII format (for example, files that have been created in Notepad or a
similar text editor). "Binary” files are all those files created in an external
application that use a format internal to that application (for example,
Microsoft Word documents).

Netscape settings for handling Text files

If you are using Netscape Navigator and choose the View in Browser option for a
Text file, Netscape displays the text as an HTML page within a new browser
window. However, if you choose the Download option, Netscape uses its internal
settings to handle this file.

To customize your Netscape settings:
1. From the Netscape menu, click Edit > Preferences...

2. Select the Navigator > Applications category and locate the Description for
Plain Text (Figure 22 on page 21).
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Preferences E3 |

LCateqgarny:

=l Appearance

-~ Smart Browsing
- Mail & Mewsgroups
- Floaming Access

- Compozer

- Offline

- Advanced

Specify helper applications for different file types

Dezcrption
PKCS #7 Signature ;l Mew Type... |
PrCSY Encrypted Data _
PKCS? Signature Edit.. |
Plain Text
PMG Image Remove |
PPIE" w32 File
PPIE W 32 File _l
Pre-enciypted Data
Froperty % alue File LI
— File type detailz
% Extenzion:  TxT TEXT
MIME Type:  text/plain
Handied By Metzoape [intermal)
] I Cancel Help

Figure 22. Netscape Navigator Plain Text category

3. Click the Edit button. The Edit Type dialog box is displayed:

Chapter 2. Working with Objects

21




Edit Type |

Extenzion;  THT TEXT

MIME Tope:

[ Usze thiz MIME as the outgoing default far theze file extenzions

—Handled By
* Mavigator

i~ Save to Disk

™ spplication:

Browse... |

¥ | £sk me before opening downloaded fles of this ype

k. I Cancel

Figure 23. Netscape Navigator Plain Text settings

4. Select one of the Handled By options:

* Navigator - a Text object opens as an HTML page within a new browser
window, even when the Download option is selected.

» Save to Disk - the Save As dialog box is displayed when the Download
option is selected.

» Application - use the Browse button to select the application executable file
to be used when the Download option is selected.

* Ask me before opening downloaded files of this type - if the Application
option is selected and this is selected, a dialog box offers the choice of
opening the object or saving it to disk, when the Download option is
selected. If this option is cleared, the specified application opens
automatically and displays the downloaded Text object.

5. Click OK in the Edit Type dialog box and OK in the Preferences dialog box.

Using the View command
If your Profile has the View in browser option set to Yes, then:

1. Generate a list of members or files (see [“‘Listing Objects” on page 11).

2. Select the members or files that you wish to view (see [“Selecting list items” on
[page 19).

3. Select VIEW or VIEW MEMBER from the Cloud 9 Main Menu.

» If the selected object is a Text file (ASCII or EBCDIC), the file opens in a new
browser window, converting EBCDIC to ASCII where necessary.
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import java.util.*; =

public class Hello {
public static void main(String args[]) {
System.out.println("Hello");
¥

4 o

Add to SCLM

SCLM Project: [scimesT | 2| Submit | Canceland Unlock |
Alternate: I ﬂ -
, ' _>|_I

4]

Figure 24. Text file as viewed in a browser window

* If the selected member is a Binary file, the browser prompts you to open the
file using its internal format or to download the file to your PC or
Workstation (see [“‘Editing Binary Files” on page 30).

Note: If multiple files are selected, each file either opens in a new window or
causes the browser to prompt you to open or download it, depending
upon the file type.

If your Profile has the View in browser option set to No, then:
1. Generate a list of objects (see [“Listing SCLM Members” on page 11).
2. Select the members or files that you wish to view (see [“Selecting list items” on

[page 19).
3. Select VIEW or VIEW MEMBER from the Cloud 9 Main Menu. The View

Options panel (Figure 25) is displayed.

Wiew in Browser:  Yes O No, download as a File
File Type: & Default © Text ¢ Binary

Subrnit |

Figure 25. View Options

The entry fields on the View Options panel are:
View in Browser Determines how the selected member or file is
opened.
* Yes — If the selected member is a Text file, it
opens in a new browser window, converting
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EBCDIC to ASCII where necessary. If the
selected member is a Binary file, it is handled
according to your browser settings and other
factors (see [“Editing Binary Files” on page 30|
for details).

* No — Regardless of the file type, the browser
prompts you to download the file to your PC
or Workstation.

Note: For Netscape users, the action taken is
determined by your browser settings.
File Type Determines in what format the selected member
or file is opened.

* Default — Cloud 9 selects the access method
(Text or Binary) based on the file’s extension.

* Text — access the member using EBCDIC to
ASCII conversion where necessary. If this
format is selected for a Binary object, the
binary code for the file is displayed in a new
browser window or downloaded, according
to your View in Browser option and your
browser settings.

* Binary — access the member using its
internal format. If this format is selected for a
Text file, the binary code for the file is
displayed in a new browser window or
downloaded, according to your View in
Browser option and your browser settings.

4. Select your options and click Submit. The selected member(s) or file(s) open.

Note: If multiple files are selected, your View Options choices apply to all of
the selected files.

Table 1. Summary of View results for Text objects

View Options File Type IE NS
Profile View in Browser = Yes Default WP WP
View in Browser = Yes Default WP WP
View in Browser = Yes Text WP WP
View in Browser = Yes Binary WP, BC WP, BC
View in Browser = No Default FD BS
View in Browser = No Text FD BS
View in Browser = No Binary FD, BC BS, BC
IE Internet Explorer

NS Netscape Navigator

WP Displays as a Web page in a new browser window
FD Displays the File Download dialog box

BS Action is determined by the browser settings

BC Binary code for the object is displayed/downloaded
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When you have finished viewing the file, close the relevant window. The Cloud 9
browser window becomes active again.

Editing Objects

Text-based objects can be opened for editing within a browser window and then
saved back into an SCLM hierarchy, a PDS data set or a Unix server. Both
Text-based and Binary files can be opened in an external application or
downloaded to your PC or Workstation, edited and then added back into an SCLM
hierarchy, a PDS data set or saved to a Unix server, using the Add PC/WS Files
command.

Your method of editing objects varies, depending upon your Profile settings (see

[“Setting Your Profile” on page 7), your browser settings and the File Type of the

object you are editing:

* Your Profile settings determine whether the member or file is opened
automatically in a browser window, using the default File Type setting, or if the
Edit Options panel is displayed, in which you can choose the Edit in Browser or
Download option and to set the File Type (Default, Text or Binary).

Notes:

1.

The Edit in browser setting in your Profile is ignored when editing SCLM
members, as there are SCLM parameters (such as Lock in Group and
Authorization Code) that might need to be specified.

Netscape browsers limit the amount of text that can be placed in a text area
control to approximately 50,000 bytes. If you are using a Netscape browser
and you attempt to edit an object that is larger than 50,000 bytes, Cloud 9
will download the file to your workstation, rather than attempt to place the
large file into your browser text area control.

» If the Edit Options panel is displayed, Internet Explorer users can use the
Download option for all File Types. Netscape Navigator users can use the
Download option for Binary files but must use their Netscape Preferences to
determine how to handle Text files when the Download option is selected (see

[Netscape settings for handling Text files” on page 20).

* The method used to edit Binary files depends upon your browser settings, the
available browser plug-ins, the applications registered on your PC or
Workstation and whether the file type is registered in the SLR Add Types within
SCLM (see [“Editing Binary Files” on page 30| for details).

Note: "Text” files are those objects that use EBSCIC format (for example, members

that have been created in SCLM or in an Edit Session within Cloud 9) or
ASCII format (for example, files that have been created in Notepad or a
similar text editor). "Binary” files are all those files created in an external
application that use a format internal to that application (for example,
Microsoft Word documents).

Opening an object for editing

If your Profile has the View in browser option set to Yes and the selected member
or file is not in an SCLM hierarchy, then;

1.

Generate a list of members or files (see [‘Listing Objects” on page 11).

2. Select the members or files that you wish to view (see [“Selecting list items” on|

lpage 19)

3. Select EDIT or EDIT MEMBER from the Cloud 9 Main Menu.
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 If the selected object is a Text file, the file opens in an editing session within
a new browser window, converting EBCDIC to ASCII where necessary.

| »

import java.util.=;

public class Hellao {

public static void main(String args[]) {
System.out println("Hella"):

¥

Kl _>I_I
Add to SCLM

SCLM Project: [scLmTEST | 2| Submit | Cancel and Unlock |
Alternate: I ﬂ -
: I ;I_I

4]

Figure 26. Browser editing session

» If the selected member is a Binary file, the browser prompts you to open the
file using its internal format or to download the file to your PC or
Workstation (see [“Editing Binary Files” on page 30).

Note: If multiple files are selected, each file either opens in a new window or
causes the browser to prompt you to open or download it, depending

upon the file type.

If your Profile has the Edit in browser option set to No or is an SCLM member,
then:

1. Generate a list of objects (see [“Listing SCLM Members” on page 11)).

2. Select the members or files that you wish to edit (see [“Selecting list items” on|

page 19).
The Edit Options panel is displayed (Figure 27).

Edit in Browser: & vyes ¢ No, download a5 a File
File Type: © Default © Text ¢ Binary

Subrnit Reset

Figure 27. Edit Options for PDS members and Unix files

The entry fields on the Edit Options panel are:
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Edit in Browser Determines how the selected member or file is
opened.

* Yes — If the selected object is a Text file, it
opens in an editing session within new
browser window, converting EBCDIC to
ASCII where necessary. If the selected object
is a Binary file, it is handled according to
your browser settings and other factors (see
[“Editing Binary Files” on page 30| for details).

* No — Regardless of the file type, the browser
prompts you to download the file to your PC
or Workstation.

Note: For Netscape users, the action taken is
determined by your browser settings.
File Type Determines in what format the selected member
or file is opened.

» Default — Cloud 9 selects the access method
(Text or Binary) based on the file’s extension.

» Text — access the object using EBCDIC to
ASCII conversion where necessary. If this
format is selected for a Binary object, the
option is ignored, that is, it is treated as a
Binary object.

* Binary — access the member using its
internal format. If this format is selected for a
Text object and the Edit in Browser option is
Yes, the object opens in an editing session
within new browser window, converting
EBCDIC to ASCII where necessary. If the Edit
in Browser option is No, the binary code for
the Text file is displayed in a new browser
window or downloaded, according to your
browser settings.

Eat

Edit in Browser: & Yes ¢ Mo, download as a File
File Type: & Default © Text © Binary

Lock SCLM Member: & ves Mo

Lock in Group: IDEV1 v|
Authorization code: I 'I

Submit | Reset

Figure 28. Edit Options for SCLM Members

The additional entry fields on the SCLM-specific Edit Options panel are:
Lock SCLM Member Determines if the member is locked upon
opening.
* Yes — locks the member into the SCLM
group specified in the Lock in Group field.
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* No — the member is opened without
locking.

Lock In Group The name of the SCLM group into which you
want to store this object (must be a
development level group). If the selected
member does not reside in a development level
group, the member is copied to the group
specified here and the copy is opened for
editing.

Authorization code Standard code.

3. Specify your Edit options.
4. Click Submit.

If the file is available for editing (that is, not locked or in use), the file is
opened in the specified manner.

Note: If you are running a version of Netscape that is pre-6.x and attempt to
open a Text file greater than 20k within a browser editing session, you
are prompted to download the file instead. (Netscape pre-6.x has a
limitation of 20k worth of data that can be put in a HTML text area).

If the file is in use or has been locked, Cloud 9 displays an error message.

File already locked under access key DOHERTL.

Edit of member not allowed.

Merber...: A0293J07
Type.....: SOURCE

Figure 29. File locked message

If you receive this message, you might want to look at the Accounting
Information, which (if the user has completed his or her Cloud 9 Profile)
displays the user’s e-mail address and telephone number (see [“Viewing SCLM|
[Accounting Information” on page 64). You can then call or e-mail the user to
inquire about the member’s availability, or to give an alert that you also need
to make changes to it.

Table 2. Summary of Edit results for Text objects

Edit Options File Type IE NS
Profile Edit in Browser = Yes® Default ES ES
Edit in Browser = Yes Default ES ES
Edit in Browser = Yes Text ES ES
Edit in Browser = Yes Binary ES ES
Edit in Browser = No Default FD BS
Edit in Browser = No Text FD BS
Edit in Browser = No Binary FD, BC BS, BC
Notes:

1. If the selected object is an SCLM member, the Edit Options panel is displayed.

IE Internet Explorer
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NS Netscape Navigator

ES Displays text within an Edit Session in a new browser window.

FD Displays the File Download dialog box.

BS Action is determined by the browser settings.

BC Binary code for the object is displayed/downloaded.

Once a member or file has been opened in a browser editing session, it can be
modified and then transmitted back to its source, using the panel options at the
bottom of the edit session browser window (see [“Transmitting an Edited Member]

Back to SCLM™).

Members and files that have been opened in the applications associated with their
extensions or have been downloaded to your PC or Workstation must be saved
and then uploaded with the Add PC/WS Files command (see [“Editing Binary|

[Files” on page 30).

Transmitting an Edited Member Back to SCLM

When you are finished making changes to the member:

1.

Scroll to the appropriate form beneath the editing area.

These forms are almost identical to those seen when creating a new object in a
browser editing session (see [“Creating Text-based objects” on page 43). The
only difference is that the Add to SCLM form also contains a Cancel and
Unlock button.

The Cancel and Unlock button closes the editing session and releases a locked
SCLM member.

Update the fields in one section (Add to SCLM, Add to Dataset, Add to Unix
or Submit Batch Job) and click the Submit button in that section.

If all required fields were completed correctly and the submission is successful,
a confirmation message is displayed:

Save messages

Member processed:
3hortname = TE3I0DZ513
Longhname TEITOOOZ

Add-back complete.

Press the Back button to make addiional changes.
Close this window when you are fintished making changes.

Figure 30. Successful save message

If a required field was not completed or contains incorrect data, an error
message is displayed and describes the cause of the problem.
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Microsoft Internet Explorer |

& Member is required,

Figure 31. Example form error message

Click the OK button, correct the error and click the Submit button again.

If the form is correctly completed but the submission is unsuccessful, a message
is displayed and describes the reason for failure, such as:

Errors occurred
Save is allowed only in an entry group.

FPress the Back button, correct the error, and retry sawve.

Figure 32. Example of Add-back failure message

Notes:

1. If an SCLM member was not locked on opening, setting the Lock option to
Keep on this form applies a lock to the member.

2. You can use this form to return an edited member or file to a different SCLM
location, a different PDS data set or a different Unix directory, performing a de
facto copy. If the object was an SCLM member that was locked on opening, the
original remains locked and the copy is locked or unlocked according to the
settings on this form.

Editing Binary Files
So far, you have seen how to edit Text files in a browser Edit Session, however,
with Cloud 9’s versatility you can open or download any file stored in SCLM to
the PC/Workstation, and edit it using another editor program. Cloud 9
accomplishes this by using the file’s extension to determine the appropriate edit
program to open.

For Cloud 9 to be able to "recognize” a file extension and handle the file
appropriately, the extension must be registered as an SCLM Type and the Type
must be defined within the Suite Long Name Registry (SLR). See [“Adding and

[Defining Cross-Platform File Types” on page 36| for details.

File Extensions That Are Recognized by Cloud 9

These steps might vary slightly depending upon the browser and version that you
are using. This section describes the actions that result when you use either
Internet Explorer v5.5 or Netscape Navigator v4.75.

1. Generate a list of members or files (see [“Listing Objects” on page 11).
2. Select the members or files that you wish to view (see [“Selecting list items” on
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3. Select EDIT or EDIT MEMBER from the Cloud 9 Main Menu.

Note: If you want to download a Text file that is not an SCLM member (rather
than edit in the browser), you must set the Edit in Browser option in
your Profile to "No”. This forces the display of the Edit Options panel, in
which you can select the Download option. Otherwise, the file
automatically opens in an editing session within a new browser window,
converting EBCDIC to ASCII where necessary.

4. On the Edit Options panel, select the View Option as required and set the File
Type to Binary.
5. Click Submit.

From this point on the process varies, depending upon your browser version
and your operating system’s list of registered file types.

If you are using Internet Explorer:

» |f the Edit in Browser option is set to Yes and the file was created using one of
the Microsoft Office suite of products, the file is immediately displayed as an
object embedded within a browser window. Most of the application menu
commands are available.

<= http://pthmvs8:1695/ cgi-bin/CLZRSCLM - Microsoft Internet Explorer

J File Edit ‘iew Insert  Formak  Tools  Table GoTo Favoribes Help |

J 4=Eack - = - (£} ﬁ-| ‘Qhsearch [E]Favorites ¢ 4History |ﬁ B S H

J Links &]5earch the Web with Lycos & IBM Business Transformation &7 IBM Inkernal Help ”
| Address [£7 httpsjjpthnmyss:1695cai-bin/CLZRSCLM ~| pen
[L] S a0 e e S o

Teztdoc

v

-
2 |
B
7
=] EEEEN | »

I_ I_ /@ Unknown Zone &

Figure 33. Microsoft Word document in an Internet Explorer browser

B

B

 If the Edit in Browser option is set to Yes and the file was not created using one
of the Microsoft Office suite of products, a new browser window opens and the
File Download dialog box is displayed (Figure 34 on page 32).
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File Download Ed |

You have chosen to dovvnload a file from this location.

Packaging Mates doc from pthinyss

Whiat weould you like to dowith this file?
i Open thiz file from its current location

' Eave this tile to disk

[¥ | &livays ask before opening this type of file

004 Cancel Mare Info

Figure 34. File Download Dialog Box

1. Select whether to open the file from the current location or save the file to
disk.
If you choose to open the file and Internet Explorer can integrate with the
application, the file is displayed as an object embedded within a browser
window.
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- http://pthm¥s8:1695/ cgi-bin/CLZRSCLM - Microsoft Internet Explorer

J File Edit “iew Create Page Text GoTo Favorites  Help |

J 4= Each - = - @ A | @Search [Fe] Favoarites @Histur‘f | %- =

JLinks & Search the Webh with Lycos 4] IBM Eusiness Transformation €] 16M Inkernal Help »
| Address IE hittp:/{pthmess: 1695 cgi-bin/CLZRSCLM | e

=T ARG =Y s | g Wl e N0 O)E=EE

Word Pro Release 95
Readme.LWP

This file contains important information that is not includedin the pinted documentation or online
Help.

Thiz file contains information on the following topics:
-

| | ﬂ“‘
=!|Arial | 16| Zmw| B/ I/ THeading 1 B3y § ®Par B4

B

Figure 35. Lotus WordPro document in an Internet Explorer browser

If Internet Explorer cannot integrate with the application but the file
extension is known to your operating system, the appropriate application
opens. If the file extension is not known, see [*‘File Extensions That are Not|
[Recognized by Cloud 9” on page 34| for the action to take.

If you choose to download the file, the Save As dialog box is displayed.
Navigate to the required location and save the file.

2. Close the empty browser window.

» If the Edit in Browser option is set to No, the File Download dialog box is

displayed.

If you choose to open the file, the appropriate application opens. If the file

extension is not known, see [“File Extensions That are Not Recognized by Cloud|
9” on page 34| for the action to take.

If you choose to download the file, the Save As dialog box is displayed.
Navigate to the required location and save the file.

f you are using Netscape Navigator:

Regardless of the Edit in Browswer setting, Netscape displays the file using the
instructions in its preferences.

To change the Netscape Preferences:

1.

From the Netscape menu, click Edit > Preferences.

2. Select the Navigator > Applications category and locate the Description for the

required extension.

3. Click the Edit button. The Edit Type dialog box is displayed.

Note: If the file is handled by an installed Plug-In, you might not be able to
change the Netscape Preferences.
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4. Select one of the Handled By options.
5. Click OK in the Edit Type dialog box and OK in the Preferences dialog box.

Table 3. Summary of Edit results for recognized Binary objects

Edit Options File Type IE NS
Profile Edit in Browser = Yes* Default OLE BS
Edit in Browser = Yes Default OLE BS
Edit in Browser = Yes Text OLE BS
Edit in Browser = Yes Binary OLE BS
Edit in Browser = No Default FD BS
Edit in Browser = No Text FD, BC BS, BC
Edit in Browser = No Binary FD BS
Notes:

1. If the selected object is an SCLM member, the Edit Options panel is displayed.

IE Internet Explorer
NS Netscape Navigator

OLE Display the as embedded object within the browser, if possible. If the
application does not support OLE integration with IE, display the File
Download dialog box.

FD Displays the File Download dialog box.

BS Action is determined by the browser settings. This can include displaying
the object in the browser using an installed Plug-In, saving the object
directly to disk as a file or opening the object using a specified application.

BC Binary code for the object is displayed/downloaded.

File Extensions That are Not Recognized by Cloud 9

If Cloud 9 does not recognize the file’s extension and the Edit in Browser option is
set to Yes, a new browser window opens and displays the binary code within a
text field.

If the Edit in Browser option is set to No, the browser attempts to open or
download the file.

Internet Explorer users:

The File Download dialog box is displayed. If you select Open and the file
extension is not listed in the Registered File Types list, the "Open With” dialog box
(Figure 36 on page 35) is displayed. In this window, you can associate the file’s
extension with the editor program of your choice.
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lopenwith_________________________HH

Click the program you want to use to open the file ‘DS Screen
Shots - C9 User Guide.doc’.
If the program you want is not in the list, click Other

Choose the program you want to use.
0 n
) scANcamM
] acrobat

[ ecrodn
£aM
CLATHRM

i CMMBR22

OK | Cancel | Other...

Figure 36. "Open With" Dialog Box

Note: Once you associate a file extension with a specific program, Cloud 9 uses
that program to open all subsequent files that have that particular extension.

When the "Open With” dialog box appears, select an editing program and click
OK. The file opens within the editing tool you chose.

Netscape Navigator users:

The Unknown File Type dialog box is displayed.

Unknown File Type |

¥ rou have started to download a file of tepe
i Uk on

Click "kare Info'' to learn how to extend Mavigator's
capabilities.

Pick App... Save File... Cancel

Figure 37. "Unknown File Type" Dialog Box

When the "Unknown File Type” dialog box is displayed, click the Pick App button
and follow the dialog box prompts to select an editing program. The file opens
within the editing tool you chose.
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Adding and Defining Cross-Platform File Types
Step 1: Define File Types to SCLM

* Determine the type name, which you might want to be the same as the file
extension. For instance, .DOC types might be defined as DOC, .JAVA types
might be defined as JAVA, and so on.

* Define the type to SCLM.

» Determine if the type is binary or text based. For instance, DOC and GIF files
are binary. Java Script, HTML, C and C++ are text. If the type is binary, type
data sets must be defined as follows:

- RECFM = VB
— BLKSIZE = 26004
- LRECL = 256

Note: If there are records in your e-Business Source types, such as HTML,
that extend beyond 256 bytes, you must assign a library with a larger
LRECL in order to stop truncation.

» Default to language =TEXT for starters. Optional translators can be built later for
deployment of objects.

Step 2: Define the Type to Suite Long Name Registry (SLR)
Run the SLR update utility CLZC9J06 (see the IBM Cloud 9 for SCLM for z/OS
Installation Guide for more information) to see if the file type you are downloading
is already supported by the SLR. The utility returns a list of file types and
extensions that are currently defined in your SLR.

SDSF OUTPUT DISPLAY P390CTC JOB02591 DSID 106 LINE 84 COLUMNS 02 - 81
COMMAND INPUT ===>

ADD NAME RULE FOR SCLM TYPE DOC CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE GRAPHICS CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE HTML CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE JAVA CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE JAR CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE JAVACLAS CASE SENSITIVE.

Figure 38. Example of List Rules Output

If the file type and extension are not defined, then use the SLR update utility to
add the file type to the SLR. See the IBM Cloud 9 for SCLM for z/OS Installation
Guide for full syntax and JCL examples.
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//STEP1 EXEC PGM=CZLSLR

//STEPLIB DD DSN=CLZ.SCLZLOAD,DISP=SHR

//CIGIN DD =

ADD NAME RULE FOR SCLM TYPE DOC CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE GRAPHICS CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE HTML CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE JAVA CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE JAR CASE SENSITIVE.
ADD NAME RULE FOR SCLM TYPE JAVACLAS CASE SENSITIVE.

//CIGLOG ~ DD SYSOUT=x
> J

Figure 39. Example of JCL for SLR Utility

Again, it is suggested that the SCLM type be the same as the file extension.

Step 3: Add Type Extension to the HTTP Rules File
(httpd.conf)

Check the httpd.conf file to see if the file extension you want to add already exists.

ATTENTION REVIEWERS: SOMETHING HAS OBVIOUSLY GONE WRONG HERE, AS
THERE ARE TWO FIGURE ENTRIES AND TWO CAPTIONS BUT ONLY ONE ACTUAL

FIGURE. PLEASE ADVISE WHAT SHOULD BE HERE.
Figure 40. Example of ADDTYPE Entries

AssembTe Macros
Microsoft Word Documents
Power Point Documents
COBOL Source Code

COBOL Source Code

COBOL Source Code

AddType .asm text/asm ebcdic
AddType .doc  binary/doc binary
AddType .ppt  binary/ppt binary
AddType .cob  text/cobol ebcdic
AddType .cbl  text/cobol ebcdic
AddType .cobol text/cobol ebcdic

Figure 41. CLZTHTPD — Cloud9 Server Rules File

If the file type you want to add is not there, then add it using the following
format:

AddType / Extension / Mime type / Translation Technique

Where:

AddType
The keyword.

Extension
File qualifier.

Mime type
The Multipurpose Internet Mail Extension (MIME) type tells the browser
how to treat the file.

Translation Technique
Binary or EBCDIC.

The number after the translation technique is arbitrary and the rest is a comment.

For example, If adding an MS-Excel file type, the following format is used:
AddType / .x1s / application/msexcel / binary
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If you are not sure what to use as a MIME type or translation technique, try to
model it after a similar application or check your browser for MIME types. To
check for MIME types in Windows, click Start, then Settings, then Folder Options,
then File Types.

Update The Browser’s File Type Settings

Windows Setup

In Windows, click Start > Settings > Control Panel, then double-click Folder
Options and click the File Types tab.

Folder Options el |
Genaral I Wiew  File Types | Offline Files

Registered file types:

Extenzions | File Types | 3
ﬁ 123 Lotus 1-2-3 9 4vorkhbook

B 1zM Lotus 1-2-3 9 Smart Master

@323 H.323 Internet Teleghony

DS 3DSFile

E ACA Microzoft Agent Character File (HTTP format)
E ACF Microzoft Agent Character File (HTTP format)

ACG ACG File |

ety | Delete |

—Details for 123" exdenszion

Opens with: ﬂ Lotus 1-2-3 Application Change... |

Files with extension 123" are of type 'Lotus 1-2-3 9Wvorkbook'.
To change settings that affect all 'Lotus 1-2-3 9 Wiorkhook!' files,

click Advanced.
Advanced |

Ok | Cancel | Al |

Figure 42. Windows Folder Options

Check the list of file types for the file type you want to download. If the file type
you are looking for is there, then the application currently set to open the file is
displayed.

If the file type is there, but set to the wrong application, then select Advanced.
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Edit File Type

\_I:
x

125 obus 1-2-3 9 Workhook, Change Icon...
anll

Actions:

open Mew, ..
prink

Edit. ..

Remove

Set Default

il

¥ Confirm open after download
[T Abways show extension

¥ Browse in same window

Ok I Cancel

Figure 43. Windows Edit File Type

On the Edit panel you can specify what application is chosen to open the file. Also,
the Confirm open after download option gives you the choice of whether a prompt
occurs after a download.

If the file type you are looking for is not in the file list, then click the New button
from the Windows Folder Options panel.

Create Mew Extension |

File Extenszion: == Advanced

A=zzaciated File Type: IﬁNewn j

(034 Cancel |

Figure 44. Create New Extension

On this panel, you can add a file type to the file list and choose a default
application with which to open the file. If you edit or add a file type, also check
the httpd.conf file to make sure that all the ADDTYPE definitions match.

Netscape Setup
In Netscape, go to Edit, then Preferences, then Navigator, then Application.
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Categon:

=) Appearanice
i Fants
Colorz Drezcription

- Navigator "rundl32 exe’ meconf File il New Type. . |

"rundll32. exe’’ meconf File

"rundll 32 exe'" msconf File Edit... |

per applications far different file types

5

mirt Browzing 1-2-3 Worksheet
- Mail & Newsgroups AcroRd32 File M
[H- Roaming Access &ction Definition File
[+ Composer Address [RCF] File
[+ Offling Address Book File
- Advanced #dobe Webbuy Plugin j
— File twpe details

Entengion: Il

) MIME Type:  applications-iphone
i
:’”n Handled By: RUMDLL32

HEROSFT
HINDOHS

ok I Cancel Help

Figure 45. Preferences

Check the list of file types for the file type you want to download. If the file type
you are looking for is there, then the application currently set to open the file is
displayed.

Ensure that the correct application is set up to open your file. If it is not set to the
right application then select Edit.
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Estenzior: Il

MIME Type: |E

[~ Use thiz MIME a3 the outgaing default for these file extensions

—Handled By
| [avigatar

" Save to Disk

7 Application: |"mndl32 exe’ meconf.dll MewhediaPhone

Browse... |

v &k me before opening downloaded filss of this bype

] I Cancel

Figure 46. Edit Type

If the file type you are looking for is not in the list of file types, select New Type.
In this panel you can add a file type to the file list and choose a default application
with which to open the file. If you edit or add a file type, also check the httpd.conf
file to make sure that all the ADDTYPE definitions match. In Netscape, any file
without an extension is given a default extension of .TXT. To change this default
extension, you must change the "Handled by” option for the file types with the
description, plain text.

Note: Image files are downloaded as binary when running Netscape. In the
httpd.config file, if the user had specified an Addtype statement for .jgp of
image/jpeg then Cloud 9 downloads the file with a content-type of
binary/jpeg. Therefore, the user needs to define a helper application for jpeg
and jpg types (or any other image type to handle binary/image-type on
downloads). If the Netscape user does not specify a helper application then
Netscape downloads the file to the user’s workstation.
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Chapter 3. Creating Members and Packages

You can create new members in an SCLM hierarchy or within PDS data sets, or
create and save files to a Unix server. You can also work with SCLM Packages,
which are a special type of SCLM member. This chapter describes how to:

» Create text members in an SCLM hierarchy, a PDS data set or save text to a file
on a Unix server.

* Add PC or Workstation files to an SCLM hierarchy, a PDS data set or save files
to a file on a Unix server.

» Create, open and edit SCLM Package members.
* Delete members and files.

Creating Objects

Text-based objects can be created within a browser window and then saved into an
SCLM hierarchy, a PDS data set or a Unix server, or can be submitted as a batch
job. Both Text-based and Binary files stored on your PC or Workstation can be
added to an SCLM hierarchy, a PDS data set or saved to a Unix server.

Creating Text-based objects
In Cloud 9, you can create a new file and add it into SCLM, PDS, or UNIX. To do
this:
1. Ensure that you have no list items selected in any Member List or Unix File
List.

Note: You might need to return to each list panel and clear any selections.

2. On the Main Menu, click EDIT or EDIT MEMBER. An empty edit session is
opened within a new browser window:
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|»

Kl ;IJ
Add to SCLM

SCLM Project: [scLmTEST | 7| Submit |
Alternate: I ﬂ -

Figure 47. Empty edit session

3. Create your new file by typing directly in the editing area within the new
browser window.

Note: If you are running a pre-6.x version of Netscape, you cannot enter more
than 20k of data in the editing area.

4. When you are ready to save your work, scroll down the Web browser window
to the relevant section of the form beneath the editing area.

Add to SCLM

Add to SCLM
Subrmit |

SCLM Project:
Alternate:

Grou:

Lelele]-

Type:
Iember:

Language:

Authorization code:

Ll

Change code:

Lock: © Eeep & Release
Allow truncation: © Yes * Neo

1T

Figure 48. Add to SCLM form

The input fields in this form are:

SCLM Project Your SCLM project name. Required field.
Alternate Alternative SCLM project name. Optional field.
Group Your SCLM group name. Required field.
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Type

Member

Language
Authorization code

Change code
Lock

Allow truncation

Submit button

Add to Dataset

Your SCLM type name. Required field.

Your SCLM member name. Required field.

Your SCLM language name. Required when

adding a new member.

Your authorization code.

A valid SCLM change code. Optional field.

During processing, the chosen member is

locked to prevent another user from accessing

it. After processing, this option determines what

action to take on the chosen member.

* Keep — the member remains in a locked
condition.

* Release — the member is unlocked and
available to other users.

The Yes/No option specifies whether a file that

has a line length greater than the defined

record length of the SCLM data set is truncated

as it is added.

* Yes — files are added with truncation where
necessary.

* No — files that require truncation are not
added.

Verifies that all required SCLM fields have been

completed and attempts to add the member to

SCLM.

Add to Dataset

Dataset: I

Subrnit |

Iember: I
Eeplace file: ¢ Tes
Allow truncation; ¢ Tes

Figure 49. Add to Dataset form

The input fields in this form are:

Dataset
Member

Replace file

Allow truncation

Submit button

Host data set. Required field.

MVS conventional member name. Required

field.

Yes/No option buttons that specify whether

like-named members of the data set are

replaced.

The Yes/No option specifies whether a file that

has a line length greater than the defined

record length of the PDS data set is truncated

as it is added.

* Yes — files are added with truncation where
necessary.

* No — files that require truncation are not
added.

Verifies that all required Dataset fields have

been completed and attempts to add the

member to a PDS data set.
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Add to Unix

Add to Unix
Tniz Pathname: | Submit |

Eeplace file: © Yes & Mo

Figure 50. Add to Unix form

The input fields in this form are:

Unix File Fully qualified Unix path. Required field.

Replace file Yes/No option buttons that specify whether
like-named files in the specified Unix path are
replaced.

Submit button Verifies that all required Unix fields have been

completed and attempts to save the member to
a Unix server.

Submit batch job

Submit Batch Job

Subrnit |

Figure 51. Submit Batch Job form

Clicking the Submit button within this section causes the current edit process
to submit the file as a batch job, with no save action performed.

5. Complete the fields in one section only (Add to SCLM, Add to Dataset, Add to
Unix or Submit Batch Job) and click the Submit button in that section.

If all required fields were completed correctly and the submission is successful,
a confirmation message displays:

Save messages

Member procezszed:
Shortname = TEZOZ513
Longname = TEZITOOOZ

Add-hack complete.

FPress the Back button to make additional changes.
Close this window when you are finished making changes.

Figure 52. Successful save message
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If a required field was not completed or contains incorrect data, an error
message is displayed and describes the cause of the problem:

Microsoft Internet Explorer |

& Member is required.

Figure 53. Example form error message

Click the OK button, correct the error and click the Submit button again.

If the form is correctly completed but the submission is unsuccessful, a message
displays and describes the reason for failure:

Errors occurred
Save is allowed only in an entry group.

Press the Back button, correct the error, and retry save.

Figure 54. Example form error message

Add PC/WS Files

Cloud 9 gives you the ability to add Personal Computer (PC) or Workstation (WS)
files to SCLM, a PDS data set or a Unix server, through the Web browser.

1. Click on ADD PC/WS FILES on the main menu. The Add PC/WS Files panel
is displayed, containing three sections: Add to SCLM, Add to Dataset and Add
to Unix directory.

2. Scroll to the relevant section for the task you want to perform.

Add to SCLM
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Add to SCLM

From Path:

File Mame Generation:
Rermove from pathnarme:
File type:

To SCLM Project
alternate
Graup

Type

IMember

Language

Autharization code

Change cods:
Lock:
Allovy runcation:

Birowese. .. | Submit |

" Save file with no pathname ¢ Use Remove from pathname

" Default " Text

7
7
7
7

[ Binary

|

| 2|

: i
—

*Kesp { Release
T es * No

Figure 55. Add to SCLM form

The entry fields on the Add to SCLM panel are:

From Path

Browse button

File Name Generation

Remove from pathname

Cloud 9 for SCLM for z/OS User’s Guide

Fully qualified path and file name for the file to
be uploaded, wild card characters are not
allowed.
Displays the File Open dialog box, in which
you can navigate to the file to be uploaded.
Once the file is selected, the full path and file
name are returned to the From Path field and
the path without the file name) is returned to
the Remove from path name field.
Controls the use of the Remove From Pathname
field.
Save file with no pathname
If this option is selected, the file is
stored in SCLM with no prefixed path
name.
Use Remove from pathname
If this option is selected, the file is
stored with the full path name, minus
any section of a path name that is
specified in the Remove from pathname
field.
The specified section of a path name is
removed and the remainder is retained as part
of the long file name stored in SCLM.

For example, if you have selected
c:\pictures\mypets\myDog.jpg to be added into
SCLM, but wish to define the file to SCLM as
mypets\myDog. jpg, you specify c:\pictures\ in
this field. When the file is added to SCLM, the
file name is stored in the SLR as
mypets\myDog.jpg.



File type

SCLM Project
Alternate

Group

Type

Member

Language
Authorization code
Change code

Lock

Allow truncation

Submit button

Add to Dataset

Add to Dataset

Note: If no value is specified in "Remove from
pathname”, the file name is stored
without any directory information. Also,
the drive letter is never retained as part
of the SCLM file name.

Determines in what format the selected member

or file is uploaded.

* Default — Cloud 9 selects the upload method

(Text or Binary) based on the file’s extension.

» Text — upload file using ASCII to EBCDIC

conversion.

* Binary — upload the file "as is".

Your SCLM project name. Required field.

Alternative SCLM project name. Optional field.

Your SCLM group name. Required field.

Your SCLM type name. Required field.

Your SCLM member name. Required field.

Your SCLM language name. Required field.

Your authorization code.

A valid SCLM change code. Optional field.

During processing, the chosen member is

locked to prevent another user from accessing

it. After processing, this option determines what
action to take on the chosen member.
Keep — the member remains in a locked
condition.
Release — the member is unlocked and
available to other users.
The Yes/No option specifies whether a file that
has a line length greater than the defined
record length of the SCLM data set is truncated
as it is added.
Yes — files are added with truncation where
necessary.
No — files that require truncation are not
added.

Verifies that all required SCLM fields have been

completed and attempts to add the member to

SCLM.

From Path: |

File Mame Generation: & Sawe file with no pathname ¢ Use Remove from pathname

Browse. .. | Subrmnit |

Remave fram pathname: I

File type: & Default  © Text  © Binary

To Dataset: |

Member : |
Replace file:  ves & Mo
Allow fruncation: ¢ Yes Mo

Figure 56. Add to Dataset form

The input fields in this form are:
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From Path

Browse button

File Name Generation

Remove from pathname

File type

Dataset
Member

Replace file

Submit button
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Fully qualified path and file name for the file to
be uploaded, wild card character is not
allowed.
Displays the File Open dialog box, in which
you navigate to the file to be uploaded. Once
the file is selected, the full path and file name
are returned to the From Path field and the
path without the file name) is returned to the
Remove from path name field.
Controls the use of the Remove From Pathname
field.
Save file with no pathname
If this option is selected, the file is
stored in the PDS Dataset with no
prefixed path name.
Use Remove from pathname
If this option is selected, the file is
stored with the full path name, minus
any section of a path name that is
specified in the Remove from pathname
field.
The specified section of a path name is
removed and the remainder is retained as part
of the long file name stored in SCLM.

For example, if you have selected
c:\pictures\mypets\myDog.jpg to be added into
a Data set, but wish to define the file to SCLM
as mypets\myDog.jpg, you specify c:\pictures\
in this field. When the file is added to the data
set, the file name is stored in the SLR as
mypets\myDog. jpg.

Note: If no value is specified in "Remove from
pathname”, the file name is stored
without any directory information. Also,
the drive letter is never retained as part
of the file name.

Determines in what format the selected member

or file is uploaded.

Default — Cloud 9 selects the upload
method (Text or Binary) based on the file’s
extension.

Text — uploads file using ASCII to EBCDIC
conversion where necessary.

Binary — uploads the file "as is".

Host data set. Required field.

MVS conventional member name. Required

field.

Determines the action to take if a member with

the same name exists in the target data set.

* Yes — replace a like-named member with

this one.

* No — do not replace a like-named member.

Verifies that all required Dataset fields have



been completed and attempts to add the
member to the PDS data set.

Add to Unix

Add to Unix directory

From Path:l Browse. .. | Submit |

Remaove from pathnarme: |
{Leave blank for filename only)
File type: Default  © Text Binary

To Unix Path: |
Replace file: © ves & Mo

Figure 57. Add to Unix form

The input fields in this form are:

From Path Fully qualified path and file name for the file to
be uploaded, wild card character is not
allowed.

Browse button Displays the File Open dialog box, in which

you navigate to the file to be uploaded. Once
the file is selected, the full path and file name
are returned to the From Path field and the
path without the file name) is returned to the
Remove from path name field.
File Name Generation Controls the use of the Remove From Pathname
field.
Save file with no pathname
If this option is selected, the file is
stored in the Unix Directory, specified
in the To Unix Path field, with no
prefixed path name.
Use Remove from pathname
If this option is selected, the file is
stored with the full path name, minus
any section of a path name that is
specified in the Remove from pathname
field.
Remove from pathname The specified section of a path name is
removed and the remainder is retained as part
of the long file name stored in SCLM.

For example, if you have selected
c:\pictures\mypets\myDog.jpg to be added, but
wish to define the file in Unix as
mypets/myDog.jpg, you specify c:\pictures\ in
this field. If this were to be added to a Unix
directory such as

/u/dohert1/scimtest/devl/docs/, the file is

copied to Unix as
/u/dohert1/scimtest/devl/docs/mypets/myDog.Jpg.

Notes:

a. The full Unix path must exist before files
can be copied to it. That is, the "mypets”
directory must exist within "../docs/", the
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Add WS/PC Files process does not create
the sub-directory for you.

b. If no value is specified in "Remove from
pathname”, the file name is stored directly
in the specified Unix directory.

c. The drive letter is never retained as part of
the file name or path name.

To Unix path Fully qualified Unix path. Required field.
Replace file Determines the action to take if a file with the
same name exists in the target data set.

* Yes — replace a like-named file with this one.

* No — do not replace a like-named file.

Submit button Verifies that all required Dataset fields have
been completed and attempts to add the
member to the PDS data set.

3. Complete the fields in one section only (Add to SCLM, Add to Dataset, Add to
Unix or Submit Batch Job) and click the Submit button in that section.

If all required fields were completed correctly and the submission is successful,
a confirmation message displays:

Save messages

Hember processed:
Jhortname = TE3IODZ2513
Longname = TEITOOOZ

Add-back complete.

Press the Back button to make addiional changes.
Close this window when you are finished making changes.

Figure 58. Successful save message

If a required field was not completed or contains incorrect data, an error
message is displayed and describes the cause of the problem:

Microsoft Internet Explorer [EX |

& Member is required.

Figure 59. Example form error message

Click the OK button, correct the error and click the Submit button again.
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If the form is correctly completed but the submission is unsuccessful, a message
displays and describes the reason for failure:

Errors occwrred
~ave is allowed only in an entry group.

Press the Back button, cotrect the error, and retry save.

Figure 60. Example form error message

Packages

Cloud 9 gives you the ability to create, view, and modify SCLM Packages. An
SCLM Package is a SCLM High-Level (HL) architecture definition member
(ARCHDEF) that contains a list of the members that make up the Package.
Packages are a means whereby you group SCLM members together to form a unit
of work. Once placed in a Package, you can build and promote the members as a
unit instead of having to build or promote the members individally.

For example, a developer might have a problem raised against a product such as
ISPF. The developer investigates the problem and decides that there are 5 members
that need to be changed, plus he wants to add some documentation. He can then
create or open a Package and add the five members to it. When editing, he must
still edit and change each member individually. However, the Package gives him
the ability to build (compile) all the modules at once, without having to go into
each of the 5 members. Once he has finished testing and has written his
documentation, he can add that to the Package also. He then has a complete unit
of work that can be promoted to the next level in the hierarchy, keeping all the bits
of the change together. If he wants, he can build individual members but before he
can promote the Package, he must also build it to make sure it picks up all the
latest build information.

Only one Package at a time can be active within Cloud 9 and that Package remains
available until you choose to "Start Over” (see Closing a Package) or leave the
Cloud 9 Web site.

The main tasks involved in working a Package are:
1. Creating or opening a Package.

2. Adding SCLM Members to the active Package.
3. Editing and saving the Package contents.

4. Closing the Package.

Create or open Package

You start with the OPEN PACKAGE function, found in the Misc Functions section
of the main menu.

From the Cloud 9 Main Menu:
1. Click on OPEN PACKAGE. The Open SCLM Package panel displays:
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Open SCLM Package

' Create New Package " Open Existing Package

Package Information

Project: IW ﬂ
Alternate: l— ﬂ
Group: I— ﬂ
Type: li ﬂ

Member :

Authorization code: I ﬂ

Subrnit | Reset |

Figure 61. Open SCLM Package Panel

The input fields on the OPEN PACKAGE panel are:

Create New Package Begin creation of a new package.

Open Existing Package Begin working with a package that already
exists.

Project Your SCLM project name. Required field.

Alternate Alternative SCLM project name. Optional field.

Group Your SCLM group name. Required field.

Type Your SCLM type name. Required field.

Member Your SCLM member name. Required field.

Authorization code Your authorization code.

2. Fill in the package information (Project, Group, and so on.).

3. Click on Submit.
If all required fields were completed correctly and the submission is successful,
the Package is created or opened and you are returned to the Cloud 9 Main
Menu. The menu has two new options: ADD TO PACKAGE and SAVE/VIEW
PACKAGE. These new options are explained in the following sections of this
chapter. Notice that the OPEN PACKAGE option is no longer seen in the menu.

BECQUT CLOUD 9

Figure 62. Add to Package and Save Package Menu Options

If a required field was not completed or contains incorrect data, an error
message is displayed and describes the cause of the problem:
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Microsoft Internet Explorer

& Member is required,

Figure 63. Example form error message

Click the OK button, correct the error and click the Submit button again.

If the form is correctly completed but the submission is unsuccessful, a message
displays and describes the reason for failure:

Unable to lock the package.
Access key DOHERTL has already been applied to the member in group DEV1

Figure 64. Example of Open Package failure message

Adding SCLM Members to a Package

To add SCLM members to an open package:
1. Generate a list of SCLM members (see [“Listing SCLM Members” on page 11)).

2. Select the members that you wish to add to the Package (see [“Selecting list

litems” on page 19).

Member (9) Project Group Type Language Status Access key

™ ThIBEES SCLMTEST DEY1  SOURCE TEXT EDITABLE
I ThJESD SCLMTEST DEVY SOURCE TEXT EDITABLE
T TNJBST SCLMTEST DEM1  SOURCE TEXT EDMTAELE
r muesr SCLMTEST DEVY S0OURCE TEXT EDITABLE
r TJese SCLMTEST DEV1 SOURCE TEXT EDITAELE
r Thie4l SCLMTEST DEV1 SOURCE TEXT EDTABLE
r ThJBs3 SCLMTEST DEV1  SOURCE TEXT EDNTABLE
r TS SCLMTEST DEV1  SOURCE TEXT EDTABLE
-

ThLJBES SCLMTEET DEVY SOURCE TEXT DITABLE

Figure 65. Member List

3. Click on ADD TO PACKAGE. The message in is displayed.
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Microsoft Internet Explorer

& Rows selected were added ko the package,

Figure 66. Package Add Message

Editing and Saving SCLM Packages
To view, edit or save the contents of the package into SCLM for further processing:
1. Click SAVE/VIEW PACKAGE. The panel in is displayed.

Bave Package Ii

Specify package information, edit contents a5 required, and then submit 1o save the package.

Project: SCLMTEST
Alternate: SCLMTEST
Group: DEY1
Type: PACKAGE

Member: susburn

Autharization code: | I j

Change code: I

Lock: ©Keep Release

Submit | Reset | Start Over |

Package Contents: ||

IMNCLD APCTHTO1 SOURCE ;I
* testlsue

INCLD TEZ02514 DOC

* f52%ug01.ide

INCLD F5200000 DOC

* testlsue

INCLD TEZ0z2514 DoOC

* APCTHTOZ2

IMCLD APCODODO  DOC |

Figure 67. Save Package Panel

2. If required, edit the text in the Package Contents text area.

Note: If you want to delete a member from the Package, delete the reference to
it in the Package Contents.

3. Complete the input fields in the SAVE PACKAGE panel.

The input fields are:
Authorization code Your authorization code.
Change code Your change code.
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Lock During processing, the chosen member is
locked to prevent another user from accessing
it. After processing, this option determines what
action to take on the chosen member.

* Keep — the member remains in a locked
condition.

* Release — the member is unlocked and
available to other users.

Submit button Verifies that all required SCLM fields have been
completed and attempts to save the Package to
SCLM.

Reset button Clears all of the current field values within the

Save Package form and returns option buttons
to their default setting.

Start Over button Closes the current Package. If changes have not
yet been saved, they are lost.

4. Click Submit to save the member in SCLM for later processing.

If all required fields were completed correctly and the submission is successful,
the Package is saved and a confirmation message is displayed:

Query Functions

ILES

Figure 68. Package Save confirmation

If the form is correctly completed but the submission is unsuccessful, a message
displays and describes the reason for failure:

Errors occurred
Invalid Authorization Code specified.

Press the Back button, correct the error, and retry save.

Figure 69. Example of Save Package failure message

Closing a Package

Only one Package at a time can be active within Cloud 9 and that Package remains
available until you choose to "Start Over”.

To close an open Package:
1. Click SAVE/VIEW PACKAGE .
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2. Click the Start Over button. The Package closes and the Main Menu returns to
its initial state (that is, it displays OPEN PACKAGE instead of ADD PACKAGE
and SAVE/VIEW PACKAGE).

Note: The Start Over button does not prompt you to save the Package. If you have
added members to the Package or edited the Package Contents and have not
yet saved it, and then choose to close the Package, all your changes are lost.

Deleting Objects

You can use Cloud 9 to delete SCLM members (including SCLM Packages), PDS
members and Unix files. If a Package is deleted, it is only the Package member
that is removed, not the members that have been added to the Package.

To delete an object using Cloud 9:
1. Generate a list of members or files (“Listing Objects” on page 11)).
2. Select a list item or items for deletion (see [‘Selecting list items” on page 19).

3. Click DELETE.

For SCLM members, the following panel is returned:

Delete

Flag: & all © BuildMap ¢ Account © Text ¢ Output

Execution Mode:  * Foreground  © Batch submission

Submit Reset

Figure 70. SCLM Delete Options

The input fields on the Delete Options panel are:

Flag

Execution Mode
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All — All Flag options — Build Map, Account, Text, and
Output — that match the selected pattern are deleted.
Build Map — all build map records that match the selected
pattern are deleted.

Account — all accounting records, cross-reference records,
intermediate records, and build map records that match the
pattern are deleted. The accounting type is not checked.
Text — all accounting records, cross-reference records,
intermediate records, build map records, intermediate code,
and Text members that match the pattern are deleted. The
accounting type is not checked.

Output — all build map records, intermediate records and
code, and all non-editable accounting records, their
cross-reference records and associated Text members that
match the pattern are deleted. Editable accounting records,
their cross-reference records or associated Text members are
not deleted.

Foreground — processing done before any further action can
be taken.



« Batch submission — control of the session is returned to the
user, therefore additional tasks can be performed while the
delete request is carried out.

Submit button

Submits the Delete request for processing.

Cancel button Cancels the Delete request and closes the Delete Options panel.

The most recently used Cloud 9 panel is redisplayed.

For PDS members, the following panel is returned:

Delete Member

WPRODODD SCLMTEST.DEY1.DOC

Press Submit to delete members shown above,

Subrnit Cancel

Figure 71. PDS Delete Member panel

For Unix files, the following panel is returned:

Delete File

Jufdohertlf.sh_history

Press Submit to delete files shown abowve.

Subrnit Cancel

Figure 72. Unix Delete File panel

4. Choose your options (SCLM members only), then click Submit to remove the
object or Cancel to abandon the Delete action.

If the deletion is successful, a confirmation message displays:

DELETE messages

MMember Eeturn code

TES02512 0

Figure 73. Confirmation of Delete success

If the deletion is unsuccessful or only partly successful, a message displays and
describes any problems that might have occurred:
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DELETE messages

IMember

Eeturn code

WPE00000

FLMMSGS follows:

FLM3710%9 - DELGROUP WARNIMNGS FOR GROUP DEV1 AT 13:06:16, CODE: 4
FLMS37109 - DELGROUP FAILED FOR GROUP DEV1 AT 13:06:17, CODE: 5
ISPLOG FOLLOWS:
Start of ISPF Log - - - - Zession # 1 —~—————————————— - —————
T33O - Command - - TEMPNAME
End of ISPF Log - - - - - Jeszion # 1l ———————
DEUMSGS follows:
FLMS5000 - DELETE GROUP UTILITY INITIATED - 13:06:16 ON 1071472002,
FLME1020 - NO MEMEERS MATCHING SELECTION CRITERIL
FLM35107 - 0 ACCOUNTING RECORDS WERE DELETED.
FLM35109 - 0 BUILD MiP RECORDI WERE DELETED.
FLM35110 - 0 INTERMEDIATE RECORDS WERE DELETED.
FLMS5299 - DELETE GROUF UTILITY COMPLETED - 13:06:16 ON 10/14/200Z2.
FLMZS000 - DELETE GROUP UTILITY INITIATED - 13:06:17 ON 10/14/zZ002.
FLM3O0500 - ACCE3S KEY INCORRECT, ACCESS KEY:
GROUP: DEV1 TYPE: DOC  MEMEER: WPROOOOO
FLM35107 - 0 ACCOUNTING RECORDS WERE DELETED.
FLM35109 - 0 BUILD MiP RECORDI WERE DELETED.
FLM35110 - 0 INTERMEDIATE RECORDS WERE DELETED.
FLMS5299 - DELETE GROUF UTILITY COMPLETED - 13:06:17 ON 10/14/200Z2.

DEURPT follows:

AR R R AR RS R R R AR R AR AR R SRR R RS E SR AR SRR R R R R SRR R R RS

4|

Figure 74. Example of Delete failure message
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Chapter 4. SCLM Functions

A number of SCLM functions become available on the Main Menu, whenever an
SCLM Query (List SCLM Members) has been performed. The menu items remain
available until a different query (List Members or List Unix Files) is performed or a
new SCLM Package is opened (or created).

ADD PC [LES
DIT MEMBER.

AUTHCO
BLILD
DELETE

PROFILE

ABOUT CLOUD 9

Figure 75. Main menu showing SCLM functions

This chapter describes the use of the following SCLM functions:

Change the Authorization Code
View SCLM accounting files

Use the Version/Recover option
Build and Promote SCLM members
Lock and unlock SCLM members
Migrate SCLM members

| Changing the Authorization Code

I Cloud 9 gives you the ability to change the Authorization Code for a selected
I SCLM member or members.

I To change the Authorization Code for a member:
| 1.
I 2.
|
I
|

Generate a list of SCLM members (“Listing SCLM Members” on page 11).

Select the member or members for which you want to change the Authorization
Code.

Click on AUTHCODE. The following panel displays:
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Authcode |
MNeww Authorization Code: I

Execution Mode: & Foreground © Batch submission

Submit | Reset |

Figure 76. Authcode panel

The fields on this panel are:

New Authorization Code
Standard Authorization Code

Execution Mode
* Foreground — browser waits for end of processing.
* Batch submission — browser available for action while job is
processing.

4. Enter a new Authorization Code. This code must be already defined to your
project within SCLM.

5. Choose your Execution option and click Submit.

6. Your return message depends upon the Execution Mode you chose. A

successful Authcode change, using Foreground Execution, returns the following
message:

AUTHCODE messages

Member Eeturn code
GENO011% 0

FLMMSGS follows:
FLMS7107 - AUTHCODE SUCCEEDED FOR MEMBER GENOO11S AT 11:42:13, CODE: O

ISPLOG FOLLOWS:

Start of ISPF Log — - - - Session # 1 ——————— e
T30 - Comenand - - STEMPNAME
End of ISPF Log - - - - = Session # 1 ——————————

Figure 77. Authcode change (foreground) success message

An unsuccessful Authcode change, using Foreground Execution, returns a
message describing the problem. For example:
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AUTHCODE messages

MMember Eeturn code
GENO0115 8

FIMMSGS follows:
FLMS7107 - AUTHCODE FAILED FOR MEMEBER GENOO112 AT 11:43:48, CODE: 16

ISPLOG FOLLOWS:

Ztart of ISPF Loy - - - - Sesgion # 1 -~——-———-"-—-—-"—-"-"""""""""“""""————————
T33O - Command - - $TENPNAME
End of IZPF Log - - - — - Zegsion #4 ~—————--—-"—--"—-"—-""-"""""""""""""""“""""——

DEUMSGS follows:
FLMO4005 - AUTHORIZATICN CCDE: X IS NOT DEFINED To GROUF: DEVL
FOR TYPE: JAVL, MEMEER: GENOO119.

SYSTSPRT follows:

RELDY
. *f
RELDY

Figure 78. Authcode change (foreground) failure message

When the Execution Mode is set to Batch Submission, the JCL sent to SCLM is

displayed in Cloud 9, for example:
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Batch job submitted =
JCL follows:

//SCLMUSRE JOE (#ACCT),'SCLM USER',CLASS=A4,

i/ MNEGCLASS=X, NOTIFY=£3Y3UID

T I — *
/4% NAME: CLZJIBHN *®
//% PURPOSE: CLOUD 9 FOR SCLM. *
/r* SCLM BATCH SEELETCH. *
T I — *
VA *
/7% REQUIRED JCL MODIFICATION: *
/7% 1) CHAMNGE THE FOLLOWING AS PER THE INSTALLATION WORKSHEET. * -
A - ISPFQUAL hd
e - TDISK *
//% Z) TARGET LIBRARIES CLZ.SCLZILOAD AND CLZ.SCLICGI f*C1 ) *
i SHOULD BE CHANGED IF THE INSTALLED HIGH LEVEL P
A QUALIFIER IS NOT 'CLZ.' fv C1 o wf ®
/ft *
//*%* MNOTE: BREEZE USERS MUST MODIFY THIS MODULE FER EMEELDDED *
fi* INSTRUCTICON. BREEZE DATASET MNAMES MAY ALSO NEED TO EE *
A MODIFIED. hd
/ft *
f/% ZZ0OCTZ001 OWS1810 - CHAMNGES MARKED A3 /+ C1 #*/ *
/% Z0z0402L *
/% Z2401094 M344 - AUTHCODE PROCESSING *®
e ®
lf: ___________________________________________________________________ *
//% ERESIDES IN HTTP SERVER AT: f*Cc1 *f0*
/% fROOTDIR/CLOUDS/JCL/CLZJIBM *®
/ft ___________________________________________________________________ *
e

//GENER EXEC PGM=IEBGENER

A /SY3UTL DD+

PROC O

FLMNCHND AUTHCCODE, COWAJAVL, COVAJAVA, DEV1, JAVA, GENOO119, P, U, AUTHM3GS, + LI

Figure 79. Authcode Change (background) submission message

The Authcode change success or failure messages are part of the output
generated by the batch job. To view these messages, check the output from the
batch job submitted.

Viewing SCLM Accounting Information
Using Cloud 9 you can view the accounting information and view the build map
for any SCLM member.
1. Generate a list of SCLM members (see [“Listing SCLM Members” on page 11)).
2. Select the members or files that you wish to view (see [“Selecting list items” on|

page 19).
3. Select VIEW ACCOUNTING from the menu.
4. The Accounting Information displays in a new browser window:

64  Cloud 9 for SCLM for z/0S User’s Guide



Accounting Information

Figure 80. Accounting Information (top of page)
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Figure 81. Accounting Information (bottom of page)

The information displayed in the Accounting Information main page is drawn
directly from SCLM. See the SCLM Program Manager’s and Developer’s Guide
for details about these fields. If the person specified in the Change User Id field
has completed their Cloud 9 Profile information, their JPG image, e-mail
address and telephone number is also displayed.

If the selected member has Change Code information, contains Include
statements or has associated Build Map information, these details display in
separate sections beneath the main Accounting Information.
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Change Codes

Change Code Change Code Date Change Code Time
CR301592 2002/10/14 14:05:30

Include Include-Zets
FLMWMOTEQTT

Build Map

Longname Ilember Type Last Modfied Wersion  HKeyword
FLMOIMD1 FLMOIMD1 ORI 02/10/14 14:11:33 4 OB
FLMOIMD1 FLMOIMD1 SCOURCLST 02/10/14 14:.11.33 4 LIST
FLMOIEQT FLMOIEQT SOURCE 010730 112136 1 1

Figure 82. Accounting Information (additional info)

Using Version/Recover

In Cloud 9, you can view SCLM member versions and recover old member
versions. You can only view or recover old versions of a member if the SCLM
Group in which it resides has Version Control activated. The activation of Version
Control is done from within the SCLM product.

1. Generate a list of SCLM members (Figure 8 on page 13).

2. Select a member whose versions you wish to view.

3. Click VERSION/RECOVER on the Main Menu.
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Group Date Time User Change Code

Current
[ TEST current source DOHERTL FLMOTEQU
[ RELEASE current source SCLMUSRE FLWMOTEQL
Versions
[ TEST 2002410421 171827 DOHERTL FLRAOTEGL
[ TEST 2002410/21 17:09:28 DOHERTL FLRMOTEQL
[ TEST 2002410221 16:30:17 SCLMUSRE FLMOTEQU
[ TEST 2002410/21 16:08:45 SCLMUSRE FLMOTEQL
T Compare Recowver Reset
For compare
Delta @ CHNG Long © OWSn O
Blank SEQ O NOSEQ CcOoBOL
For Recover
To Dataset To SCLM
Dataset I
SCLM Group I
SCLM Type | [+ =l
Authorization Code I

Figure 83. Version/Recover

The entry fields on the Version/Recover panel are as follows:
Current This section displays the most recent (current) version of a
member in the member’s group and all groups above it in the

SCLM hierarchy.

\Versions This section displays all previous versions of the member that
exist within the current group.
View/Compare/Recover/Reset buttons

These verify that you have selected the appropriate number of

members or versions and then submit the request for the

named function.

View View a selected member(s). You can select one
or more members from the Current and
Versions lists.

Compare Compares two selected members (current or
previous version). This button is used in
conjunction with the For compare radio buttons
found on this panel.

Recover Recovers one selected version (not current
members). This button is used in conjunction
with the radio buttons and entry fields field in
the For Recover section of this panel.

Reset Restore the settings on this panel to their
default values.

For compare Radio buttons that set the comparison filters for the selected
members.
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The comparison is made using the SuperC facility of ISPF.
Cloud 9 sets the SuperC Compare Type to Line and the Display
Output to Yes. You can select a Listing Option and select from a
sub-set of Processing Options. For more information, see to the
ISPF User’s Guide, Volume 11 SC34-4792.

Delta A listing type. Lists only the differences between the
source members being compared, followed by the
overall summary results. Differences are flagged to the
left of each output line.

CHNG
A listing type. Same as the Delta listing, plus up to 10
matching lines, words, or bytes before and after the
differences. This shows the differences within the
context of the surrounding lines.

Long A listing type. Same as the CHNG listing, except this
listing shows the entire new data set, plus any data
from the original data set that is not in the new data
set.

OVSUM
A listing type. Lists only an overall summary of the
results of the comparison without showing the
individual differences themselves.

Blank Compare process option. Exclude sequence number
fields from the comparison if the data set is Fixed 80 or
Variable 255 and the compare type is Line. Otherwise,
treat them as data.

SEQ Compare process option. Sequence numbers. Ignore
standard sequence number columns that display in a
file with Fixed 80 length.

NOSEQ
Compare process option. No sequence numbers. The
comparison processes Fixed 80 standard sequence
number columns as data.

COBOL
A compare process option. Ignore columns 1-6 in both
Fixed 80 data sets. Data changes in columns 1-6 are
ignored.

For Recover  Radio buttons and entry fields that determine where and under
what name to store a recovered version of an object.

To Dataset
Store the recovered version in a data set.

To SCLM
Store the recovered version in an SCLM data set.

Dataset
The fully qualified name of the data set in which to
store the recovered version.

SCLM Group
SCLM Group name.

SCLM Type
SCLM Type name.

Authorization Code
Standard authorization code.

4. From this panel you can view different versions, compare versions, and recover
an older version.

To view a version:
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1. Select the check box next to the member(s) or version(s) you want to see.
2. Click the "View" button at the bottom of the panel.

3. Each selected member or version displays as a Web page in a new browser
window (wherever possible). See [“Viewing Objects” on page 19| for details
about the way in which different File Types are viewed.

To compare versions:

1. Select the check boxes next to the two objects (members or versions) that you
want to compare.

2. Select your compare options in the For compare section
3. Click the "Compare” button.

4. The comparison request is submitted to SCLM to run in the Foreground and, if
successful, the results are returned to Cloud 9 and displayed in a new browser
window.

To recover an older version

Select the check box next to the member or version that you want to recover.
Enter the appropriate information in the For Recover section.

click the "Recover” button.

The Recover request is prepared as a Batch Job and is submitted to SCLM. The
batch job JCL is displayed in the current window (replacing the
Version/Recover panel). To access the recovered member, list the SCLM
members again.

oD~

Building an SCLM Member

In Cloud 9, you can use the Build process to build SCLM members and Packages
in preparation for promotion. If an SCLM Package is built, all members referenced
within the Package are built at the same time.

The Build process compiles, links and integrates software components according to
the architecture. For any group in the hierarchy, the Build function uses the
software components within the hierarchy of that group to update the out-of-date
members. See the SCLM Project Manager’s and Developer’s Guide for more
information about the Build process.

For each component that it processes, the Build function takes one of the following
actions:

* Does nothing if the component has not changed since the previous build
» Deletes out-of-date outputs if that leaves the component in an up-to-date state
« Compiles or links changed components.

The Build can be run in either foreground or batch mode.

1. Generate a list of SCLM members (“Listing SCLM Members” on page 11).

2. Select a member or members to build.

3. Select BUILD from the Cloud 9 Main Menu. The following panel is displayed:
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Buld |

Mode: ' Conditional
Unzonditional

Forced
Lirnited
Marmal
Subunit
" Extended

Group: ITEST ﬂ

Execution Mode: Faoreground ¢ Batch submission

Scope:

O N e Nie

.

Subrmit | Reset |

Figure 84. Build Options

The input fields on the Build Options panel are:
Mode

» Conditional — checks for unacceptable return codes and
stops processing immediately if found.

* Unconditional — continues processing of all members
despite translation errors of certain members.

» Forced — force requested components to be processed
regardless of their previous status.

Scope

* Limited — process only components directly referenced by
the architecture members.

* Normal — process components referenced by the architecture
member, but also process upward dependencies for all
Ada-type source members referenced directly by the
architecture member and all source members referenced as
upward dependencies.

e Subunit — process the components and members processed
in Normal scope, and downward dependencies for all
Ada-type source members referenced directly by the
architecture member.

* Extended — process the components and members processed
in Normal scope, and as downward dependencies for all
source members within the Normal scope and the source to
all outputs referenced. In addition, extended scope processes
any outputs referenced through LINK architecture definition
statements or parsed includes.

Group Standard group name, where the build is to be performed.
Execution Mode

* Foreground — browser waits for end of processing and
results are returned to Cloud 9.

» Batch submission — browser available for action while job is
processing.

Note: If you require a Build Report, select Batch submission
and examine the report within the SCLM system.

4. Adjust the Mode, Scope, and Group settings.
5. Choose the Execution mode.
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6. Click Submit.

Your return message depends upon the Execution Mode you chose. A
successful Build action, using Foreground Execution, returns the following
message:

BUILD messages

Member Eeturn code

STTEOQ00D ]

Figure 85. Build (foreground) success message

An unsuccessful Build action, using Foreground Execution, returns a message
describing the problem. For example:

BUILD messages =
Iember Return code
TSTPRG1 3

FIMMSGS follows:
FLM57107 - BUILD FAILED FOR MEMEER TSTPRG1 AT 11:37:16, CODE: &

ISPLOG FOLLOWS:

Start of I3PF Loy - - - - 3essjon # 1 ———————————————
T3O - Command - - %$TEMPNAME
T3O - Command - - BZZSMEBZ EBUILD FSCLMTEST, SCLHNTEST, 3CLHMUSE ,DEV1 ; B0OURCE
,NORMAL ,CONDITICHNAL
End of ISPF Log - - - - — Jession # 1 ~———————————

DEUMSGS follows:
FLM4z000 - BUILD PROCESIOR INITIATED - 11:37:10 ON Z00Z/10/23

FLM44500 - »>> INVOKING BUILD TRANSLATOR (3) FOR TYPE: SOURCE HEMEEER: T3TPRGL
FLMO6501 - TRANSLATOR RETURN CODE FROM ===> PL/I CPTIMIZER === 12
FLM44513 - TRAN3ZLATOR ERROR FOR MEMEER: T3TPRG1 TYPE: 3Z0URCE

FLM45000 - ERROR PROCE3ZING CURRENT EUILD

FLM46000 - BUILD PROCESSOR COMPLETED - 11:37:16 CON 2002/10/23

DEURPT follows:
o o o o o o o o o o o o e e o o o o

Y
T i il
1] | »

Figure 86. Build (foreground) failure message

When the Execution Mode is set to Batch Submission, the JCL sent to SCLM is
displayed in Cloud 9, for example:
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Batch job submitted =

JCL follows:

J/BCLMUSEL JOB (#ACCT), 'SCLMUSE JOB', CLASS=L, MSGCLASS=X,

£/ HOTIFY=£373UID

ffF ————= J— - _ - %

//% MAME: CLZJIBM * —

/¢% PURPOSE: CLOUD 9 FOR SCLH. *

e SCLM BATCH ZKELETON. ®

FAE ——— J— _ _ - %

e *

//% REQUIRED JCL MODIFICATION: *

/#% 1) CHINGE THE FOLLOWING A3 PER THE INSTALLATION WORKSHEET. "

A - ISP *

A - 3TSDA *

/#% 2) TARGET LIERARIES CLZ.3CLZLOAD AND CLZ.3CLEICGI dEoCL oR) o

e SHOULD BE CHANGED IF THE INSTALLED HIGH LEVEL A% CL %) *

fiE QUALIFIER IS NOT 'CLZ.' sroclowp %

e *

//% NOTE: BREEZE USERS NUST MODIFY THIS MODULE PER EMEEDDED "

a INSTRUCTION. BREEZE DATASET NAMES MAY ALS0 NEED TO BE "

A MoODIFIED. *

A "

/% 220CT2001 OWS1810 - CHANGES MARKED A4S /* C1 +/ *

J/% E0Z04024 CHANGES MAREED L3 /* C2+%/ *

FEE *

FfF————— J— _ _ J—

/% RESIDES IN HTTP SERVER AT: f®oCL oW

/4% JROOTDIR/CLOUDS/JCL/CLIZJIBM *

ff -- - -— ——* _|
-

Figure 87.

The Build messages, Build Report and Build List are all part of the output
generated by the batch job. To view the job output that includes these reports,
check the output from the batch job submitted by the Build process.

Promoting an SCLM Member
After a member is built, Cloud 9 can be used to promote the member in either
foreground or batch mode.
1. Generate a list of SCLM members (“Listing SCLM Members” on page 11).
2. Select a member or members for promotion.
3. Click PROMOTE from the Cloud 9 menu. The following panel displays:
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0}

Mode: Conditional

Unconditional

O]

Mar rnal
Subunit
Extendad

Group: I ﬂ

Scope:

i

Package Execution {0 | ;l {I {HH M) I : I
Through (rMMoD): | 4 /l ) | |

Override Dates: [
Force Package Clear: [

Description: I

Package Type: © Standard ¢ Emergency

Execution Mode:  © Foreground & Batch submission

Submit Reset

Figure 88. Promote Options

The input fields on the Promote Options panel are:

Mode

Scope

Group

Breeze Options
If you are running Breeze in conjuction with Cloud 9, the
following options are displayed. These fields only affect the
promotion of Packages that are under the Breeze Approval
process.
Package Execution (YY/MM/DD) (HH:MM)
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Conditional — checks for unacceptable return codes and
stops processing immediately if found.

Unconditional — continues processing of all members
despite translation errors of certain members.

Normal — process components referenced by the architecture
member, but also process upward dependencies for all
Ada-type source members referenced directly by the
architecture member and all source members referenced as
upward dependencies.

Subunit — process the components and members processed
in Normal scope, and downward dependencies for all
Ada-type source members referenced directly by the
architecture member.

Extended — process the components and members processed
in Normal scope, and downward dependencies for all source
members within the Normal scope and the source to all
outputs referenced. In addition, extended scope processes
any outputs referenced through LINK architecture definition
statements or parsed includes. For more information, see the
SCLM Project Manager’s and Developer’s Guide.

Standard group name, where the promote is to be performed.

Start date and time for the window of time in which
the package can be promoted. If the dates are left blank
then the Breeze default dates are used.



N o o s

When you promote a Package that requires approval
(foreground or batch), you can specify a date when that
promote can occur. There is a sweep job in Breeze that
you can schedule to run automatically, looking for
approved Packages to promote. Even though a package
gets approved, its promotion does not take place until
the specified date is reached. If the approval has not
been given until after the Package Execution window,
the promotion does not occur.

through (YY/MM/DD) (HH:MM)

End date for the window of time in which the package
can be promoted. If the dates are left blank then the
Breeze default dates are used.

Override Dates

Select the check box to override Package execution
parameters on the second promote, if they were entered
incorrectly on the first promote. If, after approval, the
second promote has been started but the promotion
date window has not been reached, due to being
entered incorrectly on the first promote, use the
override attribute to set the promotion window to it’s
correct value.

Force Package Clear

Check this box if you wish Breeze to automatically
clear the package if it exists at the next level of the
hierarchy. This enables packages to be reused without
having to manually clear same-named packages using
the BZZSMJD1 job.

Description

A description of the Package that is seen by approvers
and other users, within the Breeze application.

Package Type

Execution Mode

Standard or Emergency. This option does not affect
approval, and is for documentation purposes only,
except for one key difference: if your administrator has
created a $$EMER member in the SBZZJAVA data set,
then only the user IDs listed in that member can build
or promote emergency packages. If there is no $$EMER
member in the SBZZJAVA data set, then there is no
difference in behavior between standard and emergency
packages. For details, see the Breeze Planning and
Administration Guide.

* Foreground — browser waits for end of processing.
* Batch submission — browser available for action while job is

processing.

Adjust the Mode, Scope, and Group settings.
Choose the Execution Mode.

Click Submit.

Your return message depends upon the Execution Mode you chose. A
successful Promote action, using Foreground Execution, returns the following

message:
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PROMOTE messages

Member Eeturn code

APCTHTOL 0

Figure 89. Promote (foreground) success message

An unsuccessful Promote action, using Foreground Execution, returns a
message describing the problem. For example:

PROMOTE messages =
IMember Return code
STEQ0000 2

FLMMSGS follows:
FLM57107 - PROMOTE FAILED FOR MEMEEER 3ZUEQOOOO AT 15:54:55, CODE: &

ISPLOG FOLLOWS:

Start of ISPF Log - - - - Session # 1 -— —-— -—
TaO - Comwmand - - $TEMPFMAME
T3O - Command - - BZZZMEP1 PVERIFY ,SCLMTEST,SCLMTEST,SCLMUSR ,TEST , PACKLGE
L SUECOOOOD, WORMAL , CONDITICONAL ,NCNEEY
End of ISPF Log - — - — — Jession # 1 -— - -—

DEUMSGES follows:
FLM51000 - PREOMOTE PROCESSOR IMITIATED - 15:54:53 ON 2002710723
FLM5Z000 — IWITIATING VERIFICATICHN PHASE - 15:54:53 ON 2002/10/23
FLMO&S12 — VERIFICATICW ERROE FROM USER EXIT ROUTINE: BZZ3MEOZ, CODE: 4
FLMO702Z0 - DATA SET SCLMTEST.NONKEY.DOC
DOE3 NOT EXIST FOR GROUP: NONEEY TYPE: DOC
FLM58000 - PROMOTE PROCESZOR COMPLETED - 15:54:55 ON 2002/10/23

DBURPT follows:
ool o o o o o o o o o o o o o o o
o A e e e e o e e e e i e e e e i al e  e al l

w w
Xy Lxa -
4| | »

Figure 90. Build (foreground) failure message

When the Execution Mode is set to Batch Submission, the JCL sent to SCLM is
displayed in Cloud 9, for example:
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| v

Batch jobk submitted

JCL follows:

J/SCLMUSRA JOB (#ACCT),'SCLMUSR JOB',CLASS=i, M3GCLASS=X,

/i NOTIFY=&3YSUID

A ————— e ——_ *
/% NAME: CLZJIBM *
//% PURPOSE: CLOUD 9 FOR SCLM. * —
A SCLM BATCH SKELETCN. *
A ————— *
A *
//% REQUIRED JCL MODIFICATICN: *
//% 1) CHINGE THE FOLLOWING A3 PER THE INSTALLATION WORKSHEET. *
A - IZF *
A - SYSDA *
/¢/*% 2) TARGET LIBRARIES CLEZ.3CLZLOAD AND CLZ.3CLZICGI FE 0L RS F
A SHOULD BE CHANGED IF THE INSTALLED HIGH LEVEL FE 0L RS F
S QUALIFIER I3 MOT 'CLE.' PR BT
A *
//* NOTE: BREEZE USERS MUST MODIFY THIS MODULE FER EMBEDDED *
A INSTRUCTION. BREEZE DATASET NAMES MAY ALSO NEED TO BE *
e MODIFIED. ®
A *
/7% 220CT2001 OWS1810 - CHANGES MARKED A8 /+ C1 #/ *
/7% 20204024 CHAMGES MARKED A4S /+* C2+/ *
A *
e —————— *
//* RESIDES IN HTTP SERVER AT: A% C1 ot
S4% JROOTDIR/CLOUDS/ JCLSCLEZJIBN *
e e * =l
Figure 91.

The Promote messages, Promote Report and Promote List are all part of the
output generated by the batch job. To view the job output that includes these
reports, check the output from the batch job submitted by the Promote process.

Using Lock/Unlock

Cloud 9 gives you the ability to Lock or Unlock an SCLM member to insure that
no other programmers are making simultaneous changes to the member you are
working on.

To lock a member:
1. Generate a list of SCLM members (“Listing SCLM Members” on page 11).

2. Select an unlocked member (locked members display a string in the Access Key
column of the SCLM Member List panel, unlocked members do not have an
entry in this column).

3. Click on LOCK. The following panel displays:
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Lock m Greup: [ )
Author izaton code: i

Access key! [SCLMUSR

Execubion Moda: = Foreground ¢ Batch submission
Subirit I Resel |

Figure 92. Lock panel

The fields on this panel are:

Lock in Group
The name of the SCLM group into which you want to lock this member
(must be a development level group).

Authorization Code
Standard Authorization Code

Access Key
An identifier used to restrict access to a member.

Execution Mode
» Foreground — browser waits for end of processing.
* Batch submission — browser available for action while job is
processing.

4. Choose your options and click Submit.

5. Your return message depends upon the Execution Mode you chose. A
successful Lock action, using Foreground Execution, returns the following

message:
LOCK messages
MMember Eeturn code
FPACO0002 0

Figure 93. Lock (foreground) success message

An unsuccessful Lock action, using Foreground Execution, returns a message
describing the problem. For example:
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LOCK messages =

Member Eeturn code

PACOOD02 8

FIMMSGS follows:
FLMB0500 - ACCESZS KEY INCOREECT, ALCCESS KEY: SCLMUSR
GEQOUP: DEW1l TYPE: DOC MEMEER: FACOOOOZ
FLME7107 - LOCK FAILED FOR MEMEER PACOOOO0Z AT 17:45:00, CODE: 8

ISPLOG FOLLOWS:

Ztart of ISPF Loy - - - - Session # 1 ———————————— -
T30 - Command - - %TEMFNAME
End of IZPF Log - - - - - Zegssion # 1 ——————mm e

DEUMSGS follows:

DEBURPT follows:

DEUTAIL follows:

SYSTEPRT follows:

REALDY
2 LE
REALDY

S * NAME: CLZJDYI *f -
i I _>l_|

Figure 94. Lock (foreground) failure message

When the Execution Mode is set to Batch Submission, the JCL sent to SCLM is
displayed in Cloud 9, for example:
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Batch job submitted =

JCL follows:

S/ASCLMUSRL JOB (H#ACCT),'3CLMUIR JOB',CLAZS=L,M3GCLLIZ=X,

'z NOTIFY=&5YSUID

A *
F4* NAME: CLZJIEBM *
J/% PURPOSE: CLOUD 9 FOR SCLM. L
i 3CLM BATCH SEELETON. *
A *
IFA *
S/ BREQUIRED JCL MODIFICATION: *
J¢* 1) CHANGE THE FOLLOWING A5 FER THE INSTALLATICON WORKSHEET. *
i - I3P *
i - 3¥3DA *
Ff%  2) TARGET LIBRARIES CLZ.3CLEILOAD AND CLEZ.3CLEICGI JeoCcloss oW
i SHOULD BE CHANGED IF THE INSTALLED HIGH LEVEL P o P
i QUALIFIER I3 NOT 'CLZ.! JeoCcloss oW
IFA *
J/% WNOTE: BREEZE U3ERS MUST MODIFY THIS MODULE FER EMEEDDED *
i INSTRUCTION. EBEREEZE DATASET NAMES MALY ALSO NEED TO EBE *
i MODIFIED. *
IFA *
FA% ZZ0CTZO01 OWS1510 - CHANGES MARKED A3 /* C1 */ *
Ji® EZ0Z040ZA CHANGES MARKED A4S /* C2%/ *
A *
- *
//*% RESIDEZ IN HTTP IERVER AT: JeoCcloss oW
fi®  JROOTDIR/CLOUDS/JCL/CLZJIEN * LI

Figure 95. Lock JCL

The Lock success or failure messages are part of the output generated by the
batch job. To view these messages, check the output from the batch job
submitted by the Lock process.

To unlock a member:
1. Generate a list of SCLM members (“Listing SCLM Members” on page 11).

2. Select an locked member (locked members display a string in the Access Key
column of the SCLM Member List panel).

3. Click on UNLOCK. The following panel displays:

Arcess key: |

Execution Mode:  © Faoreground % Batch submission

Subrnit Reset

Figure 96. Unlock panel

The fields on this panel are:

Access Key
An identifier used to restrict access to a member.

Execution Mode
» Foreground — browser waits for end of processing.
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* Batch submission — browser available for action while job is

processing.
4. Choose your options and click Submit.

5. Your return message depends upon the Execution Mode you chose. A
successful Unlock action, using Foreground Execution, returns the following

message:

UNLOCK messages

IMember Eeturn code
PACOOOO2 0

Figure 97. Unlock (foreground) success message

An unsuccessful Unlock action, using Foreground Execution, returns a message

describing the problem. For example:

UNLOCK messages

FIMMSGS follows:
FLMS0500 - ACCESS KEY IMNCORRECT, ACCEZZ KEY: ICLMUSR
GROUP: DEVZ TYPE: JAVAL MEMEER: TES0ZEZS

FLMS7107 - UNLOCK FAILED FOR MEMEER TEZSQZ52Z25 AT 17:38:3Z, CODE:

ISPLOG FOLLOWS:

Ztart of ISPF Loy - - - - Segsion # 1 ——-—-——--—-—---—-—----
TS0 - Comwand - - $TEMPNAME
End of IZPF Log - - - - - feggion # 1 ——-——--"—-"—-"--"-"""""""""""""“"“"“"“""-————

DBUMSGS follows:

DBURPT follows:

DBUTATL follows:

SYSTSPRT follows:
RELDY

S ———————

RELDY

/% MAME: CLZJDTN

RELDY

/% PURPOSE: CLOUD 9 FOR ICLM

RELDY

i IZPF ALLOCATIONS FOR 3CLM WEE BASED FUMNCTICHNZ.
RELDY

S ———————

RELDY

i

RELDY

/% RBEQUIRED MODIFICATIOM:
RELDY

/% 1) CHANGE THE FOLLOWING A3 PER THE INSTALLATICH WORKSHEET.

RELDY
i - I3P
RE ATV

4] |

Figure 98. Unlock (foreground) failure message

wf

wf

wf

wf

wf

wf

wf

wf

wf
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When the Execution Mode is set to Batch Submission, the JCL sent to SCLM is
displayed in Cloud 9, for example:

Batch job submitted

|»

JCL follows:

AFSCLMUSEA JOB (HACCT),'3CLMUSR JOB',CLAZZ=4, M3GCLAZS=X,

¥ NOTIFY=&3¥5UID

ll."l,."ﬂ' _________________________________________________________________ *
A/ % NAME: CLZJIEHM L
// % PURFPOSE: CLOUD 9 FOR 3CLHM. *
Fa SCLM BATCH SKELETON. *
ll."l,."ﬂ' _________________________________________________________________ *
//‘K *
f/ % REQUIRED JCL MODIFICATICON: *
/7% 1) CHANGE THE FOLLOWING AS PER THE INSTALLATION WORESHEET. *
i - ISF *
L - SYSDA *
A% 2) TARGET LIBRARIES CLZ.SCLZILOAD AND CLZ.SCLZICGEI ST Ccl1 %/ %
Fa 3HOULD BE CHANGED IF THE INITALLED HIGH LEVEL ¥ Cc1 %/ %
i QUALIFIER I3 NOT 'CLZ.' ST Ccl1 %/ %
//ﬁ *
//* NOTE: BREEZE USERS MUIT MODIFY THIZ MODULE PER EMEEDDED *
Fa INSTEUCTICN. BREEZE DATAIET NAMES MAY ALSCO NEED TO EE *
i MCDIFIED. *
//ﬁ *
J/% 2Z0OCTZ001 OWS51510 - CHANGES MAREED A% /% C1 +/ *
A/% Z0Z040ZA CHANGES MAREED A4S /* Cz2%/ *
ll."l,."ﬂ' *
//'k ___________________________________________________________________ *
//* REIIDEZ IN HTTF ZIEEVER AT: ST Ccl1 %/ %
f/%  JROOTDIR/CLOUDS/JCL/CLZJIEN * ‘:J

Figure 99.

The Lock success or failure messages are part of the output generated by the
batch job. To view these messages, check the output from the batch job
submitted by the Lock process.

Migrating Members to SCLM

Cloud 9 gives you the ability to Migrate multiple SCLM members, PDS members
or Unix files to an SCLM Life Cycle location (Project/Group/Type) or to change
the Language of members in an existing location.

1. Generate a list of members or files (“Listing Objects” on page 11)).

Note: The MIGRATE command displays on all modified menus, after a list has
been returned.

2. Select a list item or items for migration.
3. Click MIGRATE on the Main Menu. The following panel displays:
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To Project: |SCLMTEST ﬂ
Alternate: I ﬂ

Group: |DEV2 ﬂlDE\Qj
Type: IW ﬂ
Language: IF ﬂ
Autharization Code: I— ﬂ

Change Code: I

Lock: € Keep © Release
Allow truncation:  © es
File Type: & Default © Text © Binary

Remave from pathname:

Execution Mode: & Batch only

Subrnit I

Reset |

Files To Migrate

SCLMTEST.SCLMTEST | TEST | SOURCE |FLMO1MD1 FLMO1MD1

Figure 100. Migrate Options

The input fields on the Migrate Options panel are:

Project

Alternate

Group

Type

Language

Change code
Authorization code
Change code

Lock

Allow truncation

File Type

Standard project name, required.

Alternative project name.

Standard group name, required.

Standard type name, required.

Standard language name, required.

Standard code.

Standard code.

A valid SCLM change code string.

Determines if the member is locked after

migration.

» Keep — locks the member into the specified
SCLM group.

* Release — unlocks the member immediately
after migration.

The Yes/No option specifies whether a file that

has a line length greater than the defined

record length of the SCLM data set is truncated

as it is migrated.

* Yes — files are migrated with truncation
where necessary.

* No — files that require truncation are not
migrated.

Determines in what format the selected member

or file is migrated.

* Default — Cloud 9 selects the access method
(Text or Binary) based on the file’s extension.

» Text — migrate the member using ASCII to
EBCDIC conversion where necessary.
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* Binary — migrate the member using its
internal format.

Note: If you are migrating load modules into
an SCLM controlled data set, ensure
the file type is set to binary. This
ensures that the load module is copied
into the PDS correctly.

Remove from pathname

Execution Mode

The Files To Migrate
for migration.

Batch only — no foreground processing
available.

section lists the members or files that you have selected

Note: Migration occurs at the "member” level, that is, dependent members or

files generated
selected.
Enter your migration
displayed in Cloud 9

in a Build process are not migrated unless they have been

information and click Submit. The JCL sent to SCLM is

, for example:

Batch job submitted

JCL follows:

|»

J/SCLMUSRA JOB (HACCT),'SCLMUSE JOB',CLASS=A4,M3GCLASS=X,

'z NOTIFY=&3YSUID

l,.-’l,."w _________________________________________________________________ *
Fi* NAME: CLZJIEBEM *
S % PURFPOZE: CLOUD 9 FOR 3ICLH. *
i 3CLM BATCH SEELETON. *
l,.-’l,."w _________________________________________________________________ *
4 "
f¢* REQUIRED JCL MODIFICATICHN: * |
J¢* 1) CHANGE THE FOLLOWING AS FPER THE INSTALLATICON WORKSHEET. *
I - ISF *
W - SYSDA *
f4&* 2) TARGET LIBRARIES CLZ.3CLZILOAD AND CLZ,.SCLICGI JfTCc1owf o
i SHOULD BE CHANGED IF THE INSTALLED HIGH LEVEL P o R
I QUALIFIER IS NOT 'CLZ.' JfTCc1owf o
//w *
f¢/* HNOTE: BREEZE USERZ MUST MODIFY THIS MCDULE FER EMEELDDED *
i INSTRUCTION. EREEZE DATASET NAMES MALY ALSO NEED TO BE *
I MODIFIED. *
//w *
S ® ZZOCTZ0O01 COWS51510 - CHAMNGES MAREKED A% /+ C1 */ -
Fi® EZ0Z040Z A CHANGES MARKED A4S /* C2%/ *
l,.-’l,."w *
//w ___________________________________________________________________ *
/% RESIDEZ IN HTTF SERVER AT: JfTCc1owf o
fi®  JROOTDIR/CLOUDS/JCL/CLZIJIEN *
l,.-’l,."w ___________________________________________________________________ *
F{COPY EXEC PGM=IKJEFTO1

F/I1 DD PATHDISP=(KEEF),

/¢ PATH='/u/dohertl/sclmtest/devi/doc/Testdoc001. doc!
401 DD DEN=SCLMTEIT.DEV1.DOC (USDO0000D) ,DISP=3HR

f/STSTSPRET DD STSOUT=*
FABTSTSING DD+

QCOPY INDD(I1)
i

Figure 101.
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The Migrate success or failure messages are part of the output generated by the
batch job. To view these messages, check the output from the batch job
submitted by the Migrate process.
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Chapter 5. PDS Functions

A number of PDS functions become available on the Main Menu, whenever the
List Members action has been performed for PDS members. The menu items
remain available until a different query (List SCLM Files or List Unix Files) is
performed or a new SCLM Package is opened (or created).

This chapter describes the use of the following PDS functions:
» Compare function

* Copy and Move PDS members

* Rename PDS members

» Search-For function

Note: The MIGRATE command is described in[“Migrating Members to SCLM” on|

Comparing PDS Members

Cloud 9 gives you the ability to compare PDS members. Members can be
compared against members in the same data set, a different data set, or a Unix
directory. The compare results can be used to show changes that have been made
to a member.

1. Generate a list of PDS members.

2. Select one member to compare it with a member in a different data set or with
a Unix file;

OR

Select two members within this data set that you wish to compare.
3. Click on COMPARE on the Main Menu.
4. The following panel is returned:
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Compare: & Matching members listed

" Using "Cld" path location
" Using "0ld" dataset location

Display format: @ Delta © Changes 1 Long

"Old" location:

Submit | Reset Cancel

Figure 102. Compare Options

The entry fields on the Compare options panel are:

Compare
* Matching members listed — used to compare two members from the
same data set.
* Using "Old” path location — used for comparing a PDS member
against the same file in a Unix directory.
* Using "Old" dataset location — used for comparing a PDS member
against the same PDS member in a different data set.

Display format
» Delta — list the differences between the source data sets.
* Changes — list the differences between the source data sets, plus up
to 10 matching lines before and after the differences.
* Long — list all the new data set source lines, plus old data set
deleted lines. Both inserted and deleted lines are flagged.

"Old"” location
If you select only one member for comparison, Cloud 9 prompts you
for the location of another member or Unix file with which to compare
it.

5. Set the Compare and Display Format options.
6. Enter the "OIld” location if applicable.
7. Click Submit. The results panel is displayed, for example:
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Mew: CLZWVZE1 SCLACGICLATIAVCY)
Old: CLZ V2R ACLZCGI{CLETIAV C)

CLZ V2R 5CLECGIICLETIAY C)

- od 51
- cd §1
- Jjavac —wverbose -d 53 %2
- javac -verbose -d $3 §2

H oA g

Eeturn to top

Figure 103. Compare Results

Copying PDS Members
Using Cloud 9 you can copy PDS members to another data set or to a UNIX
directory. Copying to UNIX is covered in|Chapter 6, “Unix Functions,” on page 95,
1. Generate a list of PDS members.
2. Select a member(s) to be copied.
3. Click COPY on the Main Menu. The following panel is returned:

—_
Copy Member I
MName mask: I

Replace target file: © yes % o

& ToPDS Dataset: |
Truncate:  yes ¢ Ng
Packdata: © Yes & Mo

" Ta Unix Directory: |
File type: & Default © Text ¢ Binary

Permissions: 777

Old name:  Mew name: Dataset:

54 I SCLMTEST.DEYZ2,.S0URCE
Submit I Reset Cancel

Figure 104. Copy Member Options

The entry fields on the Copy options panel are:

Name mask
Used to change individual characters in the member name. For
example entering "***2’ in the name mask field changes the member
name from 'IBM1’ to ’IBM2’.

Replace target file
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* Yes — if a file with the same name already exists in the data set that
you are copying this file to, replace it with this file.
* No — do not replace a like-named file in the target data set.

Be sure to note the Replace target file option, if there is already a
member in the target data set with the same name!

To PDS
» Dataset — the name of the data set into which you want to copy this
file.
* Truncate — "Yes", truncate the newly copied file to fit restraints in
the target data set. "No”, do not truncate the new data.
» Pack data — "Yes”, compress the data for storage. "No”, do not
compress the data.

To Unix
* Directory — the name of the directory into which you want to copy
this file.
* File type
— Default — Cloud 9 determines upload method based on file
extension.

— Text — upload using ASCII to EBCDIC
— Binary — upload "as is”
* Permissions — Unix permission bits.

New name
Used if a new member name is wanted.

4. Once all the options have been selected and the name has been decided, click
Submit. The following panel is returned:

Copy complete

Old name Mew name  Retumn code

=4 54 0

Figure 105. Confirm Copy Panel

Moving PDS Members

Using Cloud 9, you can move PDS members to another data set or to a UNIX
directory. This move is a "copy and delete” action, the member moved to a new
data set or directory is removed from its old one.

1. Generate a list of PDS members.
2. Select the PDS member or members to be moved.
3. Click MOVE on the Main Menu.
4. The following panel is returned:
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Marme rmask: I

Replace target file: ¢ wes & No

o

To FDS Dataset: |
Truncate: ¢ Yes & Mo
Pack data: " yes @& no

" Ta Unix Directory: |

File type:  * Default © Text ¢ Binary

Permissions: |77

54

Old name:  Mew name: Dataset:

I SCLMTEST.DEY L.SOURCE

Subrnit I Reset Cancel

Figure 106. Move Member Options

5.

The entry fields on the Move options panel are:

Name mask
Used to change individual characters in the member name. For
example, entering "***2’ in the Name mask field changes the member
name from 'IBM1’ to ’'IBM2’.

Replace target file
* Yes — if a file with the same name already exists in the data set that
you are moving this file to, replace it with this file.
* No — do not replace a like-named file in the target data set.

Be sure to note the Replace target file option, if there is already a
member in the target data set with the same name!

To PDS
» Dataset — the name of the data set into which you want to copy this
file.
* Truncate — "Yes”, truncate the newly moved file to fit restraints in
the target data set. "No”, do not truncate the new data.
» Pack data — "Yes”, compress data.. "No”, do not compress data.

To Unix
» Directory — the name of the directory into which you want to copy
this file.
* File type
— Default — Cloud 9 determines upload method based on file
extension.

— Text — upload using ASCII to EBCDIC.
— Binary — upload "as is".
* Permissions — USS permission bits.

New name
Used if a new member name is wanted.

Once all the options have been selected and the name has been decided, click
Submit. The following panel is returned:
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Move complete

Old name Mew name  Return code

54 =4 0

Figure 107. Move Confirmation Panel

Renaming PDS Members

One or more PDS members can be renamed using the Rename function. The
Rename function works the same as the 'Name Mask’ and 'New Name’ fields on
the Copy and Move panels.

1. Generate a list of PDS Members.
2. Select the member(s) to be renamed.
3. Click RENAME on the Main Menu. The following panel is returned:

Rename Member I
Mame mask: I

Cld narme: Mewy narme: Dataset:

FLMO1TXT I SCLMTEST.DEY 1.ICLLIB
FLMO2TXT I SCLMTEST.DEY1.ICLLIB
FLMO3TXT I SCLMTEST.DEY1.ICLLIB

Submit | Cancel

Figure 108. Rename Member Options

The entry fields on the Rename options panel are:

Name mask
Used to change individual characters in the member name. For
example, entering "***2’ in the Name mask field changes the member
name from 'IBM1’ to 'IBM2’.

New name
Used if a new member is wanted.

4. Enter data in either the Name Mask or New Name fields to change the name of
the selected PDS member.

5. Click Submit. The following message is returned:
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Rename complete

Old name  Mew name Eetum code

TES02518 SHORTTAR 0

Figure 109. Rename Results

Using Search-For with PDS Members

You can use the SEARCH-FOR function to search multiple PDS members for
individual data strings.

1. Generate a list of PDS Members.

2. Select member or members for search.

3. Click SEARCH-FOR on the Main Menu. The following panel is returned:

string: |

Submit I Reset Cancel

Figure 110. Search-For Options

The entry field on the Search-For options panel is:
String Enter the string (or strings) of characters that you want to search for in
the selected members.
4. Enter the data string or strings to search for and click Submit.

5. If no data matches the requested search, then a 'No Matches’ message is
returned.

6. If there are any matching data strings, results similar to these are returned:
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Member Dataset Name
v AD358102 SCLMTEST .DEVL. JCLLIE
63 %INCLUDE SYSLIB(DCLSYSY); 00560000
250 %IMCLUDE SYSLIBCGTEYDCL); /* B2@MEA* f 02450000
629 %IMCLUDE SYSLIBCGTEYLM); /* B2@MBA*/ 06280000
v AD358103 SCLMTEST .DEVL. JCLLIE
&3 %INCLUDE SYSLIB(DCLSYSY); 00560000
250 %IMCLUDE SYSLIBCGTEYDCL); /* B2@MBA* f 02450000
539 %INCLUDE SYSLIB(CGTEYLM); /* B2@MBA*/ 06280000
v AD358104 SCLMTEST.DEVL. JCLLIE
&3 %INCLUDE SYSLIB(DCLSYSY); 00560000
259 %IMCLUDE SYSLIB(CGTEYDCL); /* B2@MBA™ f 02450000
539 %INCLUDE SYSLIBICGTEYLM); /* B2@MBA*/ 06280000
v BZZSMSRY  SCLMTEST.DEV1.JCLLIE
41 %% 1, INCLUDE A WALID JOB CARD
42 ¥¥* 2, MAKE SURE THE TCF LIBRARY IS INCLUDED IN THE
44 ¥x* 3, INCLUDE THE THREE DD FILES MEEDED FOR BATCH
v FLMO1EQL  SCLMTEST.DEV1.JCLLIE
2 * COMMENT INCLUDE

LIpdate Member List |

Figure 111. Search-For Results

Individual members can be selected or you can use the Select All and Deselect
All links in the lower left corner of the form to select/deselect members.

7. Click theUpdate Member List button to return a new PDS Member List
containing only the selected members.

MemberList |
MMember (5) Dataset Name

[ A0358102 SCLMTEST . DEWL. JCLLIB

[ s0358103 SCLMTEST.DEVL. JCLLIB

[ A0358104 SCLMTEST .DEWL. JCLLIB

I BZZSMSRY SCLMTEST.DEV1.ICLLIE

[ FLIMO1EQL SCLMTEST .DEWL. JCLLIB

Figure 112. Updated Member List

You can then repeat your search, using additional strings, to find members
within this smaller sub-set.
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Chapter 6. Unix Functions

A number of Unix functions become available on the Main Menu, whenever the
List Files action has been performed for Unix files. The menu items remain
available until a different query (List SCLM Files or List Members) is performed or
a new SCLM Package is opened (or created).

You can use the Unix functions to perform actions on files contained in the Unix
System Service environment of your z/OS system.

This chapter describes the use of the following Unix functions:
* Compare function

* Copy and Move UNIX files

* View UNIX File information

* Rename Unix files

» Search-For function

Note: The MIGRATE command is described in[“Migrating Members to SCLM” on|

Comparing Unix Files

Cloud 9 gives you the ability to compare Unix files. Files can be compared against
files in the same directory, a different directory, or a PDS data set. The compare
results can be used to show changes that have been made to a file.

1. Generate a list of Unix files.

2. Select one file to compare it with a PDS member or with a Unix file not in
these list results;

OR

Select two files within the list results that you wish to compare.
3. Click on COMPARE on the Main Menu.
4. The following panel is returned:
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96

S ——
Compare

Compare:  *  Matching files listed
" Using "0ld" path location
" Using "0ld" dataset location

Display format: & Delta O changes ¢ Long

"2ld" location

Subrnit | Reset Cancel

Figure 113. Compare Options

The entry fields on the Compare options panel are:

Compare
* Matching files listed — used to compare two files from the same List

Files results set.

* Using "OIld” path location — used for comparing a Unix file against
a Unix file that is not in the current List File results set.

* Using "Old" dataset location — used for comparing a Unix file to a
member in a PDS data set.

Display format
* Delta — list the differences between the source data sets

* Changes — list the differences between the source data sets, plus up
to 10 matching lines before and after the differences.

* Long — list all the new data set source lines, plus old data set
deleted lines. Both inserted and deleted lines are flagged.

"Old"” location
If you have selected only one file for comparison, Cloud 9 prompts you

for the location of the file with which to compare it.
5. Set the Compare and Display Format options.
6. Enter the "Old” location, if applicable.
7. Click Submit. The results are displayed, for example:
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Old file:  fu/dohertlsclmtest/dev]fjavaHello java cmd  Wew file:  fufdohertlfzclmte st/ dev 1ijavathellow java cmd

Mfdohertlsclmtest/dev 1iavathellow java. cind

- export CLASSPATH=/u/dohertl/sclmtesti/release/java: $CLASSPATH

- export CLASSPATH=/u/dohertl/sclmtest/release/olasses: 5CLASSPATH
export CLASIPATH=/u/dohertl/sclmtest/test/ java: §CLASSPATH

- export CLASIPATH=/u/dohertl/sclmtest/test/classes: $CLASIPATH

- export CLASSPATH=/u/dohertl/sclmtest/devl/java: §CLASSPATH

- export CLASSPATH=/u/dohertl/sclmtest/devl/classes: $CLASSPLTH

L o B L i w ]
|

RO- javac -J-mx128m —verhose -d fufdohertl/sclmtest/devl/olasses Hello. java
BIf- jawvac -J-mxlZ8mw -verbose -d /uw/dohertl/sclumtest/devl/classes hellow. java

Return to top

Figure 114. Compare Results

For an explanation of compare listings, see the SuperC sections of the ISPF
User’s Guide Volume 1I.

Copying Unix Files

Using Cloud 9 you can copy Unix files to a PDS data set or to a UNIX directory.
1. Generate a list of Unix files

2. Select a file (or files) to be copied

3. Click COPY on the Main Menu. The following panel is returned:

Copy File

MName mask: I

Replace target file: ¢ ves & no

 To PDS Dataset: |
File type: & Default ¢ Text ¢ Binary

' Ta Unix Directory: |

Old narme: Mew name: Directary:

Hello, java.crmd I Jufdohertfsclmtest/idevl/java
Subrnit I Reset Cancel

Figure 115. Copy File Options

Information about the fields on this panel can be found in|“Copying PD

[Members” on page 89.| The fields are arranged differently on PDS Members
Copy panel, but the explanations for each field are the same.

4. Once all the options have been selected and the name has been decided, click
Submit. The following panel is returned:
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Copy complete

Old natme New natne  Mlessage

Hells java cmd Hijava cind Copy complete

Figure 116. Copy Results

Moving Unix Files
Using Cloud 9, you can move Unix files to another UNIX directory or to a PDS
data set.
1. Generate a list of Unix files.
2. Select the Unix file or files to be moved.
3. Click MOVE on the Main Menu.
4. The following panel is returned:

MoveFile
Marme mask: I

Replace target file: © Yes Mo

 ToPRDS Dataset: |
File type: * Default ¢ Text { Binary

& To Unix Directary: |

Cld name: Mew name: Directory:

Hello, java.cmd I Jufdohertlfscimtest/devlfjava
Submit I Reset Cancel

Figure 117. Move File Options

Information about the fields in this panel can be found in|“Moving PDS

[Members” on page 90| The fields are arranged differently on that panel, but the
information for the fields is the same.

5. Once all the options have been selected and the name has been decided, click
Submit. The following panel is returned:

Move complete

Old natne MNew natne  hlessage

Hello java comd HELLO Ilove complete

Figure 118. Move Results
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Viewing Unix File Information

In Cloud 9, you can access the Unix file information and change a file’s attributes.
1. Generate a list of Unix files.

2. Select the file or files whose information you wish to obtain.

3. Click FILE INFO. The following panel is returned:

File name Directory Permissions  Sticky bit SetGUID Set UID Owner Group id
Hello.java  /fufdohertlfsclmtest/ideyl/java I?’?E ID ID ID o ]
Submit | Reset |

Size Creation time Last accessed Status changed Data last changed
132 2002/09/27 10:09:13 2002/11/05 10:10:51 2002/09/27 10:09:14 2002/09/27 10:09:14

Figure 119. File Information Options

The entry fields on the File Info options panel are:

Permissions
See the Unix System Service (USS) User’s Guide, SA22-7801.

Sticky bit
See the USS User’s Guide.

Set GUID
See the USS User’s Guide.

Set UID
See the USS User’s Guide.

4. Change the options, if required, and click Submit. The following panel is

returned:
File information
File Directory Message  Return code
Hello java fw/dohertlsclmtestdev1fjava chinod faled -1

Figure 120. File Information Results

Note: The submission attempted in this example failed because the user did
not have the correct authorization to make the change.
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Renaming Unix Files

One or more Unix files can be renamed using the Rename function. The Rename

function works the same as the Name Mask and New Name fields on the Copy and
Move panels.

1. Generate a list of Unix files.
2. Select the file or files to be renamed.
3. Click RENAME on the Main Menu. The following panel is returned:

RenameFies |
Mame mask: I
Qld file name:  Mew file name: Directory:
Clack3. jzva | Jufdohertlfscimtest/devlfjava
Clacks. jzva | Jufdohertlfscimtest/devlfjava
Subrmit Cancel

Figure 121. Rename Files Options

Information about the fields on this panel can be found in [“Renaming PDS|

[Members” on page 92| Note that the fields are arranged differently on that
panel, but the explanations are the same.

4. Enter data in either the Name Mask or New Name fields to change the name of

the selected Unix file. See [*Copying Unix Files” on page 97| for more
information.

5. Click Submit. The following message is returned:

Rename complete

Cild name MNew name  Message

Black3 java Clock 3 java File renamed
Blackd java Clockd. java File renamed

Figure 122. Rename Results

Using Search-For with Unix Files
You can use the Search-For function to search multiple Unix files for individual
data strings.
1. Generate a list of Unix files.
2. Select file or files for Search.
3. Click SEARCH-FOR on the Main Menu. The following panel is returned:
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Ty
Search-for

string: |

Subrnit I Reset Cancel

Figure 123. Search-for Options

Information about the field on this panel can be found in [*Using Search-For|
with PDS Members” on page 93| The fields are arranged differently on this
panel, but the explanations for the fields are the same.

4. Enter the data string or strings to search for and click Submit.

5. If no data matches the requested search then a 'No Matches’ message is
returned.

6. If there are any matching data strings, results similar to these are returned:

Searchfor

File Directory
v hiellowe, javacmd fufdohertl/sclmiest/devl/java
26 javac -J-mxl28m -verbose -d Au/dobertl/scimtest/devl/classes hellow. java
v sue. java.crmd Jufdohertl/sclmtest/devl/java
32 jawac -)-mxl128m -werbose -d /u/dohertl/sclmtest/devi/classes Hello. java
I Hello, java Jufdohertfsclmtest/idevl/java
3 public class Hello §
5 System.out.printing"Hello"};
I Hi. java.cmd Jufdohertfsclmtest/idevl/java
32 javac -1-mx128m -verbose -d fu/dohertl/sclmtest/devl/classes Hello. java

IUpdate Directory List |

Figure 124. Search-for Results

Individual members can be selected or you can use the Select All and Deselect
All links in the lower left corner of the form to select/deselect members.

7. Click theUpdate Directory List button to return a new Unix Directory List
containing only the selected files.
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UnixDirectorybist |
File Type File IName (4) Directory Path

[~ file hellow. java. comd faldohertlisclmtest/'dev1fava

[~ file sue. java. cid fufdohertlizclmtest/dev1ijava

[~ file Hello java faldohertlisclmtest/'dev1fava

[~ file Hi java.cmd fdohertlizclmtest/dev1ijava

Figure 125. Updated Unix Directory List

You can then repeat your search, using additional strings, to find members
within this smaller sub-set.
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Chapter 7. Usage Scenario

This chapter descibes how to use Cloud 9 to manage your SCLM life cycle and
development process, including how to:

* Use complex queries for multi-location selection lists

» List and build members based on SCLM language

» List and promote members based on SCLM change codes

» Use package processing to promote changes into production

Note: Our scenario uses the Sample project that can be generated from within
SCLM. You can use Option 7 from the main SCLM menu to create a copy of
this project, with your user ID as the Project Name. See the ISPF SCLM
Program Manager’s and Developer’s Guide for details on how to use this
option.

In our Scenario, the Project Name is SCLMUSR. You will be listing various
members within your copy of this project, selecting some for editing,
creating a Package for the edited members and building and promoting that
Package up to Production (RELEASE).

Task #1: Exploring the SLCM Query options

In this task, you explore some of the unique querying capabilities of Cloud 9, to
view your project’s contents. At the end of the task, you list the members needed
for Task #2.

1. If you have not done so already, log in to Cloud 9.
2. From the Cloud 9 main menu, click LIST SLCM FILES.

3. On the SCLM Query panel, click the ? button adjacent to the Project field and
select your project name from the list.

Note: If your project name is not on the list, you need to create the project in
SCLM before continuing with this scenario.

4. Ensure that the Hierachy View option is set to All occurrences and the
Accounting Status option is set to All, then click the Submit button.

5. Examine the results that are returned. You should see a list of 36 members, all
in the RELEASE group and with a variety of Type, Language and Status

values.
Member (36) Project Group Type Language Status Accesskey Ii
[~ FLWMO1AP1 SCLMUSR RELEASE ARCHDEF ARCHDEF  EDITABLE
[~ FLMOD1ARH SCLMUSR RELEASE ARCHDEF ARCHDEF — EDITABLE
[~ FLMO1CKMD SCLMUSR RELEASE ARCHDEF  ARCHDEF EDITAELE
[~ FLWMO1EGU SCLMUSR RELEASE SOURCE  HLAS EDITABLE
[~ FLMO1LD1 SCLMUSR RELEASE ARCHDEF  ARCHDEFR EDITAELE
[~ FLWMO1LDA SCLMUSR RELEASE LMAP LE370 MON-EDIT
[~ FLMO1LD1 SCLMUSRE RELEASE LOAD LE370 NON-EDIT

Figure 126. Members in the SCLM Sample project

© Copyright IBM Corp. 2001, 2004 103



Note: If the list contains less than 36 members, re-examine the way that you
created your project copy.

Use the browser Back button to return to the SCLM Query panel.

Select the Type of Source and set the Accounting Status to Editable and click
Submit again.

Examine the results that are returned. The list contains 7 members.

=
=
=
=
=
=
=

Member (7) Project Group Type Language Status Accesskey
FLMO1EQU  SCLMUSR RELEASE S0URCE HLAS EDITABLE
FLIO11D1 SCLMUSRE RELEASE SOURCE HLAS EDITAELE
FLMOIMD2  SCLMUSR RELEASE SOURCE FLIO EDITABLE
FLMO1 D3 SCLMUSRE RELEASE SOURCE HLAS EDITAELE
FLMOIMD4  SCLMUSR RELEASE SOURCE HLAS EDITABLE
FLMO11D5 SCLMUSRE  RELEASE SOURCE HLAS EDITABLE
FLMOIMDE  SCLMUSR RELEASE SOURCE HLAS EDITABLE

Figure 127. Editable Source members in the SCLM Sample project

9.

10.

Return to the SCLM Query panel and experiment with different query
options, such as selecting by Language, and so on.

When you have finished experimenting, click the Reset button on the SCLM
Query panel, set the Type to Source and the Accounting Status to Editable
again, then click Submit.

You are now ready to begin Task #2.

Task #2: Editing Members

In this task, you edit two members in your project and assign these members a
Change Code. This Change Code is used to track the members through the SCLM

life
1.

cycle.

On your Member List, select FLM01MD1 and FLM01MD2. These members
have different languages.

From the Cloud 9 main menu, click EDIT.

On the Edit Options panel, make sure your settings match the following:
Edit in Browser Yes

File Type Default

Lock SCLM Member Yes

Lock in Group DEV1
Authorization Code Blank (empty)

Click Submit. Two new browser windows open, with your members loaded in
an Edit session.

For each member:

a. Make a minor change in the Edit area. If you do not know the language,
just make a small change in the comments area at the top.

b. Enter CCO1 into the Change Code field in the Add to SCLM section.
c. Click the Submit button in the Add to SCLM section.

d. Close the Edit session browser window.

From the Cloud 9 main menu, click LIST SCLM FILES.
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7. Reset the SCLM Query options, then select your Project and DEV1 from the
drop down lists.

8. Click Submit. The results show that the two members you have just edited
have been placed into DEV1.

You are now ready to begin Task #3.

Task #3: Compare files

In this task, you compare one of your edited files with the original, and investigate
the various compare options.

1. On your Member List, select FLM01MD1 only.

2. From the Cloud 9 main menu, click VERSION/RECOVER. The Current section
of this panel contains two copies of your member; one in the DEV1 Group and
one in the RELEASE Group.

Group Date Time User Change Code
Current
I DEW1 current source SCLMUSR CCOo1
r RELEASE current source SCLMUSR
e Cornpare Recover Reset

Figure 128. Member displayed in Version/Recover panel.

3. Select the two copies in the Current section.
4. Select the Delta and Blank For Compare options.

5. Click the Compare button. A new browser window opens and displays the
Compare results.

6. Examine the results. You should be able to see the details of your small editing
change, made in Task #2. If you cannot see any changes, return to Task #2 and
edit and save the member again.

7. Close the Compare results browser window and experiment with different
combinations of For Compare options. Close the browser windows when
finished.

You are now ready to begin Task #4.

Task #4: Create Package and add members
In this task, you create a Package to hold the edited members. In later tasks, you
use this Package to build the members.
1. From the Cloud 9 main menu, click OPEN PACKAGE.
2. Select the Create New Package option and enter the following values in the

fields:

Project SCLMUSR (use your own Project Name)
Group DEV1

Type ARCHDEF

Member MYPKG

3. Click the Submit button.
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4. From the Cloud 9 main menu, click LIST SCLM FILES and search for all
members in your Project with a Change Code of CCO01. This finds the two
members you have edited, within the DEV1 Group.

5. Select the two members and, from the Cloud 9 main menu, click ADD TO
PACKAGE. A message box displays to confirm that the two rows have been
added.

6. From the Cloud 9 main menu, click SAVE/VIEW PACKAGE. Your Package
information is displayed in the Save Package section and the two members are
listed in the Package Contents section.

7. Ensure that the Change Code field contains CC01 and click the Submit button.
A confirmation message displays in the browser.

8. From the Cloud 9 main menu, click LIST SCLM FILES again and search for all
members in your Project with a Change Code of CCO01. This finds the two
members you have edited and your new Package.

Member (3) Project Group Type Language Status Access key

[~ FLMO1MD1 SCLMUER  DEW1 S0URCE  HLAS EDITABLE
I~ FLMOIMD2 SCLMUSR  DEW1 SOURCE  PLIO EDITABLE
[ MYPKG SCLMUER  DEWA ARCHDEF  ARCHDEF EDITABLE

Figure 129. Member List for DEV'1, showing new Package

You are now ready to begin Task #5.

Task #5: Build the Package

This task has two sub-tasks, which together demonstrate the differences between a
simple Build process, which uses Packages containing Source members; and
Change Code processing, which uses Packages containing Change Codes and
ARCHDEFs.

Task #5a: Build Packages with Source members

In this task, you build your existing Package member, which builds both members

listed in the Package contents and all non-editable dependent members. This

demonstrates simple Package processing, which is useful for testing your changes

within its immediate scope.

1. On your Member List, select MYPKG (your existing Package member) only.

2. From the Cloud 9 main menu, click BUILD. The Build panel displays.

3. Set the Mode to Conditional, the Scope to Normal and the Execution Mode to
Foreground.

4. Click the Submit button. A confirmation message displays in the browser.

5. From the Cloud 9 main menu, click LIST SCLM FILES again and search for all
members in the DEV1 Group. Ensure that the Accounting Status is set to All.

This finds the two members you have edited, your Package and the
non-editable members dependent upon your edited members.
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=
=
=
=
=
=
=

Member (7) Project Group  Type Language Status Access key
FLMO1MD1  SCLMUSRE DEw1 OBl HLAS MON-EDIT
FLMOIMD1  SCLMUSR DEv1  SOURCE  HLAS EDITABLE
FLMO1MD1 SCLMUSE  DEWY SOURCLST  HLAS MNON-EDIT
FLMO1MD2  SCLMUSRE DEW1  OBJ PLIO MON-EDIT
FLKO1MD2 SCLMUSE  DEWM SOURCE PLIO EDITAELE
FLMO1MD2  SCLMUSE DEv1  SOURCLST PLIO MON-EDIT
MYPKG SCLMUSE  DEWM ARCHDEF  ARCHDEF EDITAELE

Figure 130. Member List for DEV'1, after MYPKG Build

Task #5b:

Build Packages with Change Codes and ARCHDEFs

In this task, you create a Package that uses your Change Code and a High Level
ARCHDEF, instead of individual source members. This builds all members of the
package that have been assigned the Change Code and all members within the
project that might be affected by these changes. This demonstrates Change Code
processing, which is useful when you want to build your full application.

1.
2.

From the Cloud 9 main menu, click SAVE/VIEW PACKAGE.

Click the Start Over button, then click OPEN PACKAGE from the Cloud 9
main menu.

Select the Create New Package option and enter the following values in the
fields:

Project SCLMUSR (use your own Project Name)
Group DEV1

Type ARCHDEF

Member Ccco1

Click the Submit button.

From the Cloud 9 main menu, click SAVE/VIEW PACKAGE. Your Package
information is displayed in the Save Package section and the Package
Contents section contains *** FILE IS EMPTY ***,

Highlight and delete the current Package Contents.

Enter CCODE CCO01 at the top of the Package Contents area. This causes
Cloud 9 (and therefore SCLM) to include any other source members that have
this Change Code, when you Build and Promote the Package.

Enter INCL FLMO01AP1 ARCHDEF on the next line. This is the highest level
ARCHDEF in your project and it forces the re-link of any load modules
affected by changes in Members marked with the CC01 Change Code.

Package Contents:

CCODE CCO1
INCL FLMO1lAF1 ARCHDEF

Figure 131. Package Contents after editing

9.

10.

Ensure that the Change Code field contains CC01 and click the Submit button.
A confirmation message displays in the browser.

From the Cloud 9 main menu, click LIST SCLM FILES again and search for all
members in the DEV1 Group.
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11.
12. List the SCLM members in DEV1 again. This time, the list includes a number

Select the CC01 member and click BUILD.

of additional members.

Member (12) Project Group  Type Language Status Access key
- ccot SCLMUSE DEY!  ARCHDEF  ARCHDEF EDITABLE
I FLWMOILDA SCLMUSRE DEW1  LMAP LEZ70 MONM-EDIT
I~ FLWMO1LDA SCLMUSE DEW1  LOAD LE370 MON-EDIT
[~ FLMO1LDZ2 SCLMUSRE DEW1  LMAP LEZ70 MONM-EDIT
I~ FLMOILD2 SCLMUSE  DEWA LOAD LE370 MON-EDIT
I FLMODIMD1 SCLMUSR DEY1  OBJ HLAS MONM-EDIT
I~ FLMO1MDA SCLMUSE  DEWA SOURCE HLAS EDITABLE
I FLMODIMD1 SCLMUSRE DEY1  SOURCLST HLAS MON-EDIT
I~ FLMOD1MDZ SCLMUSE  DEWA OB.J PLIO MON-EDIT
I~ FLMOD1MDZ SCLMUSRE DEY!  SOURCE  PLIO EDITABLE
I FLMODIMDZ SCLMUSR DEW1  SOURCLST PLIO MONM-EDIT
I~ MYPKG SCLMUSE  DEWA ARCHDEF  ARCHDEF EDITABLE

Figure 132. Member List for DEV1, after CCO1 Build

You are now ready to begin Task #6.

Task #6: Promoting Packages

108

In this task you promote your Package to the TEST and RELEASE Groups, which

promotes all of the edited members and any dependent non-editable members.
1. On your Member List, select CCO1 (your new Package member) only.

2. From the Cloud 9 main menu, click PROMOTE. The Promote panel displays.
3. Set the Mode to Conditional, the Scope to Normal and the Execution Mode to

Foreground.

4. Click the Submit button. A confirmation message displays in the browser.

5. List the SCLM members again, and search for all members in the DEV1 Group.

The list contains only your MYPKG member.

Note: Attempting to Promote this member would cause errors, as the source
members have been moved to the TEST Group.

6. List the SCLM members again, and search for all members in the TEST Group.

The promoted members are on this list.

7. Select the CC01 member and Promote it a second time. This moves the Package

and its related members up to the RELEASE Group.

8. List the SCLM members again, and search for all members in the RELEASE
Group that have a Change Code of CC01. The CCO01 Package and the two

edited members are on this list.
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Part 2. Using the VisualAge for Java Interface
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Chapter 8. Cloud 9 Visual Age for Java Plug-in

This document is designed to familiarize you with the functionality of the Cloud 9
SCCI Interface. It describes the main aspects of the product’s functionality, lists the
product requirements, and provides a reference section with some key definitions
and an FAQ section to answer any further questions the user might have. The
topics covered in this document are:

* Product requirements
* Cloud 9 SCCI interface walkthrough
— Add to Version Control
— Cloud 9 browser interface
— Adding Resource files to SCLM
— Adding .class files to SCLM
— Add to Version Control - project already in SCLM
— Refresh project
— Using the Check Out facility
— Creating your Profile
— Using the Check In facility
— Viewing log files
* Key term definitions
* Cloud 9/VA Java limitations
* FAQ Section

Product requirements

The VA Java IDE interface has been tested using Visual Age for Java 3.5.3 and 4.0.
Older versions of the product might work but have not, as of yet, been tested. The
following list shows the operating systems on which the IDE Interface has been

tested. Other operating systems might be compatible, but have not yet been tested.

* NT 4.0 SP5 (no longer supported by Microsoft)
* NT 4.0 SP6 (free upgrade)

* Windows 2000 Professional

* Windows 2000 Professional SP1

* Windows 2000 Professional SP2

* Windows 2000 Professional SP3

* Windows 2000 Professional SP4

* Windows XP Professional

Note: This document uses the term "z/0S" to refer to both the z/0OS and the
0OS/390 operating systems.
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VisualAge for Java - Cloud 9 SCCI Interface Walkthrough

This section of the document contains a comprehensive walkthrough of the Cloud
9 SCCI Interface. The walkthrough starts with the Add to Version Control function.
Add to Version Control is an initial load of the project’s files into SCLM. By the
end of the walkthrough, many of the features of the Cloud 9 SCCI Interface will
have been explained.

Add to Version Control

You can use Add to Version Control to initially place a VA Java project under the
control of SCLM. This task only needs to be performed once for the VA Java
project. After the project has been loaded into SCLM, you can use the check out,
check in, add and delete functions to work with the VA Java files.

To add a project to version control:

1. Within the VisualAge for Java Workbench, right-click the project that you want
to add.

2. Select Tools > External Version Control > Add to Version Control.

'E:Workhench i | - O} x
e L

[ﬁ_.ﬁ.ll Frojects +$ e
&5 csDema™

'+ &) FinalTest3™

'+ S5 1BM Java Implementation
&) Java class ibraries

m--%'-wmﬁs-’*
E Open

I

P o l. e
HEY PIFTe oy, b
&1@ :'ESm'qII[_’:J_._e_m.c Go T »
EI@ Sunclassl ——————————
o dmm T ames. e Add (3 B
_— ¥
Attribute Filkers. ..
@Comment
Import... I
Export... 3_|
Replace With 3
Delete...
FReorganize 4
Manage 3 vl
ﬂ Compate With 3 %
Run |
Dacument 2
External Wersion Control  » Add ko Version Contral..,

Copy to Clipboard Refresh Project, ..
Propetties Remaove From Version Contral...

R T

Figure 133. VA Java Workbench: Selecting Add to Version Control
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The Add to Version Control window is displayed:

E{:_,JAdd to Yersion Control x|

Select a source code management handler

\Microsoft SCC
'Visualﬂxge TeamConnection

Cancel |

Figure 134. Add to Version Control: Selecting a source code management handler

3. Select Microsoft SCCI from the list. The Cloud 9 interface uses the Microsoft
SCCI as its source code management handler.

The Select SCM System window is displayed:

EC_,JEEIEI:I: SCM System x|

Select a system:

FB Mative

Zloud 9

¥ Show advanced aptions if available

8] Cancel

Figure 135. Select SCM System: Selecting Cloud 9 as your change control tool

4. Select Cloud 9 as your SCM tool. If you have other change management tools
defined to VA Java, you can see other change control tools in the list.

The Select local diretory window is displayed:
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[C_,J Select local directory

Look: in: IC: j

[ avis

[ backup

[ books

(Dcig

[(3 cigdema
# [ cigsceapi
B [ cigtst

ﬁ _loud

[ com

[ dev

# [J Documents and Settings
H [ Drivers
[(3 graphics

# [ Help Docs -
4] 3

Direckory: |C:'|,Clu:uud9Temp'l,
Ik I Cancel |

Figure 136. Selecting a local directory

I_ILEE

STemp

5. Select a local working directory, accessible to Cloud 9, that VA Java can use for
import and export files. It is best to have previously created a working
directory before accessing this dialog box. In this example, a working directory
called Cloud9Temp was created on the C: drive, and is being selected.

The SCC Login dialog is displayed.
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[: visualage for Java SCM 2 - PetDemo Login )

Flease loginto the Source Control System:

Liser Mame: I
Fassword: |

Flease enter the location of the Cloud 9 Server:

Server Mame or |F: |
Server For: |
Sener Directan: |

Chtainthese settings from your Cloud 9 Administratar,

] | Cancel |

Figure 137. SCC Login

6. Enter your Z/0S user ID and password, and the host name or IP address
associated with the Cloud 9 HTTP Server. If you are not using port 80, enter a
port number.

If the Cloud 9 executable files, located on the z/OS mainframe, were installed
in a location other than cgi-bin, you need to specify the alternative location of
the Cloud 9 mainframe executable files. Leaving this field blank tells the Cloud
9 SCCI Interface that the host executable files are in the default location,
../cgi-bin.

7. You must now tell Cloud 9 where in SCLM you want the Project Profile to be
stored.
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[: visualage for Java SCM ¥2 - TesER

Flease enter wour project settings:

Froject: —L‘ J
Alternate: —L‘
GEroup: vl
Tipe: —L‘
Language:; | vl

0] | Cancel | Help |

Figure 138. SCM System Selection Panel

The Project Profile is a SCLM architecture definition member that contains a list
of all files associated with the selected files under SCLM’s control. The Cloud 9
SCLM member name is the same as the selected VA Java project name. The
button to the right of the Project field can be used to show a list of valid
Projects. The lists can be used to show the other supported SCLM inventory
locations.

8. Once these settings are selected and the Save button is clicked, the dialog box
shown in|Figure 139 displays, requesting an Authorization Code. A Change

Code can be specified.

Eﬁf’gb‘isualnge for Java SCM ¥2 - MIF X|

Flease enter the following information:

Authorization Code: |DEV vI

Chanoge Code; I

[ Display Host Messages?

DKl Zancel | Help

Figure 139. SCLM Action Details

The Authorization Code and the Change Code are used when the Project Profile is
stored under SCLM’s control. Selecting the "Display Host Messages” option causes
SCLM messages, generated when the Project Profile is added, to display.

Visual Age for Java tracks whether it thinks the selected project has been added to
an external version control system before. If VA Java thinks the project is not
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currently under the control of an external version control system then VA Java
displays the Unable to Detect Files dialog box, as shown in |Figure 140

iC.{Unable to Detect Files x|

! Unable to detect files on SCM server, Click Confinue if no files were expected. You may need 1o use your
3 SCM client to exdract files to the Clcigtst directory, and click Load from directory instead,

E_a_uncl_'n SCH c!ian| Load from directory Confinue Help T Cancel

Figure 140. Unable to Detect Files

Figure 140| states that the VA Java project is not under control of an external
version control system.

If the user is adding a Project Profile that already exists in SCLM, then skip to the
“Add to Version Control - Project already in SCLM” on page 124| section.

Figure 153 on page 125{shows the dialog box that is displayed if a Project Profile
already exists in SCLM.

Click Continue and a dialog box listing the Java project’s types is returned. You
can now select all files to be added into SCLM. The Select all Types check box
provides a fast way to do just that. Once you have selected the files, click the Next
button.

Add to Yersion Control SmartGuide -

Add to Version Control
Selectthe types fo be placed under version conirol,

Avallable Types!

m
atalogltem

[v Selectall Types

Cancel Efz) | et » I Finish Help

Figure 141. Export Type Panel

A panel listing all of the project’s files is returned. Visual Age shows this panel for
every different type of file associated with the project being added to version
control. For example, [Figure 142 on page 118| contains a list of the all of the .gif
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files in the project. At this point, you select all of the files being added into SCLM
and click Next.

E{_,.:lndd to ¥ersion Control SmartGuide

Add to Version Control

Select the resources to be placed under version contral.

Available Files:

ciprogram filestibmivisualage for javaiidelproject_resources\Screenshotsladd gif =
ciprogram filesiibmivisualage for javalidelproject_resourcesiSoreenShotslappiast.gif
ciprogram filesiibmivisualage for javalidelproject_resourcesiScreenShots\copy.gif ‘

ciprogram filesibmwisualage for javalidelproject_resourcesiScreenShotsicow. gif
ciprogram filesiibmivisualage for javalidelproject_resources\ScreenShotsicut gif
-
r|

clorogram filesiibmivisualaoge for iavalidelproject resnurcesIBcreethotsldelete.uif
4

[ Selectall Files

Teut files end with: Ija\ra tut bt xml did propedies bat ini cfg

Cancel | = Back I Pext = I Einish | Help |

Figure 142. Export Files Panel

Clicking Next brings up a panel giving you an option to add a prefix to the files
being stored in SCLM. Click Finish and the export process starts.

E{_,J.ﬂdd to Yersion Control SmartGuide x|

Add to Yersion Control

[f required, enter a path to prepend to your files for starage inthe SCMW system.

[ Do not add path prefix to files in the SCM system
Prefix |

Cancel | = Back | MER= | Einish Help

Figure 143. Add Prefix

Next, the SCLM action panel shown in |Figure 144 on page 119| displays. This panel
is similar to the one shown in [Figure 139 on page 116|except that it also includes
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the option to do a Remote Build. A Remote Build causes the SCLM translator to be
called once the file’s source is stored under SCLM’s control.

E\"g’g?isualnge for Jaya 5CM ¥2 - MIE x|

Flease enter the following information:

Authaorization Code: |IZ?|ER.f vI
Change Code: |CC

[T Dizplay Host Messages?

[ Perform Remote Build?

OKl Cancel | Help

Figure 144. Remote Build Option

On the panel shown in you can specify an SCLM Authorization Code
and Change Code to be associated with all the files being added into SCLM. To
view the SCLM messages generated when the SCLM save operation is performed,
select the "Display Host Messages” check box. You also have the ability to request
that the SCLM Build translator be called for each file, by selecting the "Perform
Remote Build” option. For java files, the remote build causes the java programs to
be compiled. Fill in the correct information and then the SCLM Details panel is
displayed.

fEiPlease Set SCLM Item Details x|

Flease Setthe SCLM lterm Details for;
Java Files

Sclm Type: MEI) ¥

Scim Language:  NETOSN -

OKl Cancel | Help

Figure 145. SCLM Item Details

Select the Language and Type for the files being added to the SCM system, click
OK, then watch as the selected files are placed under the control of SCLM. When
all of the files have been added, the following VA Java summary window is
opened:
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[{_,_]Prugress Information
Exporting IDE files and resources anto disk...
Copying project resources. ..

Finished export.

Adding files to SCM senver

Adding project resource files to SCM server
Finished adding files.

Finished

Figure 146. Export progress

The summary panel states that the project’s java files have been added into SCLM.

Cloud 9 Browser Interface

You can view either the Project Profile or any of the other files just added into
SCLM, using the Cloud 9 browser interface. To access this, the Open Version
Control function can be used.

To open the user’s version control system (in this case Cloud 9):
1. Right-click the project under version control.
2. Select Tools > External Version Control > Open Version Control.
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Figure 147. Cloud 9 Package List

This starts a browser and load Cloud 9’s log-in panel. Once Cloud 9 is
accessed, the user can check to see if their project and its files have been added
into SCLM. The Visual Age for Java project is now a standard package in
SCLM and is located wherever the user specified on the SCM System Selection
Panel (Figure 138 on page 116)

[Figure 148 on page 122| shows a list of SCLM Packages in Cloud 9:
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Figure 148. Cloud 9 Package List

The previous list contains a number of VA Java projects that have been added into
SCLM. Notice that one of them has been checked and highlighted. That is the
project that was just added to version control. [Figure 149 shows what that package

looks like in SCLM:

2l view: ~visualage for Java SCM v2SmaliDemo - Microsoft Internet § " er
|| Ble Gdt WYew Favorkes ook Help

*HANI:wanifescName=~Visualige for Java SCH vZSmallDems

THANI :manifestStars=1$VI0000401.0002/07/3102/07/3115:50 10 10 OP3SOR
¥~ 50:03

THANI:extension-Jjava=JAVL| JAVA

TMANI:extension-gif=GRAPHICS|EBIZEIN

THANI:E1lename-CON00000 | JAVA=com) smal ldemoz\ HainDemoz . java

INCLD COMODDDOD JAVE

*HANI:filename-COWO0000|GRAPHICS=cow.gif

INCLD COWoDDoon GRAPHICS

« | ;I;I

[&] Done [ | ket T

Figure 149. View Package

Adding Resource Files

Now that the VA Java project has been added to version control, the individual
resource files can be added as well. To do this:

1. Make sure the project in question has been added to version control.

2. From the VAJ Workbench Resources Tab, right-click the resource you wish to
add.

3. From the menu, select Tools > External Version Control > Add.
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Figure 150. Add resources to SCLM

4. Next you see a dialog box listing the resources being added. Click OK.

x|

The following files will be added

||::1pr|:|gram files\ibmwisualage for javalidelprnject_resuurcesISmallDemmcnw.gid

] | Cancel |

Figure 151. Resource being added to SCLM

5. After clicking OK, the SCLM options dialog box displays.
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Eg’g'iisualnge for Java SCM w2 - MJF x|

Fleaze enter the fallowing information:

Authorization Code: |DEV vI

Chanoge Code; |CC

[T Display Host Messages?

[ Perform Rermote Build?

2k Cancel Help

Figure 152. SCLM options dialog

Adding

1.

On this panel, you can specify an SCLM Authorization Code and Change Code
to be associated with all the files being added into SCLM. To view the SCLM
messages generated when the SCLM save operation is performed, select the
Display Host Messages check box. You also have the ability to request that the
SCLM Build translator be called for each file, by selecting the Perform Remote
Build option.

.Class Files to SCLM

On the VAJ Workbench Project Tab, right-click the project, package or class that
you wish to store in SCLM.

From the menu, select Export.
In the Export Dialog, select Directory as the export destination. Click OK.

In the Export to Directory dialog, enter the directory that is the local directory
that the user defined when adding the project to version control. Click OK.

In the Export to Directory dialog, for the What do you want to Export? option,
select *.class and make sure nothing else is selected. Click Finish.

Once the .class files have been exported to a directory, follow the instructions
previously provided, on adding resource files.

Add to Version Control - Project already in SCLM

If the VA Java project being added to version control is already located in SCLM,
then instead of [Figure 140 on page 117} the following dialog box is displayed:
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[(_,jndd to ¥ersion Control : x|

@ Thera are files in hath the IDE project and on your SCM server.
Do you wish to replace the contents of vour IDE project with the SCM files?

Selecting Yes will version your project and remowe all its packages from the warkspace,
The packages will still be available from the repositarny.

Figure 153. Import Process

This panel states that the project that you are adding to version control already
exists in SCLM. Clicking Yes causes all the files in your local VA Java project to be
overlaid and refreshed with files stored in SCLM.

(] Select files to Import 3 x|

Available Files:

olMainapp

Select none |

Fiter, [~ Select all

Path prefix that is removed on import:

0K | Caru:eil

Figure 154. Import Process - Select Files

Because the project’s files already reside on the mainframe, the mainframe versions
of the files are imported and compared against the project files being added to
version control. Select the files being added to version control and the correct path
prefix and click OK.

When the files have all been imported to the IDE, the VA Java summary panel is
returned:
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[C_,J Progress Information '_ EI

Extracting files from SCM senver onta disk.

Finished extracting parts.

Imporing Java resources into the IDE...

Imported ChcigtsticomismalldemotainApp. java successiully.
Imported Chcigtsticomismalldemo2MainDemo? java successiully.
Imported ChcigtstidukeSnooze. gif successiully.

Imported Chcigtsthulldog.jpg successiully.

Imported Chcigtstcow.gif successiully.

Finished impoding files into the IDE

- Finished

Figure 155. Progress Info

The files within Visual Age for Java have now been refreshed and replaced with
the files stored in SCLM.

Refresh Project

Now that the VA Java project’s files have been added to version control, you might
want to edit the project’s files. To be safe, you can do a Refresh Project, just to
make sure you are working with the most current version of the project.

To refresh the project:
1. Right-click the project under version control.
2. Select Tools > External Version Control > Refresh Project.

If the project has not been changed, the Refresh Project window is displayed:

i

@ The projectis consistent with the repository already. Eefresh complete.

Figure 156. Refresh Project

If the VA Java project’s files have been changed since being added to version
control, the Refresh Project dialog box displays. Different tabs are highlighted
depending on what changes were made to the files.
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Add =

AddAll== I

« Remove I
== Remave !:II |

Ok Cancel

Figure 157. Refresh Project

Check Out

After the VA Java project has been refreshed, the files being edited need to be
checked out from SCLM. A lock is placed on a file when the user does a Check
Out in VA Java.

To Check Out a file:
1. Right-click the file that needs to be Checked Out.
2. Select Tools > External Version Control > Check Out.
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Figure 158. Check Out Summary

3. Once Check Out is selected, a panel is displayed, asking for confirmation of the
checkout. Click OK and the next panel asks you for an Authorization Code, a
Change Code and give you an option to view host messages.

E"Eﬁ?isualnge for Java SCM ¥2 - MIFLD. |

Flease enter the following infarmation:

Authorization Code: |IZ?|ER.f vI
Change Code; I

[ Display Host Messages?

DKl Zancel | Help

Figure 159.
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From this point, two different windows can be shown. If another user has not
checked out the previously mentioned file, the VA Java summary window is
displayed and the file is locked in both SCLM and VA Java.

[C_.._] Summary

Check out Surmmany

Summary
ChcigtsttestpalkiTestPakl java checked out.

1 file wwas checked out.

o

Figure 160. Check Out Summary

If the file you are requesting is already checked out by another user, you cannot
check out the file until the other user has checked it in. A "checked out” panel is
displayed and gives all the information needed to contact the user who has
checked out the file the you are requesting. Their picture, user ID, telephone
number, and an e-mail link are all provided.

¥isualAge for Java SCM ¥2 - MIF1001 Checked Out To Other User 1 il

The following fileds) are checked out to other users:

rmjfpackiiioo java

User Name: [P380k
Marme: [Bpike
E-mail: fspike@yahoo.com
Voice: |555-2345
E-Wail User Reattermpt Continue | Help |

Figure 161. Re-Attempt Check Out

Once the other user has been contacted and the file has been checked in, you can
click Re-attempt Check Out to go on with the editing process. A summary
statement, such as the one in [Figure 160} is displayed. Click OK and the requested
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file is checked out and ready to edit. Upon checkout, there a lock displays next to
the file on the VA Java workbench.

Figure 162. Locked file

Create your Profile

The Re-Attempt Check Out dialog uses information stored in your Cloud 9 Profile.
To set up your Cloud 9 profile, you need to use the Cloud 9 Browser Interface. To
access the Cloud 9 Browser Interface, you need to use the Open Version Control
function as is shown in [Figure 163 on page 131}
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Figure 163. Accessing Cloud 9 Browser Interface

Once Cloud 9 is accessed, click the Profile link on the main menu to display the
Profile panel.
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Figure 164. Profile options

Fill in the fields for your name, e-mail address, telephone number and picture
(only .jpg images), and click Update profile. This information is then returned to
other users when they attempt to check out files already under your control. The
rest of the fields on the Profile panel are used for specific Cloud 9 functions only
and are not used directly by the Cloud 9 SCCI Interface.

Check In

Now that the file is checked out, it is ready to be edited. Double-click the file to
display the edit window.
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Figure 165. Edit window

Once the file has been edited, it is ready to be checked back in to SCLM. To Check
In a file:

1. Save any changes made to the file.
2. Right-click the file the user wants to Check In.
3. Select Tools > External Version Control > Check In.
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External Wersion Contral  »

Figure 166. Check In

The next panel received asks you for an Authorization Code and a Change Code,
and gives you an option to view host messages. Enter the Codes and, if you want,
select the check box.

Figure 167. SCLM Action Details
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A VA Java summary window is displayed, informing the user that the file has been
checked in. Also, the lock that was previously next to the file, has gone.

[C_,_] Summary

Checkin Summany;

Summary
CocigtsttestpakiTestPakl java checked in.

1 filewas checked in.

Figure 168. Check In Summary

View Log Files
If a problem occurs, there are log files that can be turned on and then accessed. To

do this:
1. Click the Start button.

2. Select Run.

Run 2 x|

Type the name of a program, Folder, document, or
; Internet resource, and Windows will open it Faor wou,

Cipen: | REGEDIT |

Ik I Cancel | Browse, ., |

Figure 169. Run dialog box

3. Type REGEDIT on the command line and click OK. The following screen is
displayed.
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Figure 170.
4. Right-click Trace on the right half of |Figure 170

5.
6.

Select Modify.

Change the trace value to 0, 1 or 4, depending on what level of tracing you
require.

Then re-create the error.

The trace messages is stored in a folder called ~log, in the user’s installation
directory. This file contains helpful error information.

Cloud 9/VisualAge for Java - Definitions

IDE - Integrated Development Environment

An IDE is a development tool used for rapid application development. The
IDE includes an editor, debugging tool, run-time environment and
deployment capabilities. Visual Age for Java provides for an Integrated
Development Environment.

SCCI - Source Change Control Interface

This is a Microsoft published specification that describes how IDE vendors
interface to Source Change Control systems. The SCCI, also known as the
SCC API, describes the functions that IDE vendors support, such as
Check-in, Check-out and Project Refresh.

SCM - Software Configuration Management

Software Configuration Management is one of the systems management
disciplines that focus on the management of software components. SCM
includes capabilities such as version control, life cycle management, build
management and component relationships.

SCLM Server

SCLM is the SCM solution developed and distributed by IBM for the
0S/390 and z/0S systems. SCLM is an acronym meaning Software
Configuration and Library Manager. SCLM is one of the integrated
components of TSO/ISPF. The SCLM Server extends the capabilities of
SCLM to the user’s desktop through both browsers and IDEs. Technically,
the SCLM Server is an application called Cloud 9 that runs under the
control of the IBM HTTP Server running on the OS/390 or z/OS system.
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Cloud 9/VisualAge for Java - Frequently Asked Questions

QL1: After the SCCI interface and SCM system have been selected, a location
working directory needs to be established statement displays. Where is the location
working directory supposed to be established: on the user’s workstation or on a
server?
Answer: The local working directory is a temporary directory used by
VisualAge For Java to pass files to Cloud 9. The directory is similar to the
CA\TEMP directory used by Windows. The VisualAge for Java working
directory must be established on the local user’s workstation. You can see
an example of the local working directory in [Figure 136 on page 114 The
example shows a working directory of C:\Cloud9Temp.

Q2: In the example, Project, Alternate, Group, Type and Lang are entered. Does
this mean that if multiple Java classes are being extracted from VA Java into
SCLM then a separate logon must be performed each time Type or Language
change?
Answer: You log on to Cloud 9 only once per invocation of VisualAge for
Java, when the first SCCI service is requested. You are not required to log
on for each type.

Q3: Can the Java code and the Java output classes both be added, checked out
and checked in?
Answer: You can check-in both source and class files into SCLM, using the
Cloud 9 SCCI. In addition, other file types, such as graphics, can be added
into SCLM using the Cloud 9 SCCI.

Q4: Can code be added into separate SCLM types if needed?
Answer: VA Java files with the same extension are associated with a single
SCLM type for a single VA Java project. Therefore .java, .class, .jpg, and .gif
files can be stored as separate SCLM types; the files can be stored as the
same SCLM type. However, all file extensions with the same extension are
stored in the same SCLM type. For example, the user might store both .jpg
and .gif files into the SCLM type called GRAPHICS while .java files are
stored as type JAVA and .class files are stored as SCLM type CLASS.

Q5: Authorization codes, change codes and languages can be specified through

the Cloud 9 IDE panels. Can these fields be validated by exit routines and on

which platforms will the routines run?
Answer: Cloud 9 uses standard SCLM services when storing and updating
SCLM controlled files. By using published SCLM services, all SCLM exit
routines are available. Validation of authorization codes, change codes and
languages is typically performed through the use of the SCLM CCID exit
routine. SCLM exit routines run in the OS/390 or z/OS environment.
SCLM exit routines are described in the ISPF SCLM Project Manager’s and
Developer’s Guide and ISPF SCLM Reference manuals.

Q6: In the statement "If the project being added is new and is not located anywhere on
the SCLM server, then a panel listing all of the project’s files is displayed. Visual Age
display panel for every different type of file associated with the project being added to
version control.”, what project are you referring to? Is this the VVAJ project or is
this a definition within SCLM?
Answer: There are two different projects here: the VisualAge for Java (VAJ)
project and SCLM project. The VAJ project includes all of the objects
associated with the currently opened VAJ project. The list of files included
within the VVAJ project is stored as a single member within SCLM known
as a SCLM package. Each file within the VAJ project is stored as a separate
SCLM member.
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SCLM also uses the term Project to describe all files associated with a
particular application. All VA files associated with a VVAJ project are stored
under the control of a single SCLM project. An SCLM project can have
non-VAJ objects such as COBOL and JCL.

For example, you might have a VAJ project called Petdemo that includes
twenty java files, twenty class files and ten graphics files. The VAJ project
might be stored under the SCLM Order Entry project called ORDENTRY.
Also under control of the SCLM ORDENTRY project might be a COBOL
billing application.

Q7: During the process of Adding a project to version control, is an ARCHDEF

being created to define all of the members being exported from VA Java? All of

your examples indicate ARCHDEF or similar named languages/types.
Answer: All of the files names and default type/language definitions
associated with a single VAJ project are stored as a single SCLM member.
This member, known as a Package, must have a language of ARCHDEF.
The examples in the Cloud-9 VAJ documentation show a SCLM type of
PACKAGE with a SCLM language of ARCHDEF. The flexibility of SCLM
allows the user to define SCLM types and languages other than
PACKAGES and ARCHDEF.

Packages use the default language of ARCHDEF.

Q8: I understand that full path names can be added / saved for the VAJ member

in Cloud 9. Is this an option that has to be specified each time or can it be set in

an option file?
Answer: The full path names are stored in the SCLM-VAJ package. Once
the full path name is defined to the SCLM-VAJ package, the full path name
is not specified again. If for some reason the full path name does change,
then the definition contained within the SCLM-VAIJ package can be
updated by the SCCI function Remove from Version Control followed by
the SCCI function Add to Version Control. The SCCI function Remove
from Version Control only updates the SCLM-VAJ package file, and does
not physically delete the SCLM file.
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Part 3. Using the WebSphere Studio Application Developer
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Chapter 9. Cloud 9 WebSphere Studio Application Developer

Plug-in

This document is designed to familiarize you with the functionality of the Cloud 9
WebSphere Studio Application Developer Plug-in (WSAD Plug-in). This is a
plug-in that you can install onto your PC, so that you can use the Version Control
features of WebSphere Studio Application Developer or WebSphere Studio
Enterprise Developer. Because the WSAD Plug-in is configured and works in
exactly the same way with either WebSphere product, this manual uses the name
"WebSphere Studio Application Developer” to refer to both WSAD and WSED.

This part of the Guide describes the main aspects of the plug-in’s functionality, lists
the product requirements, and provides a reference section with some key
definitions and an FAQ section to answer any further questions that you may
have. The topics covered in this document are:

* Product requirements
* |IDE interface walkthrough
— Adding a project to Version Control
— Launching the Cloud 9 browser interface
— Using Add Special
— Performing a Remote Build
— Modifying your project settings
— Refreshing project
— Using the Check Out facility
— Creating your Profile
— Using the Check In facility
— Viewing log files
* Key term definitions
* Frequently asked questions

Product requirements

The Cloud 9 WSAD Plug-in has been tested using Websphere Studio Application
Developer 5.0 and 5.1 and Websphere Studio Enterprise Developer 5.0 and 5.1.1.
Older versions of the product may work, but have not been tested. The following
list shows the operating systems on which the Cloud 9 WSAD Plug-in has been
tested. Other operating systems might be compatible, but have not been tested.

* Windows 2000 Professional

* Windows 2000 Professional SP1
* Windows 2000 Professional SP2
* Windows 2000 Professional SP3
* Windows XP Professional

Note: This document uses the term "z/0S" to refer to both the z/OS and the
0OS/390 operating systems.
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Cloud 9 WebSphere Studio Application Developer Plug-in walkthrough

This section contains a comprehensive walkthrough of the Cloud 9 WSAD Plug-in.
The walkthrough starts with the Add to Version Control function: Add to Version
Control is an initial load of the project’s files into SCLM. By the end of the
walkthrough, many of the features of the Cloud 9 WSAD Plug-in will have been
explained.

Add to Version Control

You can use Add to Version Control to initially place a WSAD project under the
control of SCLM. This task only needs to be performed once for the WSAD project.
After the project has been loaded into SCLM, you can use the check out, check in,
refresh and remove functions to work with the WSAD files.

The first step in adding a project to version control is sharing the project with a
change control tool, in this case, Cloud 9.

1. Within the WebSphere Studio Application Developer window, right-click the
project that you want to share.

2. Select Team > Share Project.
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Figure 171. Selecting Share Project

3. From the Share Project window, select Cloud 9 as your source code
management handler, then click Next.
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Share Project

Select the repository plug-in that will be used ko share the selected project.

Select a repository bype;

= CvS

< Bach I Mexk = I FEimist Zancel

Figure 172. Selecting a source code management handler

4. The next dialog box asks you to verify that you selected Cloud 9. Click Finish
to confirm that your WSAD project will be shared with Cloud 9.
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Cloud 9

Add Cloud 9 support to this project

Figure 173. Confirming Cloud 9 as your change control tool

Note: To unshare your project, right-click the project and select Team > Unshare
Project.

After you have shared the project, you can add the project and its files to version
control. To do this:

1. Right click on the project, package, or individual files you want to add.
2. Select Team > Add to Version Control.
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Figure 174. Add to Version Control

3. From the Select Files to Add window, select the files that you want to add to
version control, then click OK.
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Figure 175. Select files to add

4. In the Login window that appears next, enter your z/OS user ID and
password, and the host name or IP address associated with the Cloud 9 HTTP
Server. If you are not using port 80, enter a port number.

If the Cloud 9 executable files, located on the z/OS mainframe, were installed
in a location other than cgi-bin, you need to specify the alternative location of
the Cloud 9 mainframe executable files. Leaving this field blank tells the Cloud
9 WSAD Plug-in that the host executable files are in the default location,
../cgi-bin.
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E%Lugin to Cloud 9 x|

Please login to Cloud 9.

Llzer Mame: |5c|musr
Fasswiord: |ﬂﬂ*ﬂ

Flease enter the location ofthe Cloud 9 Server:

Server Mame or IP: |pthisd

Server Port: {1695

Server Directory. |

Chtain these settings from your Cloud 9 Administrator.

O | Cancel |

Figure 176. Cloud 9 Login

5.

In the Project Settings window (Figure 177 on page 148), you can add your
files to an existing Manifest or create a new Manifest.

When you create a new Manifest, a Host Manifest file is created in USS and a
Local Manifest file is created in your local working directory. When you add
files to an existing Manifest to which you have not added files before, a Local
Manifest file is created. The Host Manifest file contains a listing of all of the
files which are a part of that WSAD project and metadata about the project,
including default extension mapping to SCLM types and languages. The Local
Manifest file is used to cache your Cloud 9 settings and includes the Manifest
name on the host, the host IP address and port number, and other settings. See
[Cloud 9 - WSAD Definitions” on page 163| for more information about Host
Manifest and Local Manifest files.

To create a new Manifest:
a. If necessary, click New in the Project Settings window.
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Eg_;gProiect Settings x|

Flease specify a unigue host manifest name and an SCLM location for your project.

Manifest Marne:  |wsad11 [SCLMTEST. SCLMTEST.DEW] =
Abct [SCLMTEST.SCLMTEST.DEW] —
Abc? [SCLMTEST.SCLMTEST.DEW]
Abc3 [SCLMTEST.SCLMTEST.DEW]
Abcd [SCLMTEST. SCLMTEST.DEW] -
Project: I 'l
Alternate: I vl
Graup: I—L, Hew.

Save Cancel | Help |

Figure 177. Project Settings

A name for your new Manifest is suggested for you, based on the selected
WASD project name. You can accept this name, modify it or replace it with
your own choice.

b. In the Project field, type the name of an existing SCLM project. If you are
not sure of the project name, click the button adjacent to the field to
populate the dropdown list, then select the name from the list.

Note: If you have a lot of SCLM projects, this may take a few minutes.

c. Select a name from the Alternate list. This list shows names associated with
your selected SCLM project.

d. Select a Group from the Group list. This is list shows names associated with
your selected alternate project.

e. Click Save to save your selections and continue, or click Return to return to
the SCM Project Profile Selection - existing Manifests window.

To select an existing Manifest:
a. In the Project Settings window, select the name of an existing Manifest.

E%_%Eclipse Based IDE - Test Scm Proje 1[

FPlease specify a unigque host manifest name and
an SCLM location for your project.

Manifest Name I'I'est

FProject: I vl _I
Alternate: I vI Return |
Group: I vI

Save | Cancel | Help |

Figure 178. Project Settings

b. Select a name from the Project list. This list shows the SCLM project names
associated with your selected Manifest.
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c. Select a name from the Alternate list. This list shows names associated with
your selected SCLM project.

d. Select a Group from the Group list. This is list shows names associated with
your selected project.

e. Click Save to save your selections and continue.

6. Specify an SCLM Authorization Code and Change Code to be associated with
all the files that you are adding into SCLM.

Eclipse Based IDE - Test

Please enter the following information:

Autharization CDde:lF‘ vi
Change Code: I

["] Display Host Messages?

0]54 | Cancel | Help |

Figure 179. Specifying SCLM Authorization Codes

If required, select the Display Host Messages checkbox, which displays the
SCLM messages that are generated when the SCLM Save operation is
performed. An example of these messages is shown in [Figure 181 on page 150}

7. In the next window, select the Language and Type for the files being added
into SCLM, click OK, and then watch as the selected files are placed under the
control of SCLM.

E&iDefault SCLM File Type Mapping e |

Please Setthe SCLM item Details for.
_pdf Files

These settings will be used as the
defaults for future files with this
extension. Ifyou chose to override
the language and type on the Action
Details panel, those settings will be
used far the current fileset and the
settings you choose here will be
default for future files.

Sclm Type: I#\RCHDEF 'l

Sclm Language:

ok | cancel | Hew |

Figure 180. Default SCLM File Type Mapping

This dialog box is redisplayed for each type of file (extension) being added into
SCLM control. Select the Language and Type for each file type until all types
have been added.

If you selected the Display Host Messages option in the SCLM Action window,
the SCLM messages window is displayed when all of your project’s files have been
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added into SCLM. If you did not select the option, you are returned to the WSAD
main screen when all of your project’s files have been added into SCLM.

Add to Yersion Control Host Messages Host Messages 1[
Add to Version Control
FLMOG501 - TRANSLATOR FETURN CODE FROM === ===> 0 L]
FLM37107 - 3AVE SUCCEEDED FORE MEMEER $CLOOOQQO0 AT 15:16:03, CODE: O
FLMOA501 - TRANSLATOR RETURN CODE FROM ===> ===> 0
FLME7107 - SAVE SUCCEEDED FOE MEMEER $PROOOOO0 AT 15:16:05, CODE: O
Start of ISPF Log - - - - SE55i00 § L —mmmmmmmmmmmmmm e -
TS50 - Command - - 5$TEMPNAME
End of ISPF Log - - - - - Session # 1 -
REALDTY
J,-'ﬂ‘ ______________________________________________________________ HJ.n’
FEADY
A% NAME: CLEZJDYH L
FEADY
/% PURPOSE: CLOUDr 9 FOR 3CLM w4
REALDTY
i ISPF ALLOCATIONS FOR 3CLM WEE BASED FUNCTIONS. L
FEADY
J,I"ﬂ‘ ______________________________________________________________ WJ.!’
FEADY
i i
REALDTY
/% REQUIFED MODIFICATION: /7 =
Close | Help |

Figure 181. SCLM messages

When you close this window, you are returned to the WSAD main screen. The
associations that you made between the file extension and the SCLM Type and
Language are stored in your Host Manifest file. When you add files with the same
extension in the future, the files will automatically be put into SCLM with the
same Type and Language settings. You can override these settings by adding a file
to version control using the Add Special command. (See [*Add Special” on page]

for details.)

Projects and files can also be removed from version control. To remove a project or
files from version control:

1. Right-click the project or file you wish to remove.
2. Select Team > Remove.

Launching the Cloud 9 browser interface

You may wish to use the Cloud 9 browser interface to view the files that you have
just added into SCLM version control. To open your version control system from
within WebSphere Application Developer:

1. Right click on a project that is under version control.
2. Select Team > Launch Cloud 9.
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Figure 182. Launch Cloud 9

From within Cloud 9, you can use the LIST SCLM FILES option to check that your
files have been correctly added into SCLM.

Add Special

You can add a file to version control using a Language and Type that is different to
the one specified in your Host Manifest file.

To do this:
1. Right-click on the file that you want to add.
2. Select Team > Add Special.

3. In the Select Files to Add window (see [Figure 175 on page 146), ensure that
your files are selected and click Next.

4. In the Add Special window, specify your Authorization Code, Change Code,
Language and Type. You can use this window to override the default Language
and Type specifications.
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Eclipse Based IDE - Test2 x|

Flease enter the following information:

Authorization Code: |F' :I'
Change Code: I

[ Display Host Messages?

Type and Language Override;

SCLM Qverride Type: spsRDEF
SCLM Override Language: IAl}{JA\J’A 'i
(0]24 Cancel | Help |

Figure 183. Add Special

Submitting an SCLM build

After a project and its files have been added to version control, you have the
option of submitting a batch SCLM build. Requesting a remote build calls the
SCLM Build Translator to be invoked for each file. For Java files, the remote build
will cause the Java programs to be compiled.

To perform a remote build:
1. Right-click the project for which the build will be performed.
2. Select Team > Submit SCLM Build.
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Figure 184. Submit SCLM Build

3. A message will confirm whether or not the build has been submitted.
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E%%Perfurm Remote Build x|

Submit SCLM Build Host Messages

HOSTHSE @ Bateh job suwitted
HOSTMSG @ Use the Cloud 9 5SDSF Viewer to look at the jaob.
HOSTMSG : Refer to the Help System for information on the Cloud & 3DSF Wiewer.

Close | Help |

Figure 185. Submit SCLM Build

Remote builds can also be performed when checking in a file, which is explained
further in that section.

Modify project settings

After a project had been added into SCLM, you can change the group that the
project is stored in. This is done using the Modify Project Settings option. To access
this option;

1. Right-click on the project.

2. Select Team > Modify Project Settings.

3. Change the SCLM entry group of the project.

Eﬁj‘, Project Settings 1[

Flease specify a unigue host manifest name and an SCLM location for your project.

Manifest Narme:  [Junit

PigEe ISCLMTEST vI
Alternate: ISCLMTEST vl
Group: [N n Mew. .

Save | Cancel | Help |

Figure 186. Modify Project Settings
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In some cases you

may want to add the project to a non-entry SCLM group,

which will be listed in the group dropdown. This will change the group for the
project in your local manifest. The project now contains all the data from the
non-entry SCLM group and your local manifest correctly contains the entry
group you want to work in.

Refresh Project

Now that the WSAD project’s files have been added to version control, you may
wish to edit the project’s files. To be safe, you may want to do a Refresh Project,
just to make sure you are working with the most current version of the project. To
refresh the project:

Right click on the project under version control.

Select Team > Refresh Project. The Refresh Project window will display the list
of files registered in the Host Manifest for your project. If you are missing any
files associated with the host project they can be downloaded to your machine.

1.
2.

4k Refresh Project

Select files to refresh:

=0l x|

[ 4] TestCollector,java
[ [ TestDecorator,java
[ TestFailure.java
[ [ TestimplementorTest,
[ 4] Testlistener.java
[ [ TestlistenerTest java
[ 4] TestResul java
A [ TestRunner.java
[ 4] Testsetup.java

[ Testsuite.java

[ TestsuiteLoadsr,java
[ TextRunnerTest.java
[ vectorTest.java
[ [ version.java

[ ] WwasRun.java

Select all | Deselect nlll

oK I Cancel

java

Figure 187. Refresh Project

3. Review the list of selected files, then click OK to confirm your choices. The files
will be compared with the version in SCLM and the most current version of the
file will be returned to your local repository.

If you wish to refresh individual files:
Right click on the files that you wish to refresh.
2. Select Team > Refresh. Your selected files will be listed in the Refresh Files

1.

window.
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4k Refresh Files 1Ol x|

ExceptionTestCase, java
[J] RepeatedTest.java

; TestDecorator. java

[J7 Testsetup.java

Select Al Deselect Al |

oK I Cancel

Figure 188. Refresh Files

3. Review your selections, then click OK to confirm your choices. The file or files
will be compared with the version in SCLM and the most current version of the
file will be returned to your local repository.

Check Out

After the WSAD project has been refreshed, the files being edited need to be
checked out from SCLM. A lock is placed on a file when the user does a Check
Out in WSAD.

To Check Out a file:
1. Right click on the file that needs to be checked out.

2. Select Team > Check Out. The Checkout window will display your selected
files.
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o]

Cancel

Figure 189. Check Out

3. Review your selections, then click OK to confirm your choices.
In the next window, change the Authorization Code (if desired) and enter a

valid Change Code. If required, select the option to view host messages. Click

OK.

Checkout

Flease enter the following information:

Autharization Code:

Change Code:

Fl

[

[~ Display Host Messages?

] Cancel

Help

|

Figure 190. Check Out

5. From this point two different screens may be shown. If another user has not

checked out your selected files, then they are checked out to your user ID and

a check mark appears next to the file on the WSAD menu.
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H-{= framework

----- ?ﬂ Assert.java

----- ?ﬂ AssertionFailedError.java

Figure 191. Checked out files in WSAD list

If the file or files you are requesting are already checked out by another user,
you cannot check out the file until the other user has checked it back in. You
will see a Checked out window that shows all the information needed to
contact the user who has checked out the file. If the other user has completed
their profile information, their picture, user ID, phone number, and an email
link are provided.

The following file(s) are checked outto other users:

junitiframesark

User Name: [USERID

Marne: |user Name
E-mail: |ema|l@server.com
Waice: [132428

E-Mail User | Reattermpt Continue | Help |

Figure 192. Checked out files window

If you are able to contact the other user, and they can check the file in
immediately, you can click Re-attempt Check Out to go on with the editing
process. Otherwise, click Continue to close the window without checking out
the file.

Create your Profile

The Re-Attempt Check Out dialog uses information stored in your Cloud 9 Profile.
To set up your Cloud 9 profile:

1. Launch the Cloud 9 Browser Interface.
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2. Click the PROFILE link on the main menu to bring up the Profile page.

Profile

//SCLMUSRS JOB (#ACCT),'SCLM USER',CLASS=A,
i MSGCLASS=X, NOTIFY=£3¥3UID

Figure 193. Profile page in Cloud 9

3. Fill in the fields for your name, email, phone, and picture (only .jpg images)
and click Update profile.

This information will then be returned to other users when they attempt to
check out files already under your control. The rest of the fields on the Profile
panel are used for specific Cloud 9 functions only and are not used directly by
the Cloud 9 WSAD Plug-in.

Check In

Now that the file is checked out, it is ready to be edited. Double click on the file to
activate the edit window and make whatever changes are necessary. Once the file
has been edited, it is ready to be checked in to SCLM. To Check In a file:

1. Save any changes made to the file.
2. Right click on the file and select Team > Check In.
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Figure 194. Check in

3. The Checkin window will display your selected files.
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Select files to checkin:
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Select Al Deselect Al |

o]

Cancel

Figure 195. Checkin files

Fleasze enter the following infoarmation:

Review your selections, then click OK to confirm your choices.

In the next window, change the Authorization Code (if desired) and enter a
valid Change Code. If required, select the option to view host messages. Click

Autharization Code:

izhange Code:

Fl

[~ Display Host Messages?

[

2 Cancel

Help

Figure 196. Checkin - authorization and change codes
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Once the file(s) has been checked in, then you will be returned to the WSAD main

menu. Also the check mark, which was previously next to the file, will be gone.

Note: If you want to change the SCLM Type of a file after editing, remove the file
from version control, and then add it back in using the Add Special

function.

View Log Files

If a problem occurs, there are log files that can be turned on and then accessed. To
do this:

In the WSAD application, select Window > Preferences
2. On the left side of the screen, select Team > Cloud 9 Provider.

1.

4 Preferences

£

1 [F ][

t- Workbench

- Aigent Controller
- Build Order

H - Component Test

+- Data

H-- Debug

H-- External Tools

- Help

- InstallfUpdate

- Inkernet

- J2EE

H- 1awva

- Logging

-Plug-In Developrment
Profiling and Logaing
RAD

SErver

- Spell Check

[=]- Team

i Cloud 9 Provider
7S
File Conkent
Ignored Resources
- Validation
WS Debug
“eb and XML Files

e

- \iteb Browser

|»

Cloud 9 Provider

Logging Lewvel IFF\T.D.L (Leask Qukpuk) j
TR T E—

Restore Defaults |

Apply

Irnpork. .. Export. ..

]

Cancel

Figure 197. WSAD Preferences

From the drop-down list, select the logging level that you require and click OK.

Recreate the error.

The trace messages will be stored in a folder located in Program
Files/IBM/Cloud 9/~log or in the directory you specified on the install. These
files will contain helpful error information.
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Cloud 9 - WSAD Definitions

IDE-Integrated Development Environment

An IDE is a development tool allowing rapid application development. The
IDE includes an editor, debugging tool, run-time environment, and
deployment capabilities. WSAD provides for an Integrated Development
Environment.

SCM - Software Configuration Management

Source Configuration Management is one of the systems management
disciplines that focus on the management of software components. SCM
includes capabilities such as version control, life cycle management, build
management, and component relationships.

SCLM Server

SCLM is the SCM solution developed and distributed by IBM for the z/0OS
platform. SCLM is an acronym meaning Software Configuration and
Library Manager. SCLM is one of the integrated components of TSO/ISPF.
The SCLM Server extends the capabilities of SCLM to the end-user’s
desktop through both browsers and IDEs. Technically, the SCLM Server is
an application called Cloud 9 that executes under the control of the IBM
HTTP Server running on the z/0S platform.

Local Manifest

The local manifest is an .xml file stored in the work directory for a WSAD
project which has been placed under Cloud 9’s control. It is named with a
~, followed by the project name with an .xml extension, and is located in
the work directory specified for the project. For example, a WSAD project
named Animals with a work directory of C:\Animals would contain a file
named ~Animals.xml.

This local manifest is used to cache your Cloud 9 settings. It includes the
manifest name on the host, the host IP address and port, and also stores
certain settings, such as the last change code used and last authorization
code selected.

Under certain circumstances, it may be necessary to delete this file. If, for
example the hosts SCLM configuration has been modified or a project’s
location in SCLM has changed, a user would be required to perform a
Remove from Version Control operation on the WSAD project. Prior to
re-adding the project to version control, WSAD should be shut down and
the local manifest for the project deleted, in order to match the new SCLM
settings. This removes the cached location information and permits
specification of the new location upon performing an Add to Version
Control action on the project.

Host Manifest

The host manifest is a flat file, stored under USS in the manifest directory,
parallel to the cgi-bin folder containing the Cloud 9 executables. The host
manifest consists of two sections. The first contains metadata about the
project, including default extension mapping to SCLM types and
languages. Maintaining this default mapping on the host prevents the user
from having to associate each file with a type and language. Upon creating
a new project, users are prompted to map file extensions to these types.
That preference is then stored in the manifest on the host, and will be used
as the default SCLM type and language for other files with the same
extension. The second part of the host manifest contains a listing of all of
the files which are a part of that WSAD project. When actions, such as
refresh project, are performed the manifest is used to determine which
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members belong to that WSAD project. This allows a single SCLM project
to be used to manage an arbitrary number of WSAD projects.

The host manifest does not require any maintenance, as it is kept updated
by actions against the project. While loss of or damage to the host manifest
will not result in any data loss, as the actual files are stored in SCLM, the
host manifest directories should be backed up as part of a regular backup
and disaster recovery strategy. If, for some reason, the host manifest files
are deleted, then the user will lose the ability to add the project to version
control. When this occurs, the user should perform an 'Unshare Project’
action, which will automatically remove the Cloud 9 metadata files from
the project. The user may then re-add the project to version control and
either select an existing manifest or create a new one. Information on
backup procedures can be found in the Cloud 9 Installation Guide (ch.20).

Cloud 9 - WSAD Frequently Asked Questions

Q1. On the initial add to version control, all the source and class files are listed.

Is it possible to provide a filter to deselect the class files, as on a very large

project it would be very tedious to individually select or deselect them?
Answer: You can use the provided Ignored Resources Preference page to
add and remove file name patterns you wish to ignore. This is available
from Window > Preferences > Team > Ignored Resources. Just click the
Add button on the far right of the panel and enter in whatever file types
you want blocked.

Q2. In the example, Project, Alternate, and Group are entered. This raises a
number of questions:

Q2.1. Does this mean that if multiple Java classes are being extracted
from WSAD into SCLM then a separate logon must be performed each
time Type or Language change?
Answer: You will logon to Cloud 9 only once per invocation of
WSAD, when the first Plug-in service is requested. You are not
required to re-login for each type.

Q2.2. Can the Java code and the Java output classes both be added,
checked out, and checked in?
Answer: You can check-in both source and class files into SCLM
using the Cloud 9 WSAD Plug-in. In addition, other file types such
as graphics can be added into SCLM via the plug-in.

Q2.3. Can code be added into separate SCLM types if needed?
Answer: WSAD files with the same extension are associated with a
single SCLM type for a single WSAD project. So .java, .class, .jpg,
or .gif files can be stored as separate SCLM types; the files could
be stored as the same SCLM type. However, all file extensions with
the same extension are stored in the same SCLM type. For
example, the user might store both .jpg and .gif files into the SCLM
type called GRAPHICS while .java files are stored as type JAVA
and .class files are stored as SCLM type CLASS.

Q3: Authorization codes, change codes, and languages can be specified through
the Cloud 9 WSAD Plug-in panels. Can these fields be validated via exits and
which platform will the exits run on?
Answer: Cloud 9 uses standard SCLM services when storing and updating
SCLM controlled files. By using published SCLM services, all SCLM exits
are available. Validation of authorization codes, change codes, and
languages is typically performed through the use of the SCLM CCID exit.
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SCLM exits execute in the z/OS environment. SCLM exits are described in
the ISPF SCLM Developer’s Guide and ISPF SCLM Reference manuals.

Q4. The term project is mentioned throughout the Help system. What project are

you referring to? Is this the WSAD project or is this a definition within SCLM?
Answer: There are two different projects here; the WSAD project and
SCLM project. The WSAD project includes all of the objects associated with
the currently opened WSAD project. The list of files included within the
WSAD project is stored as a flat file in USS, known as the host manifest.
Each file within the WSAD project is stored as a separate SCLM member.

SCLM also uses the term Project to describe all files associated with a
particular application. All WSAD files associated with a WSAD project are
stored under the control of a single SCLM project. An SCLM project can
have non-WSAD objects such as COBOL and JCL.

For example, you might have a WSAD project called Petdemo that
includes twenty java files, twenty class files, and ten graphics files. The
WSAD project might be stored under the SCLM Order Entry project called
ORDENTRY. Also under control of the SCLM ORDENTRY project might be
a COBOL billing application.

Q5. | understand that full path names can be added / saved for the WSAD

member in Cloud 9. Is this an option that has to be specified each time or can it

be set in an option file?
Answer: The full path names are stored in the SCLM-WSAD package.
Once the full path name is defined to the SCLM-WSAD package then the
full path name is not specified again. If for some reason the full path name
does change, then the definition contained within the SCLM-WSAD
package can be updated via the PLUG-IN function Remove from Version
Control followed by the PLUG-IN function Add to Version Control. The
PLUG-IN function Remove from Version Control only updates the
SCLM-WSAD package file, and does not physically delete the SCLM file.
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Part 4. Using the JES2 SDSF Viewer
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Chapter 10. JES2 SDSF Viewer

The Job Entry Subsystem 2 Spool Display and Search Facility (JES2 SDSF) Viewer,
hereinafter called the SDSF Viewer, is used to display at the contents of batch jobs.
This chapter describes how to:

» Start the SDSF Viewer

» List spool files

» Perform actions against files

Starting the Viewer

To start the SDSF Viewer, enter the following in your Web browser location entry
field:

host's ip-address:port/sdsf.htm

where host’s ip-address:port is the address and port of the system where you are
running Cloud 9, and sdsf.htm is used as is to start the SDSF viewer (note that sdsf
is in lowercase). The SDSF Viewer panel displays.

Prefix:

KOHRING*

Owner:
*

Job Quieue:

e Status
Active
Input
Output
Hold

Figure 198. SDSF Viewer first panel

The left side of the panel contains the Viewer menu and two input fields. The
functions of these items are:

Prefix SDSF Viewer queries default to the user ID * Prefix mask. To query using a
different mask, enter the job ID mask in the Prefix input field. The resultant
list is filtered on the mask value. The purpose of the Prefix input field is
equivalent to entering the PREFIX command on the command line in SDSF
to override the default value.

Owner
The purpose of the Owner input field is to change the default of owner (*)
to a more specific value. This field corresponds to the Owner field in the
job information of SDSF.

Job Queue
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Status — equivalent to issuing the ’st’ line command in SDSF. Shows all
jobs regardless of status.
Active — equal to issuing the 'da’ line command in SDSF. Shows a list
of currently executing jobs.
Input — equivalent to issuing the ’i’ line command in SDSF. Shows a list
of jobs awaiting execution.
Output — equivalent to issuing the '0’ line command in SDSF. Shows a
list of jobs waiting to print.
Hold — equivalent to issuing the 'h’ line command in SDSF. Shows a list
of jobs on the output hold queue.

To view output, input, or active JES2 files, the user must enter a Prefix (with or
without wild card), an Owner (wild card allowed), then select a queue type from

the menu.

Listing JES2 Spool Files by Job Queue Type

After entering the appropriate information in the SDSF Viewer’s main panel and
selecting a queue type, a list of results is displayed on a new panel. The row that

displays with each list varies, depending on the type of list requested.

The Status Queue row fields

KOHRTNG*

Figure 199. Result of STATUS List Request

Jobname
Jobid
Owner
Priority
Queue
Class

Position

11 Jobs in Status Queue.

Jobname Jobid Owner Priority Queue Class Puosition Status SAFF
™ KOHRINGW JOBGGS KOHRING 1 PRINT A 189
[ KOHRINGX JOEO7058 KOHRING 1 FRINT A 199
I~ KOHRINGK JORNT05S KOHRING 1 PRINT A 200
I KOHRING THUO7042 KOHRING 1 FRINT 203
™ KOHRINGR JOBI7271 KOHRING 1 PRINT A 225
™ KOHRINGS JOBOT2T2 KOHRING ! PRINT A 226
™ KOHRINGT JOBIT273 'KOHRING 1 PRINT A 27
™ KOHRINGU JOEOTZIA KOHRING 1 FRINT A 228
™ KOHRINGT JOBO737S. KOHRING 1 PRINT A 229
" KOHRINGZ JOEN7I7E KOHRING ! PRINT A 230
™ KOHRING& JOBO7278 'KOHRING 1 PRINT b 731

1

The name of the job and address space.

The number assigned from JES2.

The user ID of the person who submitted the job.

The JES2 input or output priority.

The JES2 queue name.

The JES2 output class for routing/printing.

The position in print queue.
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Status Job Status.
SAFF System ID where job is running.

The Active Queue row fields

2 Jobs in Active Queue.

[ Jobname  Jobld StepName  ProcStep  Owner CPU%  CPUtme UM

B KOHRING.

« o

Figure 200. Result of ACTIVE List Request

Jobname The name of the job and address space.

Jobid The number assigned from JES2 Owner.
Stepname The step currently being issued.

Procstep If active, the current procedure step.

Owner The user ID of the person who created the task.
CPU % The percentage of the CPU used by the task.
CPU Time Number of CPU seconds used by the task.

10# Number of EXCPs used by the task.

The Input Queue row fields
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0 Jobs in Input Queue.

Jobname Jobid Owner Priority Class Position Prt-Dest

Figure 201. Result of INPUT List Request

Jobname The name of the job and address space.

Jobid The number assigned from JES2.

Owner The user ID of the person who submitted the job.
Priority The JES2 input priority.

Class The JES2 input class (Initiator).

Position The position in the input queue, if waiting.
Prt-Dest The printing destination.

The Output Queue row fields

7 Jobs in Output Queue.

Jobname Jobid Owner Priorii:y Class Forms Prt-Dest Tot-Rec

Figure 202. Result of OUTPUT List Request

Jobname The name of the job and address space.
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Jobid The number assigned from JES2.

Owner The user ID of the person who submitted the job.
Priority The JES2 output priority.

Class The JES2 output class for routing/printing.
Forms The form definition for printing.

Prt-Dest The printing destination.

Tot-Rec The size of the file.

The Hold Queue row fields

ofix: =
[rommmia: | 6 Jobs in Hold Queue.
[ | Jobname Jobid Owner Priority  Class  ODisp  Dest  TotRec
- I EoHRNGW OB KOHRING W T HOLD Local 0
I KOHRINGX JOBOTSE KOHRING 144 T HOLD LOCAL 75
i~ KOHRINGX JOBO7053 KOHRING 144 T HOLD LOCAL 79
I~ KOHRINGU JOBO7274 KOHRING 144 T HOLD LOCAL 7
T KOHRINGT IOBOTETS  KOHRING 144 T  HOLD LOCAL 0
™ KOHRINGA J0B07ZES KOHRING 14 T HOLD LOCAL s

« o

Figure 203. Result of HOLD List Request

Jobname The name of the job and address space.

Jobid The number assigned from JES2.

Owner The user ID of the person who submitted the job.
Priority The JES2 output priority.

Class The JES2 output class for routing/printing.

Odisp The current output disposition (Hold, Write, and so on).
Dest The printing destination.

Tot-Rec The size of the file.

Notice that the menu on the left of the panel now contains more options, the
Actions. These options are explained in the following sections of this chapter.
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Using the Action Menu Options

After you have created a list of files using the SDSF Viewer, you can then request
actions against the resultant list. The actions available for use are listed in the
Actions portion of the menu on the left of the list panel.

fix B
11 Jobs in Status Queue.
Jobname Jobid Owner Priority Queue Class Position Status SAFF
™ KOHRINGW TOBOGDAS KOHRING 1 PRINT A 189
I” | KOHRINGZE JOEO7058 KOHRING ! PRINT A 199
™ KOHRINGX JOBO7052 'KOHRING 1 PRINT A 200
™ KOHRING TYU07042 'KOHRING 1 PRINT 203
™ KOHRINGR JOBNTITL KOHRING 1 PRINT A 225
L KOHRINGS JOBNT272 KOHRING L FRINT A 226
I” | KOHRINGT JOBO7273 'KOHRING 1 PRINT A 227
™ KOHRINGU IOB0T274 KOHRING 1 PRINT A 228
™ KOHRINGT JOBO737S. KOHRING 1 PRINT A 229
" KOHRINGZ JOBO7278 KOHRING ! PRINT A 230
™ KOHRING& JOBO7278 'KOHRING 1 PRINT b 231
u o

Figure 204. Result of Status List Request Showing Menu with Actions

The Actions available on the menu are:

View Look at a selected job.

Cancel Stop the running of a selected job.

Hold Transfer a job from output queue to hold queue.
Release Transfer a job from hold queue to output queue.
Purge Remove a job from JES2.

One or more jobs can be chosen for the action. Only one action request can be
requested at a time. For instance, you can select all of the files on the panel, but
can only request one action, such as View, at one time.

The View Action

You can use the View action to view any displayable data from SDSF on the
browser panel. Each file is displayed in its own browser window. There are no
limits to the amount of data displayed or number of active windows allowed. The
following is an example of how to view all three files in the usage example:

1. Select the files to be viewed (Figure 205 on page 175).
2. Click on the View action on the left menu.
3. View each output in its own window.
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KOHRING*

11 Jobs in Status Queue.

Figure 205. Selecting Jobs from List

Jobname Jobid Priority Queue Class Position Status
" KOHRINGW TOE06945 KOHRING il FRINT A 189
" KOHRINGK JOBOTSE KOHRING 1 PRINT A 199
I~ KOHRINGE JOBOTNI KOHRING 1 PRINT A 200
™ KOHRING TSUO7042 KOHRING 1 PRINT el
W KOHRINGR JOB727L KOHRING 1 FRINT A 225
M KOHRINGS JOB07272 KOHRING 1 PRINT & 326
V¥ KOHRINGT IOBOT273 KOHRING 1 PRINT A a7
I” KOHRINGU IOBT274 KOHRING 1 PRINT A 228
™ KOHRINGT JOBO7275 KOHRING i PRINT A 229
I” KOHRINGZ IOB0T278 KOHRING 1 FRINT A 230
I KOHRINGA TOBO7279 KOHRING 1 FRINT A 231
T

When the job is returned, the title of the browser window is the file
name/jobnumber. In the following example, the KOHRINGS output is displayed.
There were also two other windows opened and populated.

il

1 JES2 JO0OB LOG -- SY¥YSTEMN PDFE -- NODE PDFESA

10.16.32 JOBO7272 —--- WEDNESDAY, 08 AUG 2001 -—--

10.18.32 JOBO7272 IRRO10I USERID KOHRING IS ALSSIGNED TO THIS JOE.
10.18.32 JOBO7Z7Z ICHYO0O01I KOHRING LAST ACCESS AT 00:13:45 CN UEDMESDAY, AUGUST &, 2001

10.18.32 JOBO7272 $HASP373 KOHRINGS STARTED - INIT 1

10.18.33 JOBO7Z7Z ACTS10I EKOHRINGS.SUPERC

10.18.33 JOBO7272 $HASP395 KOERINGS ENDED
[ JESZ JOB STATISTICS --—-—--
08 AUG 2001 JOB EXECUTION DATE

12 CARDS READ

82 SYSOUT PRINT RECORDS

0 SYSOUT PUNCH RECORDS

5 SYSOUT SPOOL KEYTES
0.00 MINUTES EXECUTICN TIME
//ROHRINGS JOB (7GT1ZIOZ,0226,062,T1Z,99,N),
i 'KOHRING R',MSGCLASS=T,
i NOTIFY=KOHRING

-

- CLASS A - 5¥3 PDFE
10.18.32 JOBO7Z72 IEF4031 KOHRINGS - STARTED - TIME=10.15.32Z
10.16.32 JOBO7272 IEC104T 00000004, KOHRINGS, SUPERC ,NEWDD
10.18.32 JOBO7272 IEC141I 013-C0, IGGO199G, KOHRINGS, SUPERC, NEWDD
10.18.32 JOBO7272 IEC104I 0000000AL, KOHRINGS, SUPERC  , OLDDD
10.16.32 JOBO7272 IEC141T 013-C0, IGGO1939G, KOHRINGS, SUPERC, OLDDD

STEP TERMINATED -—- COND CODE= 0008
10.16.33 JOBO7272 IEF404T KOHRINGS - ENMDED - TIME=10.18.33

S T AR A R AT TS TR AETTASE NI AIATTAAATAIAXNNAIRATATANET

e

/#SUPERC EXEC PGN=ISRSUPC,

153 PARMN= (CHNGL, LINECHP,
12 e
12 [RN]
3 //OLDDD DD PATH='/u/stan/cigz/Clouds/hoepd.cont'

4 ¢ uRunn N DATH=! fularaniTakerasr (e end men

4]

-000, BPX10PN ,0073,0562003F

—000, BPX10PN , 0079, 0562003F

JOBOTZTE

Figure 206. Browsing Outputs

No Data Condition

The list displayed in the browser is current at the time of the request. The output
might be deleted or the active task might actually end before an action request on
the file. If the task or output file no longer exists, then the resulting panel’s

message area is blank.

The Cancel Action

Users can select the Cancel action to purge existing output or to cancel an active

task. To cancel an active task or purge an output file, first request a list of jobs.
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Then select the jobs to cancel by clicking on the check box next to the entry. When
one or more jobs have been selected, click Cancel. In the following example, the
user is canceling KOHRINGZ.

10 Jobs in Status Queue.

Jdbname Joblci dwner Pr;orliy dueue Cléss Ebsitibn Sfafﬁs

e e

Figure 207. Cancel Request

After processing, the updated list reflects the canceled job as follows:

8 Jobs in Status Queue.

Jobname Jobid Owner Priority Queue Class Position Status

| KOHRING 294 : 15 CUTION

Figure 208. Post Cancel Request Display

Cancel Versus Purge Actions

The cancel and purge actions have the same effect if requested against a non-active
task. For instance, if the user selects two output files and purges one but cancels
the other, the effect is the same — They are both deleted from the JES2 spool.

The cancel and purge actions have different effects if requested against an active
task such as a TSO session or executing batch job. If the cancel action is chosen,
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then the task is canceled, but any existing output remains in the output queue. If
the purge action is requested, the task is canceled and all existing output is purged
from the queue.

The Hold Action

The purpose of the Hold action is to change the status of a job to HOLD. For
instance, a user might have created an output to go to class A output, only to
decide that they do not want to print the file, just view it. For example, the user
wants to create a dump for diagnostic purposes and mistakenly asked for it to be
printed.

To change the status of output files, first request a list of output files. Select one or
more of the jobs in the list. Then click the Hold action to reset the output files.
Output is reset to HOLD class. You can also issue a Hold request for active tasks.

The Release Action

The purpose of the Release action is to release held output to the output queue,
thus making it available to be printed. To change the status of held output files,
first request a list of Held output files. Select one or more of the jobs in the list.

Then click the Release action to change the status of the output files. Output is

released to the default print class.

In this example, the output disposition (ODISP) is set to hold before the Release
action request.

refix: =
Jrommzios | 6 Jobs in Hold Queue.
I* Jobname Jobid Owner Priority Class ODisp Dest Tot-Rec
- [ KOHRINGW OB KOHRING 144 T HOLD LOCAL 142
I KOHRINGK JOBN7053 KOHRING 144 o HOLD LOGAL 7
W KOHRINGE JOBN7059 KOHRING 144 T HOLD: LOCAL 7
™ KOHRINGU IOB07274 'KOHRING 144 Gt HOLD LOCAL 73
I~ KOHRINGT JOB073TS KCOHRING 1 T HOLD LOCAL 0
™ KOHRINGA JOBO7279 KOHRING 144 T “HOLD LoCAL 70

« o

Figure 209. Release Action Request

After the release of the held file, the job is removed from the hold queue, and only
displays in the status or output. The following example shows that the job has
been reassigned to the output queue:
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7 Jobs in Output Queue.

Jobname Jobid Owner Priorify Class Forms Prt-Dest Tot-Rec |

e . . . = @ @ @ @@ @

Figure 210. Release Action Result

SDSF Batch Authorization
Results depend on the security settings of your SDSF configuration. The default
setting, in most systems, is to restrict batch SDSF processing to the user ID of the
caller. Check with your SDSF administrator for more information about batch SDSF
authorizations. The administrator can see the SDSF Customization and Security
Manual for batch SDSF information.
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Appendix A. Cloud 9 with the CA-Endevor Bridge

The CA-Endevor Bridge is designed to assist SCLM implementors with listing and
building CA-Endevor syntax for export and subsequent import into SCLM. The
main difference between the standard Cloud 9 for SCLM and Cloud 9 for SCLM
with the CA-Endevor Bridge is the appearance of the LIST ELEMENTS menu
option. All other SCLM functionality is the same. shows the additional
listing function.

Select a query
function to
display a list.
Actions can
FILE then be
performed on
the list.

ABOUT CLOUD 9

Figure 211. List Elements Menu Option

This chapter descibes how to use Cloud 9 to migrate source code from
CA-Endevor to SCLM by showing you how to:

» Perform CA-Endevor listing functions.

» Migrate existing elements into SCLM.

Listing Elements in Cloud 9

The following panel is provided to users for element listing.
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Query Functions

PRCFILE

Element Query

Environment:
System;
Subsysterm:
Type:

Stage ID:

Mermbet;

—
—
—
—
—
—

AEOUT e Feset |

Figure 212. Element Query Panel

Required Fields:The Environment field is required and cannot be wild carded.

Enter the known CA-Endevor values and click submit. An element list is returned.

Element Type Env.SystemSubsystem Stage IDVV.LL
§$SRECY SHORTNAMTEST SYSA  SUBA A 0100
$$SRECY TESTTYPE TESTSYSA  SUBA A ool
§$SRECY TESTTYPE TESTSYSA  SUBA B 0100
SESXMIT2  SHORTNAMTEST SYSA  SUBA A 0loo
§$500010 BINARY  TESTSYSA  SUBA A 0lDl
§$500011 BINARY  TESTSYSA  SUBA A 0100
§INIT SHORTNAMTEST SYSA  SUBA A 000
§NODOD0  BINARY  TESTSYSA  SUBA A 0ioo
§JAVPRZ PROCESS TESTSYS)  SUBI A 0lo0
§J000000 CLIST  TESTEYSA  SUBA A 0iD4
SREHE §J000001 CLIST  TESTSYSA  SUBA A 0118
§J000002 CLIST  TESTSYSA  SUBA A D109
§J000003 CLIST  TESTSYSA  SUBA A 0lo0
§NOOODOD CLIST ~ TESTSYSA  SUBA A 0loo
§NODOOO0 HTML ~ TESTSYSA  SUBA B 0100

Figure 213. Element List Display

Actions Against Element List

Once the list of elements is displayed, the user has a few options for working with
the CA-Endevor elements. Aside from requesting the Migrate to SCLM action,
users can also perform standard CA-Endevor Browse functions against the
elements. The following panel is displayed in response to clicking on VIEW on the
Actions menu.
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Bowse |

Query Functions
15T SCLM FIL
Yiew Source ¢
Master €
Source views Component views
Show Levels € Show Levels €
Browse Browse
Changes ¢ Changes ¢
History History
Summary Summary
Subrnit |

Figure 214. View Elements Panel

From this point, all standard CA-Endevor browse functions can be performed.

Migrating to SCLM from CA-Endevor
1. Display a list of CA-Endevor Elements.
2. Click on Submit.
3. Once the element list is returned, click Select ALL or individually select
elements for processing.
4. Click on Migrate to SCLM . The following panel is displayed.

Query Functions MIGRATE I

To  PFroject: I—
Alternate; I—iJ
Group: Iiil
I
B

Type: Ii

Language: I—
Change Code: l_
Authorization Code: I_‘

& Canvert current level only  canvert all levels

Subrmit | Reset |

Figure 215. Convert Elements to SCLM Panel

Required Fields: Project, Group, Type and Language are required and cannot
use wild cards.
Optional Fields: Change Code and Authcode are optional.

Click Submit and a batch conversion job is submitted.
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Appendix B. Creating and Adding .jpg Images to the User
Profile

This appendix covers how to create, scan, and add .jpg images to your user profile.

Creating the File
To create a .jpg or picture file, you need to capture your image and save it. There
are many ways to capture images:
» Take a picture with a digital camera.
= Scan an existing photograph into a PC.

» Take a photograph with a film camera but have the developer provide a disk
version rather than (or in addition to) a printed photograph.

» Take an existing photograph to a copy or office supply store and have them scan
it into a .jpg file.

Some photo development companies will develop your pictures and post the files
on the Web. To retrieve the file:

1. Go to the Web site address they provide you with.

2. Right-click your picture.

Select “Save Image As . . .” The Save dialog box displays.
Enter a name for the file.

Click Save.

S

Note: Check to make sure the file is stored with a .jpg extension. Other file
formats are not supported.

Adding the File

To add the .jpg file to your profile:

Select PROFILE from the Cloud 9 Main Menu.

Type in the location of the .jpg file.

If the file location is on the A: drive, Select Browse.

Move to the A: drive.

Highlight the file.

Select Open.

The file directory path is automatically filled in on the Profile panel.
Click the Update profile button to submit the new picture.

© N o o~ N~
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Jjpg Images 185
Jjpgs, Adding to profile 9
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Action Menu
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Add .class files, VA for Java IDE 124
Add PC/WS files 47
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Add SCLM Members to Package 55
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IDE 124
Add to version control
Cloud 9 VA for Java Plug-in 112
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Profile 185
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Adding Picture 9
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Authorization code, changing 61
Authorize SDSF batch job 178

B

Batch job

authorize 178

cancel 175

hold 177

purge 176

release 177
Batch jobs, viewing 169
Binary files

adding 47

editing 30

viewing 19
Binary files, edit options 34
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file types 38
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usage scenario 106
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CA-Endevor Bridge 181
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E

E-mail address 8
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Edit source
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Editing
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J
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Main Menu 5

Menu Navigation
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SCLM members 13
Unix 18

Menu Options, Action 174

Menu, Main 5
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CA-Endevor 183
MIME types 38
Moving
PDS members 90
Unix files 98
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PDS members 16
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Unix files 18
Netscape settings
Text files 20
No Data Condition 175

O

Objects

editing 25
Objects, Listing 11
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packages 53
Open Package panel fields 54
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Overview
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VA for Java IDE 111
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Developer Plug-in 141

P

Packages
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scenario 105
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creating, usage scenario 105
editing and saving 56
open/create 53
promoting, usage scenario 108
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non_IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to the IBM
Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY
10504-1785, USA.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries in writing to

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OR NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information might include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements or
changes in the product(s) and/or the program(s) described in this publication at
any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact the IBM Corporation,
Department TL3B, 3039 Cornwallis Road, Research Triangle Park, North Carolina,
27709-2195, USA. Such information may be available, subject to appropriate terms
and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Information concerning non-1BM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non_IBM products should be addressed to the
suppliers of those products.

If you are viewing this information softcopy, the photographs and color
illustrations may not display.

Trademarks

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

* IBM

* SCLM

« z/0S

* WebSphere

Breeze, Cloud 9, and SOLEI are trademarks of Chicago Interface Group,
Incorporated.

Internet Explorer and Windows are trademarks of Microsoft Corporation.
Netscape Navigator is a trademark of Netscape Communications Corporation.
CA-Endevor is a trademark of Computer Associates, Inc.

Other company, product, and service names might be trademarks or service marks
of others.
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